The Aubin Academy Master Series
Revit® Architecture 2012

PAUL F. AUBIN

THE AUBIN ACADEMY MASTER SERIES: REVIT® ARCHITECTURE 2012 combines a straightforward, reader-friendly style with project-focused exercises that encourage learning by doing. Gain practical, hands-on experience with the powerful, popular Revit Building Information Modeling (BIM) software, which leading architects and engineers are using to move beyond traditional Computer-Assisted Design (CAD) to manage complex projects, foster collaboration, and boost productivity. This practical guide takes you through the process of building design development models and creating a complete set of construction documents for architectural production. By focusing on the rationale and practicality of the Revit Architecture process, the book helps you learn faster and get a clear understanding of the software's capabilities and its potential. Author Paul F. Aubin, an architecture professional for over 20 years, and a respected Autodesk® expert, also draws on his real-world experience to provide detailed instruction and practical tips, both within the book and its Online Quick Start Videos designed to reinforce learning.

• This thorough guide provides a detailed introduction to the Revit® Architecture process, exploring the rationale and practical applications of the software and its component tools to help you appreciate both why and how to use them to complete building design projects successfully.
• The author combines extensive experience as an educator and architectural professional with a straightforward, engaging writing style, making even complex material easier to master and apply.
• Practical, project-focused exercises encourage you to “learn-by-doing,” giving you a deeper understanding of the building design process and the tools and techniques used to complete it.
• “Power User/BIM Manager” tips offer practical insights on what is required to manage Building Information Modeling (BIM) in a modern architectural setting.
• Online Quick Start Videos, featuring instruction and tips from the author, reinforce learning by allowing you to progress at your own pace and devote extra time to topics that especially interest or challenge you.

About the Author
Paul F. Aubin is the author of many highly acclaimed texts in Computer-Assisted Design and Building Information Modeling (BIM). Aubin is an independent architectural consultant who travels internationally lecturing and providing Revit® Architecture and AutoCAD® Architecture implementation, training, and support services. His 20-year career as an architectural professional has included experience in design, production, CAD management, mentoring, coaching, and training. He regularly teaches both architectural professionals and students and has been a subject faculty member for the Illinois Institute of Art in Chicago and Moraine Valley Community College in Palos Heights, IL. He has been an active member of the Building Information Modeling (BIM) Questions forum, an active member of the Autodesk® user community, and has been a top-rated speaker at the annual Autodesk University user convention for many years. His diverse experience as a professional and educator is reflected in his writing and classroom instruction. He has a bachelor’s degree in Architecture and a bachelor of science degree in Architectural Engineering, and is an associate member of the American Institute of Architects.
CONTENTS

Preface vii

I  INTRODUCTION AND METHODOLOGY

QUICK START GENERAL REVIT ARCHITECTURE OVERVIEW  3

Introduction 3 • Objectives 3 • Create a Small Building 3 • Working in Other Views 12 • Edit in Any View 15 • Round Out the Project 19 • Preparing Output 31 • Add Dimensions 34 • Output 35 • Solar Studies 35 • Summary 38

CHAPTER 1  CONCEPTUAL UNDERPINNINGS OF REVIT ARCHITECTURE  39

Introduction 39 • Objectives 39 • Building Information Modeling 40 • Defining BIM 44 • Revit Key Concepts 45 • One Project File—Everything Relates 45 • Revit Elements 45 • Model Elements 47 • Families & Types 51 • Explore an Existing Project 56 • Getting Acquainted with the Project 57 • Summary 68

CHAPTER 2  REVIT ARCHITECTURE USER INTERFACE  69

Introduction 69 • Objectives 69 • Unit Conventions 69 • Understanding the User Interface 70 • Right-Clicking 91 • Navigating in Views 94 • Selection Methods 95 • The Almighty TAB key 97 • Settings 99 • Summary 104

II  CREATE THE BUILDING MODEL

CHAPTER 3  CREATING A BUILDING LAYOUT  109

Introduction 109 • Objectives 110 • Working with Walls 110 • Working with Phasing 132 • Working with Doors and Windows 136 • Viewing the Model in 3D 153 • Adding Plumbing Fixtures 159 • Create an In-Place Family 162 • Summary 171
CHAPTER 4 SETTING UP PROJECT LEVELS AND VIEWS  173

Introduction 173  •  Objectives 173  •  Understanding Project Templates 174  •  Other Templates 184  •  Setting Up a Commercial Project 185  •  Working with Levels 186  •  Create a Simple Site 193  •  Rough Out the Building Form 195  •  Working with Elevation Views 203  •  Creating Section Views 211  •  Schedule Views 212  •  Sheet Views and the Cartoon Set 216  •  Drafting Views 233  •  Printing a Digital Cartoon Set 233  •  Summary 235

CHAPTER 5 COLUMN GRIDS AND STRUCTURAL LAYOUT  236

Introduction 236  •  Objectives 236  •  Working with Grids 236  •  Working with Columns 251  •  Adding Core Walls 259  •  Adding Floors 264  •  Creating Structural Framing 268  •  Summary 279

CHAPTER 6 GROUPS AND LINKS  281

Introduction 281  •  Objectives 281  •  Creating Groups 281  •  Editing Groups 287  •  Editing Group Instances 291  •  Additional Group Design Techniques 295  •  Maintaining Groups 300  •  Nesting Groups 303  •  Groups and Revit Links 306  •  Linked Projects 311  •  Summary 332

CHAPTER 7 VERTICAL CIRCULATION  334

Introduction 334  •  Objectives 334  •  Stairs and Railings 334  •  Commercial Core Layout 362  •  Landings and Shafts 371  •  Ramps, Custom Stairs, and Elevators 377  •  Summary 385

CHAPTER 8 FLOORS AND ROOFS  387

Introduction 387  •  Objectives 387  •  Creating Roofs 387  •  Editing Roofs 401  •  Creating Floors 413  •  Commercial Project Roof 417  •  Summary 428

CHAPTER 9 DEVELOPING THE EXTERIOR SKIN  429

Introduction 429  •  Objectives 429  •  Creating the Masonry Shell 429  •  Working with Curtain Walls 435  •  Creating Hosted Curtain Walls 449  •  Create a Custom Curtain Wall/System Type 455  •  Working with Stacked Walls 477  •  Summary 483

CHAPTER 10 WORKING WITH THE FAMILY EDITOR  485

Introduction 485  •  Objectives 485  •  Kinds of Families 485  •  Family Libraries 487  •  Family Strategies 492  •  Accessing Families in a Project 492  •  Accessing Libraries 497  •  Edit and Create Family Types 500  •  Customizing Families 503  •
Building Custom Families 511 • Load the Custom Family into the Project 534 • Building Parametric Families 535 • Create a Curtain Panel Family 555 • Enhance Families with Advanced Parameters 560 • Families from Manufacturer’s Content 571 • Summary 574

III CONSTRUCTION DOCUMENTS

CHAPTER 11 DETAILING AND ANNOTATION 579
Introduction 579 • Objectives 579 • Modify Wall Types 580 • Detailing in Revit Architecture 587 • Annotation 605 • Drafted Details (Not Linked to the Model) 623 • Working with Legacy Details 626 • Additional Detailing Techniques 630 • Summary 636

CHAPTER 12 WORKING WITH SCHEDULES AND TAGS 637
Introduction 637 • Objectives 637 • Create and Modify Schedule Views 637 • Editing the Model 654 • Working with Tags 660 • Rooms and Room Tags 667 • Querying Data 674 • Add a Color Scheme 678 • Working with Area Plans 683 • Summary 686

CHAPTER 13 CEILING PLANS AND INTERIOR ELEVATIONS 688
Introduction 688 • Objectives 688 • Creating Ceiling Elements 688 • Adding Ceiling Fixtures 702 • Creating Interior Elevations 707 • Summary 711

CHAPTER 14 PRINTING, PUBLISHING AND EXPORTING 712
Introduction 712 • Objectives 712 • Dataset 712 • The Application Menu 712 • Print Setup 713 • Print 715 • Printer Driver Configuration 717 • Trouble Shooting Printing 718 • Publish to Buzzsaw 718 • Publish to Autodesk Seek 719 • Export to CAD 719 • Export a DWF File 721 • Publishing Tools 722 • Summary 724

CHAPTER 15 WORKSHARING 726
Introduction 726 • Objectives 726 • Ways to Share Work 726 • Linking and Importing 727 • Coordination Monitor and Interference Check 728 • Worksets 729 • Understanding Worksets 730 • Creating Additional Worksets 735 • Workset Tips 749 • Going Further 750 • Summary 751
### IV CONCEPTUAL MASSING AND RENDERING

#### CHAPTER 16 CONCEPTUAL MASSING 755

- Introduction 755
- Objectives 756
- In-Place vs. Loadable Families 756
- Accessing the Conceptual Massing Environment 756
- The Massing Environment Interface 758
- Creating Forms in the Conceptual Mass Environment 759
- Project Vasari 760
- Model-based and Reference-based Forms 776
- Create a New Conceptual Mass Loadable Family 780
- Divided Surfaces, Patterns, Components, Points 788
- Summary 803

#### CHAPTER 17 RENDERING 804

- Introduction 804
- Objectives 804
- Revit Rendering Workflow 804
- Model Preparation 806
- 3D Views and Cameras 808
- Materials 809
- Lighting 812
- Render 815
- Output 819
- Walkthroughs 820
- Summary 820

### V APPENDICES

#### APPENDIX A ADDITIONAL EXERCISES 823

- Introduction 823
- Objectives 823
- Residential Project 823
- Residential Project—Chapter 10 824
- Residential Project—Chapter 12 828
- Commercial Site Project Refinements 828
- Commercial Project—Chapter 8 831
- Commercial Project—Chapter 9 831
- Chapter 10—Build a Family with Angular Parameters 833
- Add a Swing Parameter 835

#### APPENDIX B ONLINE RESOURCES 838

- Web Sites Related to the Content of This Book 838
- Autodesk Sites 838
- User Community 839
- Misc Online Resources 839

Index 841
WELCOME
Within the pages of this book you will find a comprehensive introduction to the methods, philosophy, and procedures of the Revit Architecture software. Revit is an advanced and powerful architectural design and documentation software package. By following the detailed tutorials contained in this book, you will become immersed in its workings and functionality.

WHO SHOULD READ THIS BOOK?
The primary audience for this book is users new to Revit Architecture. However, it is also appropriate for existing Revit users who wish to expand their knowledge. You need not be an experienced computer operator to use this book. Only basic knowledge of the Windows operating system and basic use of a mouse and keyboard are assumed. No prior computer-aided design software knowledge is required. If part of your job requires that you design buildings and produce architectural construction documentation or design drawings, facilities layouts, or interior design studies and documentation, then this book is intended for you. Architects, interior designers, design build professionals, facilities planners, and building industry CAD professionals will benefit from the information contained within. Prior knowledge and familiarity with architectural practice, procedures, and terminology are assumed.

FEATURES IN THIS EDITION
Aubin Academy Master Series: Revit Architecture 2012 is a concise manual focused squarely on the rationale and practicality of the Revit process. The book emphasizes the process of creating projects in Revit rather than a series of independent commands and tools. The goal of each lesson is to help readers complete building design projects successfully. Tools are introduced together in a focused process with a strong emphasis on “why” as well as on “how.” The text and exercises seek to give the reader a clear sense of the value of the tools, and a clear indication of each tool’s potential. The Aubin Academy Master Series provides resources designed to shorten your learning curve, raise your comfort level, and, most importantly, give you real-life, tested, and practical advice on the usage of the software to create architectural Building Information Models.
What You Will Find Inside
Section I of this book focuses on the underlying theory and user interface of Revit Architecture. This section is intended to get you acquainted with the software and put you in the proper mindset. Section II relies heavily on tutorial-based exercises to present the process of creating a building model in Revit, relying on the software's powerful Building Information Modeling (BIM) functionality. Two projects are developed concurrently throughout the tutorial section: one residential and one commercial. Detailed explanations are included throughout the tutorials to identify clearly why each step is employed. Annotation and other features specific to construction documentation are covered in Section III. Section IV includes coverage of the conceptual modeling features and rendering. Section V contains appendices with many additional resources useful to the book's content.

What You Won't Find Inside
This book is not a command reference. This book approaches the subject of learning Revit by both exposing conceptual aspects of the software and extensive tutorial coverage. No attempt is made to give a comprehensive explanation of every command or every method available to execute commands. Instead, explanations cover broad topics of how to perform various tasks in Revit, with specific examples coming from architectural practice. References are made within the text wherever appropriate to the extensive online help and reference materials available on the Web. The focus of this book is the design development and construction documentation phases of architectural design. Chapter 16 briefly covers conceptual design tools, and rendering is explored in Chapter 17.

STYLE CONVENTIONS
Style Conventions used in this text are as follows:

<table>
<thead>
<tr>
<th>Text</th>
<th>Revit Architecture</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step-by-step tutorials</td>
<td>I. Perform these steps.</td>
</tr>
<tr>
<td>Menu picks</td>
<td>SaveAs &gt; Project</td>
</tr>
<tr>
<td>On screen input</td>
<td>For the length type 10'-0&quot; [3000].</td>
</tr>
<tr>
<td>Ribbon Tabs</td>
<td>On the Home Tab, on the Build panel, click the Wall tool</td>
</tr>
<tr>
<td>File and Directory names</td>
<td>C:\MasterRAC 2012\Chapter10\Sample File.rvt</td>
</tr>
</tbody>
</table>

UNITS
This book references both imperial and metric units. Symbol names, scales, references, and measurements are given first in imperial units, and are then followed by the metric equivalent in square brackets[ ]. For example, when there are two versions of the same file, they will appear like this within the text:

*Curtain Wall Dbl Glass.rfa [M_Curtain Wall Dbl Glass.rfa]*.

When the scale varies, a note like this will appear: 1/8" = 1'-0" [1:100].

If a measurement must be input, the values will appear like this: 10'-0" [3000].

Please note that in many cases, the closest logical corresponding metric value has been chosen, rather than a “direct” mathematical translation. For instance, 10'-0" in imperial drawings translates to 3048 millimeters; however, a value of 3000 will be used in most cases as a more logical value.
Every attempt has been made to make these decisions in an informed manner. However, it is hoped that readers in countries where metric units are the standard will forgive the American author for any poor choices or translations made in this regard.

All project files are included in both imperial and metric units on the book's online companion unless noted otherwise. See the “Files Included with the Student Companion” topic below for information on how to install the dataset in your preferred choice of units.

HOW TO USE THIS BOOK

The order of chapters has been carefully thought out with the intention of following a logical flow and architectural process. If you are relatively new to Revit, it is recommended that you complete the entire book in order. However, if there are certain chapters that do not pertain to the type of work performed by you or your firm, feel free to skip those topics. But bear in mind that not every procedure will be repeated in every chapter. For the best experience, it is recommended that you read the entire book, cover to cover. For example, the early chapters cover the detailed procedures for drawing Walls, step-by-step with each click. Later chapters may simply say, “Draw a Wall from this point to this,” without detailing exactly how to draw a Wall. Most importantly, even after you have completed your initial pass of the tutorials in this book, keep your copy of Aubin Academy Master Series: Revit Architecture 2012 handy, as it will remain a valuable resource in the weeks and months to come.

A NOTE ABOUT COMPUTER HARDWARE AND OPERATING SYSTEMS

If Revit is your primary production application, you may want to consider maximizing your hardware and operating system to boost performance. Two important considerations are your processor and the amount of random access memory (RAM). Most systems today have multi-core processors. This essentially means the system has two, four (or more) processors working in tandem on the same chip. In order to take advantage of such a configuration, an application must be “multi-threaded,” which means that it can actually make use of all processor cores. An application that is not multi-threaded will only make use of a single core. With each release, more functions in Revit become multi-threaded. This currently includes the Mental Ray rendering engine, loading elements into memory, silhouette edge graphics, and other graphical view display items. Despite the fact that this list does not include all Revit functions, multi-core machines are often still the best choice because most people run several applications simultaneously and many other programs can utilize all cores simultaneously, or the load of several applications can be spread among the various cores.

The amount of memory your system has will have a more direct impact on Revit performance. 32bit hardware and operating systems (OS) can only address a limited amount of RAM. Depending on your current configuration, this will be between 3 and 4 gigabytes maximum. However, 64bit hardware and operating systems are becoming much more popular in recent years, and this hardware is available from many manufacturers. Microsoft Windows XP, Vista, and Windows 7 all come in 64bit editions. The 64bit version of Revit is functionally the same as the 32bit version. Users will notice no difference in the interface or function of the product. The primary benefit of the 64bit version is its ability to access significantly more memory than 32bit versions. Many users of 64bit OS have machines with 8 or 16 gigs of RAM, but it can go much higher (128 GB in Vista and 192 GB in Windows 7). If
you frequently work on large projects, it will not be unusual for your Revit models to exceed 200 MB in file size. At some firms, models of 500 MB and larger are not unheard of. (The author has even seen models of nearly 1 gig in size!) If you work on projects with file sizes in this range, the 64bit version with as much RAM as you can justify economically is a must.

Using 64bit and having more RAM in your system will give you the following benefits:

- You are able to open and work in larger models
- You can print more Sheets at a Time (this is useful even in small Projects)
- Speed increases of approximately 20% have been reported with very big Models (some reported higher gains)
- Even if you don’t realize these speed gains you will not crash large projects due to limited RAM.
- Large files and renderings will not fail on save.
- More physical RAM reduces the amount of hard disk swapping required.
- You can export more views to AutoCAD at a time.
- Intense operations such as updating Groups will process faster.

Please note that in some cases, not all of your existing software will run properly on 64bit OS. This may be the case for older programs or custom database applications. Check with the program’s manufacturer to see if 64bit is supported. While most firms report good compatibility with 64bit systems, be sure that all of your hardware supports it and that printer drivers are available. Also, it is not recommended that you mix Revit 32bit and Revit 64bit on the same project. This can cause problems, as the 32bit system runs out of memory and is unable to save the project.

FILES INCLUDED WITH THE STUDENT COMPANION

Files used in the tutorials throughout this book are available for download from the accompanying Student Companion site online at CengageBrain.com. Most chapters include files required to begin the lesson and in many cases a completed version is provided as well that you can use to check your work. This means that you will be able to load the files for a given chapter and begin working. When you install the files from the student companion, the files for all chapters are installed automatically. The files will install into a folder on your C: drive named MasterRAC 2012 by default, but you can install the files to a different location (such as My Documents) if you prefer. Inside this folder will be a folder for each chapter. Please note that in some cases a particular chapter or subfolder will not have any Revit files. This is usually indicated by a text file (TXT) within this folder. For example, the Chapter01 folder contains no Revit files, but instead contains a text document named, There is no Complete version of Chapter 1.txt. This text file simply explains that this folder was left empty intentionally.

NOTE

Please note that the Student Companion contains only Revit (RVT, RTE, RFA) and other related resource files necessary to complete the tutorial lessons in this book. The Student Companion does not contain the Revit Architecture software. Please contact your local reseller if you need to purchase a copy of Revit.
Accessing the Student Companion site from CengageBrain

You must have your own copy of Revit Architecture to follow along with the lessons in this book. However, several dataset files (mostly RVT and RFA files) are required if you wish to follow along. Dataset files are available for download from CengageBrain free of charge. To download the files, do the following:

1. In your web browser, visit: http://www.cengagebrain.com
2. Type author, title, or ISBN in the Search window. (see the back cover)
3. Locate the desired product (i.e. Aubin Academy Master Series: Revit Architecture 2012) and click on the title.
4. When you arrive at the Product Page, in the access to free study tools area, click the Access Now button.
5. Use the “Click Here” link to access the Companion site.

You will only see the Click Here link if there is a companion product available.

6. Click on the “Student Resources” link in the left navigation pane to access the resources.
7. Download and unzip the files to your C Drive.

The default unzip folder is named C:\MasterRAC 2012 on your hard drive. You can move this folder to another location if you wish.

If you wish to install both the imperial and metric datasets, return to the student companion and repeat the steps above for the other units. Installation requires approximately 450 MB of disk space per unit type (approximately 850 MB if you install both). If you install both datasets, some files will be the same. Click OK if WinZip asks to overwrite any files.

KEEP YOUR SOFTWARE CURRENT

It is important to keep your software current. Be sure to check online at www.autodesk.com on a regular basis for the latest updates and service packs to the Revit Architecture software. Having the latest version installed will ensure that you benefit from the latest features and enhancements. If you are on the Autodesk Subscription program, you will be entitled to new releases as they become available. You will also have access to extensions as they are released. Extensions add powerful functionality to the Revit software. Visit the Autodesk web site or talk to your local reseller for more information.

WE WANT TO HEAR FROM YOU

We welcome your comments and suggestions regarding Aubin Academy Master Series: Revit Architecture 2012. Please forward your comments and questions to:

The CADD Team
Cengage Learning
Executive Woods
5 Maxwell Drive
Clifton Park, NY 12065-8007
Web site: www.autodeskpress.com
ABOUT THE AUTHOR

Paul F. Aubin is the author of many CAD and BIM book titles including the widely acclaimed: The Aubin Academy Master Series: Revit Architecture, AutoCAD Architecture, AutoCAD MEP, and Revit MEP. Paul has also authored video training in Revit for lynda.com (www.lynda.com/paulaubin). Paul is an independent architectural consultant who travels worldwide providing Revit® Architecture and AutoCAD® Architecture implementation, training, and support services. Paul’s involvement in the architectural profession spans over 20 years, with experience that includes design, production, CAD management, mentoring, coaching, and training. He currently serves as Moderator for Cadalyst magazine’s online CAD Questions forum, is an active member of the Autodesk user community, and has been a top-rated speaker at Autodesk University (Autodesk’s annual user convention) for many years. This year Paul speaks at the Revit Technology Conference in both the United States and Australia. His diverse experience in architectural firms, as a CAD manager and as an educator, gives his writing and his classroom instruction a fresh and credible focus. Paul is an associate member of the American Institute of Architects. He lives in Chicago with his wife and three children.

Contact Paul directly at: www.paulaubin.com (click the Contact link).


DEDICATION

This book is dedicated to my son Marcus. I am so proud of you. Good luck in your first year in High School!

ACKNOWLEDGMENTS

The author would like to thank several people for their assistance and support throughout the writing of this book.

Thanks to Stacy Masucci, John Fisher, and all of the Delmar/Cengage team. It continues to be a pleasure to work with so dedicated a group of professionals.

Thanks to Robert Guarcello Mencarini, Architect, who was the technical editor for this and all previous editions.

Technical contributors to portions of this text include Matt Dillon, Zach Kron, Heather Lech, AIA, David Baldacchino, James Smell, Velina Mirincheva, Robert Guarcello Mencarini, Architect, AIA, and Mark Schmieding. A special thanks to each of you. Additional contributions and quotations have been noted within the text. Thank you to those contributors as well.

A very special thank you for significant contributions to the following chapters in the previous edition. These contributions continue to prove invaluable in this updated edition. I could not have completed them without your invaluable assistance:

Thank you to contributors for content to the following chapters: For Chapter 15, Revit Server information: David Baldacchino. Chapter 16, Conceptual Massing: Heather Lech, AIA, LEED AP and Zach Kron. For Chapter 17, Rendering: James Smell and Jeff Hansen, Subject Matter Expert, Autodesk.

Thanks to the following members of the Autodesk User Group International forums for their input on the 64bit version of Revit and 64bit machines: need4mospd, whgeiger1, Michael Ruehr, clog boy, Scott Womack, josh.made4worship, Steve
Stafford, swalton.161301, brenehan, Jamie Spartz, Cliff B. Collins, Scott Davis, Eric Vieleand, and Jaroslaw Janiszewski.

A special acknowledgment is due the following instructors who reviewed the chapters in detail:

Matt Dillon—DC CADD Company
Mel Persin, Coordinator—Chicago Autodesk Revit Users Group
Stephen K. Stafford II—Stafford Consulting Services (thanks for the Workset/Library analogy)

For taking the time to discuss this project personally and offer suggestions and feedback, thanks to Jeff Millett, AIA—Vice President and Director of Information Technology; Eddie Barnett—LEED, Interior Designer; Sarah Vekasy—LEED, Architect; Marc Gabriel—LEED, Architect; John Jackson—LEED, Architect; and Marwan Bakri—Stubbins Associates, Boston, MA, and also to Mark Dietrick—CIO and Senior Associate and Michael DeOrsey—Graduate Architect of Burt Hill Kosar Rittlemann Associates, Boston, MA.

There are far too many folks at Autodesk to mention (my apologies in advance for any omissions). Thanks to all of them, but in particular, Christie Landry, David Mills, Kelcy Lemon, Lillian Smith, Jason Winstanley, Tatjana Dzambazova, David Conant, Matthew Jezyk, Steve Crotty, Erik Egbertson, Greg Demchak, Chico Membreno, Trey Klein, Tobias Hathorn, Cindy Xingchen Wang, Scott Blouin, Andy Parrella, Joe Charpentier, Ken Marsh, Zach Kron, Michael Juros, Brian Fitzpatrick, and all of the folks at Autodesk Tech Support.

I am ever grateful for blessings I have received from my many friends and family. Finally, I am most grateful for the constant love and support of my wife, Martha, and our three wonderful children.
INTRODUCTION

In the previous chapter, we briefly covered the use of Groups. In this chapter, we will make a more detailed exploration of this feature. Groups provide a mechanism to standardize typical design elements throughout the project. A Group consists of a collection of elements that can be placed into the model as a single unit. You can edit any single instance of the Group and the changes will propagate to all instances throughout the model. Groups have many other features as well including the ability to have overrides applied to individual instances.

OBJECTIVES

In this chapter, we will work with both Model and Detail Groups. We will explore how to create Groups, modify them and strategies for using them effectively in your projects. After completing this chapter, you will know how to:

• Create Groups
• Modify Groups
• Override elements in Group instances
• Create Attached Detail Groups
• Swap Groups with one another

CREATING GROUPS

The dataset for this chapter will deviate from our Commercial and Residential projects to explore Groups in a dataset that will be more suitable to conveying the critical concepts. Toward the end of the chapter, we will return to the Commercial project to put into practice what we have learned about Groups and also explore Links. Groups can be created in any project. Creating them is as simple as making a selection of elements in your project and then clicking the Create Group button. Groups appear on the Project Browser beneath the Families branch.
Install the Dataset Files and Open a Project

The lessons that follow require the dataset included on the Aubin Academy Master Series student companion. If you have already installed all of the files from this site, skip to step 3 to begin. If you need to install the files, start at step 1.

1. If you have not already done so, download the dataset files located on the CengageBrain website.

   Refer to “Accessing the Student Companion site from CengageBrain” in the Preface for information on installing the dataset files included in the Student Companion.

2. Launch Autodesk Revit Architecture from the icon on your desktop or from the Autodesk > Revit Architecture 2012 group in All Programs on the Windows Start menu.

   You can click the Start button, and then begin typing Revit in the Search field. After a couple letters, Revit Architecture should appear near the top of the list. Click it to launch the program.

3. On the Recent Files screen, click the Open link beneath Projects.


   You can also select it and then click the Open button.

   Please note that for this chapter, units are immaterial to the lessons covered and as such only one dataset has been provided rather than the customary separate Imperial and Metric datasets of other chapters.

Explore the Dataset

Groups are appropriate for nearly any repetitive (typical) design condition. Hotels, dormitories, apartment complexes, and condominiums give us plenty of opportunities to utilize Groups in very effective ways. In this example, we will work with a very simple hotel room layout.

5. On the Project Browser, double-click to open the Architecture floor plan.

   This view shows the basic floor plan of a hotel guest room. Walls, Doors, Windows, and some basic fixtures are included.

6. Double-click to open the Section 1 section view.

   Here you will notice in addition to the items we can see in plan, there is also a multi-height ceiling plane in this model and some furniture items.

   - Open other views to explore the dataset further if you wish before continuing (see Figure 6.1).

7. On the Project Browser, double-click to return to the Architecture floor plan.

   - Maximize the view (if it is not already maximized).
• On the View tab of the ribbon, on the Window panel, click the Close Hidden button.

Create a New Group
The first step to understanding Groups is to create one.
Continue in the Architecture floor plan.
8. Using a window selection, select all elements on screen. (Click above and to the left of the model and drag down to the right surrounding all elements).
The Modify | Multi-Select tab will appear on the ribbon.
• On the Create panel, click the Create Group button.

An error dialog will appear. When you made your selection window, the elevation view tag and possibly the section view tag were included in the selection. View tags cannot be included in a Group. Simply clicking OK in this warning will automatically exclude them from the selection set.
• Click OK in the warning dialog to dismiss it.
The “Create Model Group and Attached Detail Group” dialog will appear.
• In the Model Group Name field, type Guest Room A.
• Leave the Attached Detail Group name as Group1 and then click OK (see Figure 6.2).

Since we have selected both model and detail elements, Revit will actually create two groups. One will be a Model Group containing the Walls, Doors, Windows,
and fixtures. The other will be a Detail Group that contains the door and window Tags. It is not possible for detail elements and model elements to be in the same group. The Detail Group will actually be an “Attached Detail Group.” This means that this Detail Group is associated to its parent Model Group. Later, we can have instances of the Attached Detail Group automatically applied to instances of the Model Group. To see each Group, simply move your mouse over them on screen.

- Move your mouse near the edge of one of the Walls.
  You will see a dashed box appear around the Model Group with a screen tip indicating its name.
- Move your mouse over one of the Tags.
  You will see a dashed box appear around the Detail Group with a screen tip indicating its name (see Figure 6.3).

Groups that you create will also appear in the Project Browser.

**FIGURE 6.2** Create a new Group and give it a name

**FIGURE 6.3** Two Groups were created—A Model Group and an Attached Detail Group
9. On the Project Browser, expand the Groups branch. 
   This reveals the Detail and Model branch.
   • Expand the Model branch.

You will see the Guest Room A Group indented beneath the Model branch.
   • Expand the Guest Room A entry to reveal the Attached Detail Group named Group 1 (see Figure 6.4).

![Figure 6.4 Groups appear hierarchically on the Project Browser](image)

Each Model Group you create will appear beneath the Groups > Model branch in the Project Browser. Attached Detail Groups will always appear beneath the Group to which they are attached. (If you create a Group from detail elements by themselves, without associated model geometry, they will appear beneath the Groups > Detail branch).

**Create a Group Instance**

Now that we have created a Group, we can easily add additional instances of the Group in our project. You can do this from the Model Group button on the Home tab or the Groups branch of the Project Browser.

10. On the Project Browser, expand Groups, then Model, and then right-click Guest Room A.
   • Choose Create Instance.
     A dashed rectangle will appear on screen with the mouse pointer in the center.
   • Click on screen to place the new Group instance to the left side of the original.
   • On the Modify | Model Groups tab of the ribbon, click the Finish button.

Another guest room will appear. (It does not include any annotation because as we saw above, the annotation is included in a separate Detail Group). When you create a Group, the geometric center of the Group becomes the insertion point by default. This is why when we added this instance; our mouse pointer was positioned in the center of the Group. You can move the origin to a more useful location simply by dragging it.
11. Select the Group instance that you just created. In the center of the Group, a blue Group Origin icon will appear.
   - Click and drag the round handle at the intersection of the two axes.
   - Drop the icon on the Wall endpoint at the top left corner of the hotel room (see Figure 6.5).

![FIGURE 6.5 Move the Group Origin by dragging](image)

12. On the Project Browser, right-click Guest Room A again and choose Create Instance. Notice the location of the mouse pointer relative to the Group outline this time.
   - Click a point to the right of the original to place the new Group instance.
   - On the Modify | Model Groups tab of the ribbon, click the Finish button.

If you select the original Group instance, you will notice that the insertion point for it is also at the upper left corner. Edits made to one instance of a Group apply automatically to all instances.

**Working with Attached Detail Groups**

Take a look at the original guest room (the one that has Tags). Notice that there are three Doors, each with its own unique number. On the other hand, the Windows share the same designation of “A.” The default Revit Door Tags show the instance “Mark” parameter of Doors, which is unique for each Door while window Tags show the “Type Mark” for Windows which is the same for all instances of a given Type. Keep these observations in mind as we perform the next several steps.

To add tags to the other Group instances, we could manually tag each item in the Group. A faster method is to use an Attached Detail Group. An Attached Detail Group can automatically be applied to any instance of its parent Model Group.

13. Select one of the Groups on the left or right (without annotation).
   - On the Modify Model Groups tab of the ribbon, on the Group panel, click the Attached Detail Groups button.
   - In the dialog that appears, place a checkmark in the box next to Floor Plan:Group 1 and then click OK (see Figure 6.6).
An instance of the Attached Detail Group will appear. Notice that each of the door Tags will have incremented sequentially to show unique numbers. The window Tags however will show the same designation that the originals did.

14. Repeat the process to add an Attached Detail Group to the other Model Group as well.

EDITING GROUPS

You can edit a Group at any time. When you do, changes you make to the Group will be applied to all instances when the edit is complete. This is one of the most powerful benefits of using Groups. Furthermore, edits to a Model Group can also have an automatic impact on Attached Detail Groups.

Edit a Group

To understand the value and potential of editing a Group, we can start with a very simple modification.

15. Select one instance of the **Guest Room A** Group onscreen.

   - On the Modify | Model Groups tab of the ribbon, on the Group panel, click the **Edit Group** button.

This enables the Group Edit mode. The background of the canvas area is tinted yellow and the Edit Group panel appears at the upper left corner of the view. The elements that are members of the Group remain bold, and all of the other elements on screen become grayed out and cannot be selected or edited, but they can be added to the group as we will see below. For this example, we will make a very simple edit.

16. Select one of the Windows (one of the bold ones).

   - On the Type Selector, choose **Slider with Trim:36° X 48"**.

In the Group editor, the selected Window will immediately reduce in size and the associated Tag will change from A to E—even though this Tag resides in a separate Detail Group!

   - On the Edit Group panel, click the **Finish** button (see Figure 6.7).
Section II • Create the Building Model

When you have finished, the edit will be applied to all instances of the Group. Notice that the Attached Detail Groups update as well. Let’s try another edit.

17. Select one instance of the Guest Room A Group.
   - On the Modify | Model Groups tab of the ribbon, on the Group panel, click the Edit Group button.
   - Repeat the Window edit made above to the other Window.
   - Create a new Window in the space between the two existing Windows. (Try a Fixed:36” × 48”).

Notice that the window Tag is also created, but it comes in grayed out. This is because it is annotation and is therefore automatically excluded from the Model Group that we are currently editing.
   - On the Edit Group panel, click the Finish button.

18. Select the window Tag.

Notice that the Tag selects independently as a freestanding element in the project. It is not automatically added to the Attached Detail Group as you can see by examining the other two instances in this project (see the top half of Figure 6.8).

FIGURE 6.7 Make a change in the Group Editor

FIGURE 6.8 Tags for newly added Group elements must be added manually to the Attached Detail Group
19. Select the Group 1 Attached Detail Group (the instance with the stray Window tag).
   - On the Modify | Attached Detail Groups tab of the ribbon, on the Group panel, click the **Edit Group** button.
   - On the Edit Attached Group panel, click the **Add to Group** button.
   - Select the window Tag (Tag H) and then click the **Finish** button (see the bottom half of Figure 6.8).

The Tag for Window Type H should now appear in all three instances of the Attached Detail Group. Again, since this Tag references a Type parameter (the Type Mark), the letter displays the same value in all instances of the Attached Detail Group. For adding a Tag, we had to manually edit the Attached Detail Group; however, if you were to edit the Model Group again and delete one of the tagged elements (a Door or Window) then the tag in the Attached Detail Group would also be deleted automatically even though it is in a different Group—you would not have to separately edit the Detail Group. Hosted elements like tags cannot exist without a host.

**Duplicate and Edit a Group**
Making a variation of a Group is simple to do. Once you have two or more variations, you can easily swap them out with one another.

20. Select the instance of the **Guest Room A** Model Group on the left.
   - On the Properties palette, click the Edit Type button.
   - In the “Type Properties” dialog, click the Duplicate button.
   - In the “Name” dialog, type **Guest Room B** and then click OK (see the left side of Figure 6.9).

Notice the appearance of **Guest Room B** on the Project Browser. If you expand it, you will see that a copy of the Group 1 Attached Detail Group has also been created and associated to the new Model Group.
21. Select the same instance onscreen (now Guest Room B).
   - On the ribbon, click the **Edit Group** button.
   - Delete the middle Window and make some other obvious change (such as enlarging the bathroom or flipping a Door).
   - Finish the Group (see Figure 6.10).

   ![FIGURE 6.10 Modify Model Group Guest Room B](image)

Not surprisingly, the change only affects the currently selected Group. This is because it is currently the only instance of Guest Room B in the project. At this point however, we can experiment with swapping Group instances and see the ease at which we can switch from one Group to another and also see another one of the benefits of the Attached Detail Group functionality. Take notice of the names of the Attached Detail Groups on the Project Browser. For both Model Groups, the Attached Detail Groups have the same name—Group 1. This is important for the next experiment. If you use the same name for the Attached Detail Groups, they will automatically swap when the parent Model Groups swap. Let’s take a look.

22. Select one instance of the Guest Room A Group.
   - From the Type Selector, choose Guest Room B. Since we tried to make the difference between the A and B Guest Rooms obvious, you should be able to spot the changes to the model right away. The most interesting change however is that the Attached Detail Group has changed automatically as well. Since the Attached Detail Groups for each Model Groups have the same name, Revit is able to swap them appropriately as well. This behavior works as long as the name of the Attached Detail Group is the same for each Model Group. In this example, we left the name “Group 1” but this name is not required. You can choose a more descriptive name if you wish.

23. On the Project Browser, right-click the Attached Detail Group (Floor Plan: Group 1) for Guest Room A and choose **Rename**.
   - Change the name to **Tags** and then click OK.
   - Repeat for the Attached Detail Group of Guest Room B and rename it to **Tags** as well.
   - Repeat the process above to swap one of the Guest Room B instances in the project back to Guest Room A.
Notice that the Attached Detail Group continues to swap as well. With this in mind, you should try to pick useful and descriptive names for both your Model Groups and your Attached Detail Groups in your own projects. Careful naming often helps reduce errors and limits the complexity of projects.

**EDITING GROUP INSTANCES**

Situations will often arise in the course of a project where one instance of a Group needs to be slightly different from the other instances in the project. In this case, we could certainly repeat the process covered in the previous sequence and duplicate and edit another Group. However, doing so could begin to dilute the usefulness of Groups and make management of the multiple potential variations cumbersome and time consuming. In scenarios such as this, Revit offers us the ability to create overrides to individual Group instances. To illustrate the point, a simple example is appropriate.

**Excluding Group Members**

Continue from the previous Exercise.

1. Delete the two Groups copied above leaving only the original one (in the middle) and its Attached Detail Group.

   Notice that the Attached Detail Groups are deleted automatically when their hosts are deleted. Make sure the Group in the middle is Guest Room A. If it is not, select it and change it on the Type Selector.

   2. Select the remaining Model Group instance on screen.

      - On the Modify panel, click the *Mirror - Pick Axis* button.
      - Click on the centerline of the vertical Wall on the right side of the Group as the mirror edge (see Figure 6.11).

![Figure 6.11](image)

**FIGURE 6.11** Mirror a copy of the Guest Room Group
When you complete the mirror command, a copy of the Group will appear, and a Warning dialog will also appear at the bottom right corner of the screen. This warning is not serious and can be ignored. All such “ignorable” warnings will appear in this location on screen and will have a yellow tint to the dialog in which they appear. It is still a good idea to read the warning message as there is some useful information conveyed in them. In this case, Revit is alerting us that we now have two Walls overlapping in the same spot. While we can ignore this situation, the message further explains that Room boundaries may be affected:

“Highlighted walls overlap. One of them may be ignored when Revit finds room boundaries. Use Cut Geometry to embed one wall within the other. Or tab-select one of the grouped overlapping walls and exclude it from the group instance.”

The right side of Figure 6.11 shows the warning message. If you wish, you can expand the warning dialog to get more detailed information. Do this with the small icon on the right side of the warning dialog. If the warning has closed already, you can click the **Warnings** button on the Inquiry panel of the Manage tab of the ribbon to access it. When you fully expand the error, you can click on each of the overlapping Walls to highlight them on screen (see Figure 6.12).

If you wish to see the element highlighted in other views, click the Show button. Each time you click Show, it will open another view window and highlight the element in question. When you are done reviewing the warning, click the Close button to dismiss it. If you did click show, make sure you return to the *Architecture* floor plan view and then close hidden windows.

In addition to potentially having an adverse effect on Rooms, you can also see that the overlapping Walls do not cleanup very nicely. The solution to both problems is simple: any element in any Group can be excluded from an individual instance of the Group. In this situation, we can exclude the duplicate Wall from one of the Groups.

3. Place your mouse over the double Wall.

Notice that the Group pre-highlights.

- Press the **TAB** key.
Notice that the other Group pre-highlights.

• Press the **TAB** key again.

This time, the Wall within one of the Groups pre-highlights.

• Click to select this Wall.

Notice that on the **Modify | Walls** tab, there is a “Show Related Warnings” icon. This gives you a shortcut to the Review Warnings dialog discussed above, letting you know that there are warnings associated with the selected element.

• Click the Group Member icon in the canvas area to exclude this Wall from the Group (see Figure 6.13).

• Deselect the Group.

Notice that the extra Wall has been removed and the cleanup is now correct. It is important to realize that this change is not simply graphical override—Revit has actually removed one instance of one of the Walls. For example, were we to have counted the Walls before we started and then re-count them now, there would be one Wall fewer in our model. Rather than count the Walls, which might prove tricky, let’s do a similar experiment using furniture, which is easier to count.

4. On the Project Browser, double-click to open the **Furniture** floor plan view.

Furniture elements will appear in the original guest room.

5. Select all of the furniture elements.

Use a window selection to select all the furniture and then click the **Filter** button on the ribbon to remove any unwanted element categories.

• On the ribbon, click the **Create Group** button.

• In the Create Model Group Name field, type **King-01**.

• Using the technique covered in the “Create a Group Instance” topic above, move the origin point to the same location as the Guest Room Group.
Section II • Create the Building Model

6. Mirror the furniture Group to the other guest room (see Figure 6.14).

![Figure 6.14](image)

**FIGURE 6.14** Group the furniture, move the origin point, and then mirror a copy

7. On the Project Browser, beneath Schedules/Quantities, double-click to open the Furniture Schedule view.

Study the table and take note of the totals in the “Count” column. In particular, notice that we currently have 4 Side Chairs (Chair-Viper: Chair). This is impressive; Revit gives us an accurate count even when the items it is counting are inside Groups! Let’s exclude one and see the impact on the Schedule.

8. Return to the Furniture floor plan.

**TIP**

On the View tab, choose Cascade or Tile Windows to see both plan and schedule side by side. The shortcut for Tile Windows is `WT`.

- Using the TAB key, select one of the Side Chairs (near the Windows).
- Click the Group Member icon to exclude this chair from the Group (see Figure 6.15).
- Deselect the chair after excluding it to see it disappear.

![Figure 6.15](image)

**FIGURE 6.15** Excluding an item from a Group removes it from the schedule as well
Now that is even more impressive; the schedule accurately reflects the quantity shown in the model. This example illustrates that you can use the exclude from Groups feature with confidence, as Revit will accurately reflect the exclusions throughout the model.

You should try a few more experiments to become comfortable with the full behavior of this feature. For example, move your mouse over the missing chair and it will pre-highlight as if it were there. In this way, you can TAB back into the Group and bring the element back (include it). Be careful when editing a Group that has overrides applied. You can edit either instance of the furniture Group on screen. However, if you edit the one with the excluded chair, you will not be able to edit the chair at all. If you instead edit the one without exclusions, you will have the ability to edit all its elements including both chairs. You can even move or otherwise edit the chair that is excluded in one of the other Groups. The change will be visible in the Group (or Groups) that shows the chair and not visible in any that exclude it. Try some of these experiments now before continuing if you like.

9. Save the project.

**ADDITIONAL GROUP DESIGN TECHNIQUES**

As you refine your design using Groups, you will find some of the additional techniques covered here useful.

**Creating Attached Detail Groups for Existing Model Groups**

The Attached Detail Groups that we made earlier were created at the same time as the host Model Groups. You can also create them later even after the Model Group has been created.

1. Return to the Furniture floor plan.
2. On the ribbon, click the Annotate tab.
   - On the Tag panel, click the **Tag by Category** button.
   - Tag each piece of furniture in only the guest room showing both chairs.

All of the furniture numbers have already been input in this dataset. To learn more about tagging and editing tag parameters, see Chapter 12. You can move the tags around after placement and adjust the leaders with the handles as required.

   - Select all of the furniture Tags, and then on the Modify | Furniture Tags tab, click the **Create Group** button.

   Remember you can use a window selection and the Filter button to get just Furniture Tags.

   - In the Attached Detail Group Name field, type **Tags** (see Figure 6.16).
As you can see, Revit will automatically recognize that the items being grouped are Tags associated with model elements contained in a Model Group. As a result, an Attached Detail Group is created automatically. Now that we have an Attached Detail Group for our furniture, we could add it to the other instance of our furniture Model Group. However, we will do something a little different with it below.

**Adding Detail Groups to Mirrored Groups**
Attached Detail Groups can be very useful as we have seen. They do have limitations as well as we will see. If we return to the Architecture floor plan, we will notice that the mirrored Group has no Tags.

3. From the Project Browser, re-open the Architecture floor plan.
   - Select the mirrored Group (on the right side).
   - On the ribbon, click the **Attached Detail Groups** button.
   - In the “Attached Detail Group Placement” dialog, place a check in the box next to the **Floor Plan:Tags** Detail Group and then click OK.

   Notice that despite the Model Group's being mirrored, the Detail Group remains “right-reading.” This is true if you mirror in any direction. Furthermore, you can mirror a selection of both Model and Detail Groups together in the same operation and the Detail Groups will remain right-reading as the Model Group mirrors.

4. Select both Model Groups and both Detail Groups.
   - Be careful not to select the Section or Elevation tags.
     - On the Modify | Multi-Select ribbon tab, click the **Mirror - Draw Axis** button.
This allows you to sketch the mirror line rather than pick an object. In this case, we will mirror the selection up at a distance above the selection to allow room for a corridor between the rooms.

- Using the temporary dimension as a guide, click the first point about 5'-0" above the top Walls to indicate the middle of the corridor.
- Drag the mouse horizontally and then click again to complete the mirror (see Figure 6.17).

**FIGURE 6.17 Tags in mirrored Detail Groups remain right reading**

If you zoom in on the new rooms and study the tags, you will see that they are right-reading, yet they each display a unique door number sequentially incremented from where the previous door numbering left off.

5. Select all Groups on screen (4 Model and 4 Attached Detail Groups).
   - Mirror the selection around the centerline of the right most vertical Wall.

As before, a warning will appear indicating that you have duplicate Walls again. Ignore this warning for now.

There are now eight total guest rooms each with its own Tags.

6. Select the four guest rooms in the middle. (Clicking with the **CTRL** key is the easiest method of selection in this case).
   - From the Type Selector, choose Guest Room B.

As we saw earlier in the chapter, not only does the guest room geometry change, but the Attached Detail Group updates as well. Remember, the Attached Detail Groups swap out as well because they have the same names. If you do not keep the names the same (“Tags” in this case), they will not swap out. The duplicate Walls warning will appear again.

- Use the process covered in the “Excluding Group Members” topic above to exclude the extra Walls. (You may need to do this for six Walls total).
- Save the project.
Duplicate Groups on Project Browser

Returning to the Furniture view will reveal that while the Walls, Doors, and Windows contained in the duplicated Model Groups were copied to form additional guest rooms, the furniture was not. This is simply because the furniture is contained in a separate Model group. Let’s duplicate our furniture Group and make an alternate for the other guest room type.

7. On the Project Browser, beneath Model Groups, right-click the King-01 Group and choose Duplicate.

   - Right-click the new copy and choose Rename. Call it: Queen-01 (see Figure 6.18).

Notice that the Queen-01 Group also has its own attached Detail Group named Tags.

There are several commands on the right-click menu. Here is a brief description of each:

- **Duplicate**—Creates a copy of the Group and assigns it a default name.
- **Make Element Editable**—This command is only active in a project using Worksharing. Worksharing is a process enabling a team of people to work in the same Revit project. See Chapter 15 for more information.
- **Copy to Clipboard**—This copies the Group to the clipboard so you can paste it in other projects. This is a fast way to use the same Group in another project. If you paste it in the same project, it behaves like Duplicate.
- **Delete**—This deletes the Group definition from the project. You can only use this command if no instances of the Group are inserted in the project. Use with caution.
- **Rename**—Use to assign a new name to a Group definition.
- **Select All Instances > Visible In View**—Use this command to select all instances of the Group in the current view only.
- **Select All Instances > In Entire Project**—Use this command to select all instances of the Group throughout the entire project. Be careful as this command selects all instances on all levels, even the ones that may not show in the current view.
- **Create Instance**—This adds an instance of the Group.
- **Match**—Use this command to swap one Group with another on screen. You will be prompted to select the Group to use as the source and then the Groups to which to apply the source definition.
• **Edit**—This command will export the Group to a new Revit project and open it for editing. In this way, you can edit a Group independently of the current project and save it as its own file outside of the project. To use the Group saved this way in a project, click the Insert tab and then on the Load from Library panel, click the **Load as Group** button and follow the prompts.

• **Save Group**—This command will also export the Group to a new Revit project but it will not automatically open it. You will simply be prompted for the file name and location in which to save it.

• **Reload**—This is a shortcut to the **Load as Group** button on the Load from Library panel of the Insert tab. Use it to load an external file and replace the internal Group definition.

• **Type Properties**—Opens the Type Properties dialog for the selected Group.

A similar list of commands appears when you right-click a Detail Group.

8. Select the furniture Group with the excluded chair. Notice that the excluded chair appears when the Group is selected.

• On the ribbon, click the **Restore All Excluded** button. The previously excluded chair will be restored.

• With the Group still selected, choose **Queen-01** from the Type Selector.

If you skip the “Restore All Excluded” step, the excluded chair will still reappear when swapping Groups. Instance-level overrides are not retained when changing types.

9. On the Group panel, click the **Edit Group** button.

• Select the bed and from the Type Selector, choose **Bed-Standard : Queen 60" X 79"**.

• Delete one of the lounge chairs and move the bed and nightstands down to fit the room better (see Figure 6.19).

**FIGURE 6.19** Swap in the Queen-01 Group and then modify it
Section II • Create the Building Model

10. On the Edit Group panel, click the Finish button to complete the edit.
11. Select the Queen-01 Group on screen.
   - On the Group panel, click the Attached Detail Groups button.
   - In the Attached Detail Group Placement dialog, place a check in the box next to the Floor Plan:Tags Detail Group and then click OK.

Notice that the Tags have automatically adjusted to the new furniture layout of the Group.

12. Using any of the techniques covered so far; add furniture and Model and Detail Groups to the remaining guest rooms (see Figure 6.20).

FIGURE 6.20 Add furniture groups to the remaining rooms

MAINTAINING GROUPS
As you can see, working with Groups so far has made it easier to compose our overall plan layout and quickly replicate a series of similarly configured spaces. After this initial design work, you may be tempted to ungroup your Groups to gain more direct access to the elements they contain. While it is certainly possible for you to do this, you may want to consider keeping your Groups active well into design development or even CDs. The reason for this is simply because despite our best efforts to minimize them, design changes continue to occur well into the construction document phase and even beyond. Groups can help you make such changes more efficiently.

Add missing elements to Groups
While design changes occur for any number of reasons, in this next example, we will consider a change resulting from an oversight during the design phase.

1. On the Quick Access Toolbar (QAT), click the Default 3D View icon.

Compare the original room that we started with to all of the copied versions and notice that the copies do not include the ceiling elements. Since we have been working exclusively in plan views, we did not notice that the ceilings were not included in the original selection set from which the Groups were created (see Figure 6.21).
The fix for Guest Room A is simple. For Guest Room B there is an extra step. In the original Guest Room A Group (shown in the figure) the ceiling elements are positioned in the proper location. All we have to do is add those stray ceiling elements to the Group and they will appear in all instances of Guest Room A. For Guest Room B, we first need to copy the ceiling elements into position relative to one of our Guest Room B Groups and then add them to the Group. While the 3D view was useful to identify the problem, a ceiling plan view is the best choice for making the required edits.

2. On the Project Browser, double-click to open the *Level 1 Ceiling Plan.*

Zoom in on the original Guest Room A; in this case, it has an interior elevation tag within it, making it easy to locate. If you compare the elements in the original Guest Room A to the others, you will notice that there is a small Wall separating the main guest room from the entry foyer. We'll need to mirror this Wall from Guest Room A to Guest Room B to form the boundaries for the Ceiling elements.

3. Place your mouse over the Wall between the foyer space and the main room and then look at the Status Bar (at the bottom of the Revit screen).

Press tab if necessary to highlight the Wall.

A message will appear reading “Walls : Basic Wall : Generic 5.” The format of this message is: *Category : Family : Type.* All Revit objects appear in this format when pre-highlighted on screen. (See the “Status Bar” heading in Chapter 2 for more information.)
Depending on your settings, the same information may appear in a tooltip on screen (see Figure 6.22).

**FIGURE 6.22 The Status Bar reports the Category, Family, and Type of pre-highlighted elements**

- When the Wall between the foyer space and the main room highlights, click it to select it.

If your Wall is not in the same location, you may have inadvertently moved it during the previous exercises. Use the **Align** button on the Modify tab to position it back where it was shown in the figure before proceeding.

4. On the ribbon, click the **Mirror - Pick Axis** button.
   - Using the center of the Wall between the two guest rooms, mirror the elements to the neighboring room (see Figure 6.23).

**FIGURE 6.23 Mirror the Wall required to enclose Ceilings**

While it would be possible to select and mirror the existing Ceiling objects to the other space as well, in this case it will be better to recreate them since the shapes of the rooms do not match.

5. Select the original instance of the Guest Room A Group.
   - On the Group panel, click the **Edit Group** button.

<table>
<thead>
<tr>
<th>TIP</th>
<th>The shortcut for <strong>Edit Group</strong> is <strong>EG</strong>.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- On the Edit Group panel, click the <strong>Add</strong> button.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>TIP</th>
<th>The shortcut for <strong>Add to Group</strong> is <strong>AP</strong>.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- This tool allows us to add items from the main model into the Group. When we are finished editing, these elements will appear in all instances of the Group.</td>
</tr>
</tbody>
</table>

6. Move your mouse near the edge of the toilet room in Guest Room A. The Ceiling object will pre-highlight.
   - Click the Ceiling to add it to the Group (see Figure 6.24).
Repeat for the foyer Ceiling, the closet Ceiling, and the small Wall.

7. Finally, add the Ceiling in the main guest room space to the group.
   Press the tab key if necessary to assist in adding any of the elements.
   - Once you have added four Ceilings and the Wall to the Group, click the Finish button on the Edit Group panel.

If you return to the (3D) view, you should notice that the four Guest Room A Groups now have Ceilings. To add ceilings to the Guest Room B Groups, we will simply create new ones.

8. In the Ceiling Plan Level 1, select the instance of Guest Room B to which we mirrored the small Wall above.
   - Click the Edit Group button.
   - Add the small Wall to the Group.

9. Click the Home tab of the ribbon.
   - Click the Ceiling button.
   - From the Type Selector, choose Compound Ceiling: GWB on Mtl. Stud.
   - Click inside each enclosed space to add Ceilings.

If you wish to make the Ceiling in the main part of the guest room taller, select it and on the Properties palette, change the Height Offset From Level to 9'-0".
   - Click the Finish button on the Edit Group panel when done.

If you return to the (3D) view, you should now have Ceilings in all rooms.

NESTING GROUPS

As we have seen, most model elements can be added to Model Groups. We can also make a Group that contains other Groups. So-called “Nested Groups” can be useful, but can also present certain challenges. For example, in the dataset we have open, it might be useful to group all of the various guest rooms and their furniture into a single Group named something like “Typical Floor Layout.” This approach may certainly prove valuable at the early stages of design where you stand to gain an advantage from the ease of being able to edit a Group instance and have the changes apply across the entire project. However, there are limitations. The most notable is that Attached Detail Groups only work one level deep. This means that you cannot make a Group containing both Model and Detail Groups as members. You will still be able to apply Attached Detail Groups to the nested instances of the Model Groups, but you will have to use the TAB key to select each instance before placement. With careful planning, you can certainly make a workable solution; the only caution is to plan your strategy carefully before execution.
To create a nested Group, you simply select objects (including other Groups) and then click the *Create Group* button as we have done already.

**Creating a Nested Group**

Let’s do a quick example of a nested Group in the project we have open. Suppose we wanted to explore adding some more Levels to this project and reusing the layout we have devised here on those Levels. We can certainly use Copy and Paste in that scenario, but creating a Group of the entire layout affords us the opportunity to make edits to the Group later and have those edits apply automatically to all Levels.

1. On the Project Browser, double-click to open the *Section 1 Building Section* view.
2. On the Home tab, on the Datum panel, click the *Level* button.
   - Using the Pick Lines draw icon, create a Level 12'-6" above the existing Level 1.
   - Rename it *Level 2* (see Figure 6.25).

![Figure 6.25 Add and rename a new Level](image)

3. Return to the *Architecture Floor Plan* view.
4. Select all eight Model Groups on screen.
   - On the Modify Model Groups tab, on the Create panel, click the *Create Group* button.
   - Name the Group: *Typical Floor Layout* and then click OK.

Take notice of the Project Browser after you complete the Group. Typical Floor Layout will show Guest Room A and B indented beneath it. This indicates that these two Groups are nested within it (see Figure 6.26).

![Figure 6.26 Add and rename a new Level (continued)](image)
5. On the Project Browser, double-click to open the Level 2 Floor Plan.
6. On the Project Browser, right-click Typical Floor Layout and choose Create Instance.
   - Snap to the Group Origin of the Group on the level below and then click the Modify tool (see Figure 6.27).

![FIGURE 6.27 Create a new instance of the Group at the Group Origin](image)

**Adding Attached Detail Groups to Nested Groups**
If you want to add the Tags Groups, you have to use the TAB key.

7. Place your mouse over one of the Groups.
Notice that the entire floor layout Group pre-highlights.
   - Press the TAB key.
   - Click to select the nested Group instance.
   - Click the Attached Detail Groups button, choose the Floor Plan:Tags Group and then click OK (see Figure 6.28).
You can repeat the process on the other Groups if you like. Following any of the procedures covered so far, you can also edit either the nested Groups or the overall Group and see the results throughout the model and in the Attached Detail Groups. Feel free to experiment further before continuing.

**GROUPS AND REVIT LINKS**

We have explored many techniques and advantages of working with Groups so far in this chapter. You can begin to see the many advantages of including Groups in your workflow. While working with Groups directly in a project can prove a useful strategy for managing typical and repetitive design conditions, it is sometimes even more advantageous to export a Group to its own separate file. This can be achieved by saving the Group or converting it to a Linked file.

**Saving a Group to a File**

A Group can be saved to a separate Revit file. This enables you to work on the Group independently of the project. This can be useful if the project is particularly large and/or if you want to have another colleague working on the Group at the same time as you or someone else is in the project file. It also allows you to use the Group in other projects.

1. On the Project Browser, right-click the King-01 Group and choose **Save Group**.
   
   - In the Save Group dialog, browse to the Chapter06 folder, verify that the "Include attached detail groups as views" checkbox is selected, and then click Save (see Figure 6.29).
The file name defaults to the same name as the Group: King-01 in this case. Once the save is complete, you can open the file to study the result.

2. From the Chapter06 folder, open the King-01 file.
   • On Project Browser, expand Views.

You should have two floor plan views: Level 1 and Tags. Tags contains the annotation contained in the Attached Detail Group of the same name in the main project. The Level 1 view contains the model geometry. You can make any edits here that you like. Upon saving those changes, we can reload them back into the main project.

3. In the Level 1 floor plan view, make a change to the furniture layout.
   • Save and close the King-01 file.
   • Back in the main project, right-click the King-01 Group on Project Browser again and choose Reload.
   • In the dialog that appears, browse to the Chapter06 folder and select the King-01 file to reload.
   • Accept the defaults and click OK in any warnings.
   If you are not in a view that shows the furniture, switch to one now to see the results.

Convert a Group to a Linked file

Revit also provides the ability to embed other Revit files in your project as Revit links. A linked file provides many of the same advantages as Groups but remains a separate project file on your hard drive or server maintaining a live link for easy reloading. In this way, another individual can work in the linked file simultaneously. When the linked file is saved, you can capture the latest changes by reloading the linked file. The process is similar to the one just outlined, but the path to the link file is saved with the project so that we do not have to browse to each time we reload.

4. On the Project Browser, double-click to open the Level 2 floor plan.
5. Select the Typical Floor Layout Group on screen.
   • On the Group panel, click the Link button.
   • If a warning appears, click OK.
   • In the “Convert to Link” dialog, click the “Replace with a new project file” option (see Figure 6.30).
In the “Save Group” dialog, browse again to the Chapter06 folder and then click Save. The first dialog was a warning about elements being deleted. This is because we had previously applied tags (via an Attached Detail Group) to the original model Group. When you convert a Group to a Link, the annotation cannot remain applied. The second message allows us to create a new file from the Group we are replacing, or to point to an existing file already on our hard drive or server to swap in its place. In this case, creating a new project file was our obvious choice.

When the conversion is complete, you will see that the newly created file automatically appears beneath the Revit Links node of the Project Browser (see Figure 6.31). Here you can access features of the linked file via the right-click menu.

Feel free to open the linked file, make a few edits, and then re-save and reload the file. When you try to open the linked file, Revit will warn you that it must be unloaded in the current project, and the unload can’t be undone. This is normal. Click Yes to proceed. Once edits are complete in the Typical Floor Layout.rvt file and saved, you
can close it and back in the *Understanding Groups.rvt* file, right-click the linked file on the Project Browser and choose **Reload**. You will not need to browse to it again. The path for links is saved with the project. You can also right-click on the Revit Links branch of the Project Browser and choose **Manage Links** to see a dialog listing paths and other information about linked files.

**Binding Linked Files (to Groups)**

The opposite of converting a Group to a linked file is “Bind,” which converts a linked file into a Group.

1. Select the linked file.
   - On the **Modify | RVT Links** tab, on the **Link** panel, click the **Bind Link** button.
   - In the dialog that appears, choose Attached Details and then click **OK**.
   - Accept the default in the remaining dialog(s).
   - Remove the link when prompted.

The Revit link should now be removed and in its place the Group that we started with should have been restored.

2. Save the project.

**Working with Rooms in Groups**

When the time comes to add Room objects to our project we can choose to add them within the Groups or outside the Groups. If we add a Room to each Guest Room Group, they will appear in all instances like other objects. We can then tag them inside an Attached Detail Group or directly on the floor plan view.

Another approach is to simply add the Rooms outside of any Groups directly in the project. Since the Room object will conform automatically to the shape defined by the Walls, either approach is completely valid.

To compare methods, try both approaches in the current project.

3. In the **Architecture** floor plan view, select one of the Guest Room Groups (use the **TAB** key to assist in selection).
   - Click the **Edit Group** button on the ribbon.
   - Using the **Room** button on the Room & Area panel of the **Home** tab, add a Room in the main space.

You will see the Room object conform to the shape of the main room plus the entry foyer. If you like you can repeat the process to add additional Rooms for the closet and toilet room. However, in some cases, for a hotel room layout such as this, you may not want to have separate Rooms for each of these spaces, but might instead prefer a single Room that expands to include the closet and toilet rooms within it. To do this, we can select the Walls between the toilet room and main guest room area and make them “non room bounding.”

4. Click the **Modify** tool and then select the Walls that separate the toilet space and closet from the main space (5 total).
   - On the Properties palette, turn off “Room Bounding” (see Figure 6.32).

When you click **Apply**, the Room should now ignore the interior Walls and fill the entire guest room layout.
When you finish the Group the Room will be added to all instances. Again, the Room Tag will need to be attached separately as explained in “Edit a Group” above. If you wish to try the alternative method, simply exit the edit Group mode and add Rooms directly to the project. Tags can also be free-standing or grouped in Attached Detail Groups.

There are certainly plenty of other equally useful applications of Groups including typical toilet room layouts, typical stair tower, office furniture layouts, etc. For example, in the previous chapter we used a simple Group to create a typical floor framing condition that was copied to multiple floors in the building. There are almost limitless applications for Groups.

For your further experimentation, a larger and more complete dataset similar to the one utilized in this chapter has been provided. You will find two versions of “MRAC Hotel” in the Chapter06 folder. One version named MRAC Hotel (With Rooms).rvt has the Room objects embedded within the Guest Room Groups. The other version MRAC Hotel (Without Rooms).rvt has the Rooms placed directly in the project (not in the Groups). You are encouraged to open each of these files and experiment further with all of the techniques covered in this chapter (see Figure 6.33).
LINKED PROJECTS

Throughout the course of this chapter, we have worked in a separate dataset and not re-visited our commercial and residential projects. While theoretically any project can make use of Groups and Linked files, our residential project has no need for either. However, our commercial project can make use of both. We have already added a Group to our commercial project at the end of Chapter 5 (for the structural framing) and we can also make use of Linked files for certain aspects of the project as well.

Many firms using Revit take advantage of Linked files as a way of splitting up larger projects into more manageable pieces. It is common to see separations made along various disciplines (such as architectural, structural and mechanical) and sometimes between major functional areas of the project (like core, shell, and interiors). These are of course suggestions and each firm and in fact each project can and often will implement some variation of these. The one strategy that is common is to separate a large project into smaller files so that different team members can readily work in separate areas simultaneously.

Now that we have explored most of the concepts of Groups and Links in the dataset files accompanying Chapter 6, let’s return to our commercial project to see how some of these concepts might apply and allow the project to progress.

Using Linked files is only one way in which Revit teams collaborate. The other method involves a toolset called “Worksharing,” “Worksets,” and “Element Borrowing.” The Worksets function of Worksharing provide a means to separate a single building model into discrete portions for purposes of facilitating multi-user access to the same model. The process involves the creation of a “Central” model stored on a common network server and individual “Local” files on each team member’s workstation. Revit keeps track of changes that each user makes by enabling object locking at the Workset level and the level of the individual element (referred to as “Element Borrowing”). Worksets will be discussed more extensively in Chapter 15. If you are working in a team of Revit users, then Worksharing is a must. Please set aside time to read the material included in Chapter 15 before participating in your first team project. Worksets are used within the office local area network (LAN) and Linked files are typically used to collaborate with external consultants such as Civil, Structural, MEP and other design firms. Links are not limited to external consultants, and are certainly used for internal workflow management as well.

Load the Commercial Project

Be sure that the MRAC Hotel.rvt and Understanding Groups.rvt Projects are saved and closed.

1. On the QAT, click the Open icon.

The keyboard shortcut for Open is CTRL+O. Open is also located on the Application menu.

   • In the “Open” dialog box, browse to the location where you installed the MasterRAC 2012 folder, and then open the Chapter06 folder.

2. Double-click 06 Commercial.rvt if you wish to work in Imperial units. Double-click 06 Commercial Metric.rvt if you wish to work in Metric units.
   You can also select it and then click the Open button.
The project is in much the same state as we left it at the end of the previous chapter. However, some important changes have been made since we closed it there. For this reason, be certain that you use the new dataset provided for Chapter 6 and do not attempt to continue in your own files from the previous chapter. The building still looks the same, but the toposurface is no longer in the file. The geometry for the site was removed and we will now walk through the process of creating a separate Revit project for the site data. Using techniques covered in this chapter, we will then link the Site project we create back into the Commercial project.

**Create and Link a Site Project**

Frequently you will receive site plan data from outside firms in AutoCAD DWG or Microstation DGN format. Revit Architecture readily imports files saved in either format (and others as well). The linework in those files can be used to create a Toposurface. (In order for this to work correctly, the linework in the file has to be drawn at the correct z-height corresponding to the actual contour level you wish to create).

This means that if your Civil Engineer did not draw the contours at their actual elevations, you will have to open the file in the original application (AutoCAD or Microstation) and move the contour lines to their correct Z heights. If you do not own a copy of the application, you can ask your consultant to do this for you before they send the file.

Let’s import some contour lines from a DWG file and generate a new Toposurface. We will create a new Revit project in which to do this. We could, of course, import the CAD file directly into our Commercial project, but as noted above, it is common “best-practice” for such data to be contained in a separate project and then linked back into our project. This makes it easier to coordinate the sometimes different needs and workflows of the different disciplines responsible.

If you prefer to skip this exercise, you can instead use the Commercial Site project file provided in the `Chapter06\Complete` folder. To do so, skip to the “Link the Site Project” topic below.

**Create a New Project**

1. From the Application menu, choose New > Project. (Access the Application menu by clicking on the big “R” button at the top left corner of the application frame).
   - In the “Template File” area, be sure that default template file is selected: `default.rte` [DefaultMetric.rte] (dialog shown in Figure 4.1 in Chapter 4).

   If your version of Revit Architecture does not include the template files cited here, both have been provided with the dataset files. Please browse to the Templates folder in the location where you installed the dataset files to find them.

   - In the “Create New” area, verify that Project is selected and then click OK.

2. Double-click to open the Site floor plan view.
Link the Site Plan CAD File

3. On the Insert tab of the ribbon, click the **Link CAD** button.

This command creates a live link to a CAD file. If the original file should be changed
in its host application, Revit will be able to reload the changes.

4. In the “Link CAD Formats” dialog, browse to the Chapter06 folder.
   
   • Select (do not double-click) the Commercial-Site.dwg [Commercial-Site-Metric.dwg]
     file (don’t click Open yet).

Several options appear at the bottom of the dialog.

**Current view only**—this checkbox will import the file into the active Revit view only.

This means that the CAD file will not display in any other view. (This can be useful
in some cases, but if you wish to use the imported file to generate a Toposurface,
as we do here, do not use this option. You will not be able to select the contours
of the imported file while using this option.) If you recall the “Revit Architecture Elements” topic in Chapter 1, we learned there that Revit treats model elements differently than annotation elements. In particular, model elements appear in all views
while annotation elements appear only in the view in which they are created. This checkbox basically tells Revit to treat the linked file like model elements when it is
unchecked, or annotation elements when it is checked.

**Layers**—most CAD files use layers (or levels in DGN files) to organize the geometry
they contain. These layers/levels can be interpreted in the incoming file. If you wish
to import only certain layers in the CAD file, you can choose either the “Specify” or
“Visible” options. Visible brings in only those Layers not turned off in the CAD file,
and the Specify option will display the list of all Layers and let you select the ones
you need. The default setting brings in all layers.

**Colors**—most DWG or DGN files are saved in multiple colors. The options here
allow you to control how this color data is handled on import. If the CAD data was
drawn in a black background, try the Invert option to make the colors read better.

**Import units**—Auto-Detect is usually the best option. However, in cases where
Revit misinterprets the units in the CAD file, you can designate the proper unit manually.

**Positioning**—there are several options. “Auto - Center to Center” is the simplest
option. It simply matches the geometric center of the imported file to the geometric
center of your active Revit view ensuring that something will show up when you
finish. If the file is a one-time import and you are reasonably certain that you will
not need to import additional files, this can be the most convenient option. If the
imported file has a known and meaningful origin, the “Auto - Origin to Origin”
can be used. When you allow Revit to align the origin of the DWG or DGN file to
the Revit model origin, you can later import additional DWG or DGN files based
upon the same origin point and be certain that they will automatically align properly
with the existing geometry. The only problem with the origin to origin option is
that your Revit project may not be built to match the origin in the incoming file,
or the origin might be far from the model geometry. In this case, you can use one of
the other options, make adjustments and then establish shared coordinates between
your project and the link. The benefit of this approach is that it does not force you
to adopt the origin of the incoming file at the expense of the host project. For the
CAD file we are importing here, we will use the origin option and see if that gives
us acceptable results.
Several manual options are also available allowing you to use the mouse pointer to place the imported file in any location you like. If you intend to move the linked file into the proper position after import, the manual options can prove more convenient. The “Place at” option controls which level the link is imported to.

- From the “Colors” list, choose **Preserve**.
- Leave Layers set to **All** and Import Units at **Auto-Detect**.
- Leave “Current View Only” checked off.
- Leave “Orient to View” checked on.
- For “Place at” leave “Level 1”
- From the “Positioning” list, choose **Auto – Origin to Origin**, and then click Open (see Figure 6.34).

![Figure 6.34 Import the Site data from a DWG file](image)

5. On the Navigation Bar, choose Zoom to Fit.

### TIP

The shortcut for Zoom to Fit is **ZF**.

The CAD file has been inserted into the Revit project relative to its own origin point, which occurs at the point where the Project Base Point and Survey Point icons (the blue icons in the center of the elevation marks) appear.

### BIM Manager Note

In this particular CAD file, the origin is not too far from the site of the building. However in many real-life projects, the origin can actually be quite far from the building(s). If the origin of the CAD file is greater than 20 miles [32.18km] away from the origin of the Revit project, Revit may not be able to use the Origin to Origin option. In such a case, a warning will appear on screen during import and the Center to Center option will be substituted. If this occurs in your projects, use Shared Coordinates to keep the relative origins in synch with one another. This allows linking of data files (RVT, DWG, DGN, or other formats) where the origin point within the linked file may be very far away from the fixed Revit Base Point (origin). Shared Coordinates is covered below.
If you zoom in on the CAD file, you will notice labels on the contours and several spot elevations. These labels are in feet[meters]. They tell us the actual height at which each of the contour lines is placed in the CAD file.

6. On the Project Browser, double-click to open the South elevation view.

Notice that we have the two default Levels at 0'-0" and 10'-0" [4000] and that the contour lines from the imported DWG file appear above these Levels at the distance indicated by the plan labels we just studied. Returning to the plan view, we will note a blue rectangular shape in the file indicating the location of the building. Furthermore, interpolation of the contour labels puts the elevation at the front façade at approximately 81'-0"[24300]. We will use this number in the elevation view to adjust the height of Level 2. Then we will rename the two Levels to something more descriptive.

- In the South elevation view, change the height of Level 2 to 81'-0" [24300].
- Rename Level 1 to Datum and rename Level 2 to Street Level. When prompted about renaming corresponding views, choose Yes.

7. Save the project as Commercial-Site.

- On the QAT, click the Default 3D View icon.
- On the View Control Bar, choose Shaded.
- Orbit the model.

Notice that the contours in the CAD file are just lines and do not have any surface.

**Build a Toposurface from imported Data**

Now that we have imported the 3D contour line data from the DWG file, we can use it to create a more accurate Toposurface than the one created from manual points in Chapter 4.

8. On the Project Browser, open the Site view.
9. On the ribbon, click the Massing & Site tab and then click the Toposurface button.

The Modify | Edit Surface tab will appear with the Place Point button active.

10. On the ribbon, click the Create from Import button.

- From the pop-up that appears, choose Select Import Instance.
- Click on any of the objects in the imported DWG to select it.
- In the "Add Points from Selected Layers" dialog, click the "Check None" button.
- Place a checkmark in only the "C-Site-Cntr" and the "C-Site-Cntr-Intm" checkboxes to select only those two layers (see Figure 6.35).
Section II • Create the Building Model

• Click OK to create the points.

Several points will be extracted from the geometry on the selected layers, and from those points a Toposurface will be created.

• On the ribbon, click the Finish Surface button to exit sketch mode and complete the Toposurface.
• On the QAT, click the Default 3D View icon.
• Orbit the model.

Notice that there is now a three-dimensional surface spread across the contours from the CAD file.

11. On the Project Browser, double-click the East elevation view.

If you zoom in, you’ll see a sloping profile of the terrain similar to the manual surface we created in Chapter 4. This Toposurface has more points and does a better job suggesting the roads that surround the building site. The manual method of placing individual points that we used in Chapter 4 is effective when you do not have any civil engineering files to import. If you receive a site plan file, it is usually easier to use the linked file. Otherwise, you can quickly create a suitable site for your building model with the point sketching method as well. Either method is appropriate for creating Toposurfaces in your own projects.

Add a Building Pad

Let’s add a Building Pad. A Building Pad adds a simple slab surface that cuts into the terrain model as appropriate to suggest the required excavation or other prepared surface of construction. It will be easier to do this without having the model shaded.

12. On the Project Browser, double-click to open the Site view.
The site plan data imported from the DWG file includes a rectangle that approximates the rough footprint of the building. We can use this to assist us in sketching the Building Pad. However, at the moment the Toposurface is concealing the linked file.

- On the View Control Bar, click the Model Graphics pop-up and choose **Wireframe**.

13. On the Massing & Site tab, click the **Building Pad** button.

- On the Modify | Create Pad Boundary tab of the ribbon (now in Sketch mode) click the **Pick Lines** tool.
- In the view window, position the pointer over one line of the building footprint in the middle of the site (the line should pre-highlight) and then press the **TAB** key.
- When all lines of the shape pre-highlight, click the mouse to create sketch lines (see Figure 6.36).

![Figure 6.36](image)

**FIGURE 6.36 Use the tab key to Chain Select and create Sketch Lines**

On the Properties palette, change the Level to **Street Level**.

For the "Height Offset From Level" parameter, input `-4'-0" [-1200]` and then click **Apply**.

On the ribbon, click the **Finish Edit Mode** button (big green checkmark).

14. On the QAT, click the Default 3D View icon.

- Zoom as required to see the Pad and its relationship to the Toposurface.

15. Save the Project.

There is plenty more work that we can do to the Site project. However, for the purposes of preparing the file for linking into the Commercial project (which is the primary goal for it in this chapter) we have completed enough work in the Site file for now. If you wish to go further with the Site project, refer to Appendix A for additional exercises on splitting the surfaces, applying materials and suggestions on adding trees and parking.

16. From the Application menu, choose **Close**.
Link the Site Project

Now that we have built a Site project, imported contours from the Civil Engineer and created a Toposurface, we are ready to link this project into the Commercial project. The process of creating a Revit link is nearly identical to the process used in the “Link the Site Plan CAD File” topic above. The Commercial project file should still be open. If you closed it, please reopen 06 Commercial.rvt [06 Commercial Metric.rvt] now.

17. In the 06 Commercial.rvt [06 Commercial Metric.rvt] project file, on the Project Browser, double-click to open the Site plan view.
18. On the Insert tab, on the Link panel, click the Link Revit button.
   • In the “Import/Link RVT” dialog, choose Commercial-Site.rvt, accept the default Center to Center positioning and then click Open.
   If you decided to skip the previous exercise and did not create the Commercial-Site file, you can instead link to the 06 Commercial-Site-Complete.rvt [06 Commercial-Site Metric-Complete.rvt] file provided in the Chapter06/Complete folder.

When the site file is linked in, it does not align with the building properly. It is to the upper left of the building (and if you looked in elevation, it is also at the wrong height). The Site project was created from a CAD file using the CAD file’s origin. Our building was created in the center of our project template’s elevation view markers where the Revit file’s Base Point (origin) is located (you can see this origin in the current view as the blue icons in the center of the screen). Therefore it is not surprising that things do not line up. While we could have started with the site plan data and built our model to match the orientation of the imported file (True North), it was more convenient to model our building relative to the project template setup (Project North) with the footprint of the building orthogonal to the screen edges.

One of the advantages of using linked files is that each model file can maintain its own coordinate system, called Project Coordinates, with its own Base Point (origin) without imposing it on the other files in the project. There is a bit of setup required to synchronize the different models’ coordinate systems, but once complete, each model maintains its own internal coordinates (Project Coordinates) and also understands how it relates to the other files (Shared Coordinates).

The basic setup process for establishing shared coordinates is as follows:
   • Gather all required project files and decide which one will be “primary.” (This is the file with which the others will synchronize their coordinates).
   • Link the files.
   • Move and rotate linked files as required to establish the correct geographic relationships. (For example, move the site file link so that the site data is correctly oriented and located under the building).
   • Save Shared Coordinates for each pair of files.

The overall process is straightforward. Let’s walk through the process now with our two project files. For step 1, we have two project files, the Commercial project and the Commercial Site. The “Primary” file in this case will be the Site file. This just means that we will “acquire” coordinates from the Site file. More detail on acquiring coordinates is found in the “Set up Shared Coordinates” topic below. We have already accomplished step 2 by linking the Site file in the previous sequence. The next task is to move and rotate the linked file (Site project) to match the orientation and location of the host project (Commercial project). We can achieve this using the Move and Rotate tools or the Align tool. Let’s look at both options.
Using Rotate

19. Select the linked site file. (You can click on it anywhere and the entire file will highlight.)
   • On the Modify | RVT Links tab, click the Rotate button.

   **The shortcut for Rotate is RO.**

If you know how much you want to rotate, you can simply type in the angle in the field on the Options Bar. Otherwise, you can rotate graphically on screen. A small round “center of rotation” control will appear at the middle of the selection. Using this control, you can change the center of the rotation to the desired position. New in this release, this can be accomplished with two clicks rather than dragging. There is also now a button on the Options Bar for this purpose. You can either click the center of rotation onscreen and then click the new location, or simply click the Place button on the Options Bar and then click where you would like the center to be.

   • Click the small blue circle handle indicating the center of rotation or click the Place button on the Options Bar (see panel 1 in Figure 6.37).

   • Click at the lower right endpoint of the building footprint to place the center of rotation (see panel 2 in Figure 6.37).

   • Move the mouse toward the opposite endpoint of the building edge and then click along the line (see panel 3 in Figure 6.37).

   • Finally, move the mouse to the right. It will snap vertically. When it does, click to finish the rotation (see panel 4 in Figure 6.37).

The result should be that the building footprint is perfectly orthogonal to the screen as shown in the far right side of the figure.

![Figure 6.37 Rotate the linked site file to make the building footprint horizontal](image)

Next we’ll move the file and snap it to our building model.

The Link should still be selected, if it is not, click to select the linked file again.

20. On the ribbon, click the Move button. (Make sure that Constrain on the Options Bar is not checked.)

   **The shortcut for Move is MV.**

   • For the start point, use the same endpoint about which you rotated.

   • For the move end point, snap to the corresponding endpoint on the building model geometry. (You may need to pan or zoom. Use your wheel mouse for this.)
If you are having trouble snapping to the precise point, move it close, then zoom in and repeat. You can type the shortcut SE to force Revit to snap to the endpoint.

The linked file will remain selected (highlighted in light blue). The footprint of the building should be shaded a little darker helping you determine if it is lined up properly. Repeat move or rotate if necessary to finetune the position or try the Align command as outlined next.

**Alternative Positioning Technique**

The Rotate tool is an important tool and you should be sure you are comfortable with the technique for changing the center of rotation. However, there is an easier way to position the linked file with the building model—use the Align tool.

If you wish to follow the steps, undo the move and rotation. Otherwise, skip to the next topic: “Position the Link Vertically.”

- On the Modify tab, click the Align button.

The shortcut for Align is AL.

- For the alignment reference, click the outside edge of the top horizontal Wall of the building model.
- Click the top angled edge of the building footprint sketch in the linked file next (see the top of Figure 6.38).

**FIGURE 6.38** Align can be used to rotate and move simultaneously

- Repeat the Align process to align the vertical edge (see the bottom of Figure 6.38).

Select the linked file when you are finished and as before, it will highlight and turn transparent so that you can visually verify that the alignment is correct. Both the align and rotate/move methods achieve the same result. The align method is a bit quicker, but there will be times when rotating and/or moving is preferred. Be sure you are comfortable with both methods before continuing.

**Position the Link Vertically**

Finally, if we look at one of the elevation views, it will become clear that there is one more adjustment required. Recall that in the “Link the Site Plan CAD File” topic above, we noted that the contour lines near the center of the building are at 81'-0". We adjusted one of the Levels to this height in the Site file in preparation for making the vertical adjustment here.
21. Open the North elevation view.

Currently we do not see the linked file in this view at all. This is because the elevation view has the crop region enabled. We must temporarily turn it off to make the required adjustment.

22. On the View Control Bar, click the Do Not Crop View icon.

You can see the View Control Bar in Figure 4.36 in Chapter 4.

Notice that once you disable the cropping, the linked file appears and the Toposurface in that file covers the entire building. Zoom out as necessary.

23. On the Modify tab, click the Align button.

- For the alignment reference, click on the Street Level line of the building model (in the current project).
- For the entity to align, click the Street Level line in the linked file. (You may have to zoom to find it.)
- Do not click the lock icon.
- On the ribbon, click the Modify button.

The Toposurface should now appear at the base of the building model (see Figure 6.39).

![Figure 6.39 Move the link file vertically in the elevation view using the Align tool](image)

24. On the View Control Bar, click the Crop View icon.

Check all four elevations. If necessary, click the Show Crop Region icon in each elevation, adjust the Crop Region, hide the Crop Region, and finally make sure that the Crop is turned on for each elevation.

25. Save the project.

**Survey Points, Project Base Points and Shared Coordinates**

The basic mechanics of linked files have already been discussed in the topics above. As we have seen in the previous sequence, when files authored by different parties are linked together, it is important to establish a common reference point for these files. This will ensure that common physical features maintain their proper geometric relationship and position relative to one another.

To help us in maintaining these relationships, Revit projects have the following tools:
Section II • Create the Building Model

**Project Base Point**—is the origin (0,0,0) of the project with respect to the *project coordinate system*. This coordinate system relates to the project itself, and by default is in the center of the default plan view.

**Survey Point**—represents a known point in the physical world. This might be some benchmark indicated by the Civil Engineer. The Survey Point is useful to correctly locate and orient your building project in another meaningful coordinate system such as the coordinate system used by a civil engineering application.

**Shared Coordinates**—reconcile the differences between the current project’s coordinate system and the coordinate system used by a linked file. Setting up a Shared Coordinate system keeps all linked files in the correct relative positions to one another while allowing each to maintain its own internal coordinate systems.

**Understanding Project Base and Survey Points**

The default template from which we began our Commercial project has the Project Base Point and the Survey Point icons displayed in the Site plan view. Other views do not display them by default. If you wish to see these points, their visibility is easy to turn on.

1. Open a plan view.
   - On the View tab, click the **Visibility/Graphics** button.

   The keyboard shortcut for Visibility/Graphics is **VG**.

   The Project Base Point and the Survey Point icons are subcategories of the Site category.

   - Expand the Site category.
   - Place checkmarks in the boxes next to Project Base Point and Survey Point and then click OK (see Figure 6.40).

   ![Visibility/Graphics dialog box](image)

   **FIGURE 6.40** Turn on Project Base Point and Survey Point

   Like other display settings, this visibility change must be performed in each view where you wish to have these points display. The Project Base Point is a round symbol with a cross through the middle. The Survey Point is triangular in shape with a
small plus (+) sign in the center. Both points are displayed on the right side of Figure 6.40 as they appear when not selected and when selected. In our project, they are currently directly on top of one another. This simply means that both coordinate systems currently share the same origin.

2. Select the Project Base Point. (Use the TAB key if necessary.)

The coordinates of the point are listed as editable dimensions next to the icon. You can type new values into any of these dimensions to move the point. For now, do not make any changes.

3. Deselect the Project Base Point and select the Survey Point. (Use the TAB key if necessary.)

Notice that both points are currently located at the origin (0,0,0). Again, do not change the location at this time.

**Saving Shared Coordinates**

If the linked file(s) were to later change and require reloading, we want to be sure that they reload in the same relative location. More importantly, if we decide to also link the architectural file to the site file, we would not want to have to move, rotate or align the positions of the file again. Saving a shared location for the file basically makes each file (the host and the link) aware of the other and what offsets and rotations are required for correct orientation in both files. When a Shared Location is saved from the host file, Revit saves this information into the link file, even if the link file is not open. This is also true of linked .dwg files.

4. Open the Site view.

5. Select the linked (site) file on screen.

   - On the Properties palette, beneath Identity Data, change the Name to: **Site**.
   - Beneath Other, next to Shared Site, click the <Not Shared> button.

The “Share Coordinates” dialog lists two ways that the coordinate systems can be reconciled. The two methods are very similar and differ only in which file will be recorded as the “primary” file. In each case, the Shared Coordinate information must be saved to both the host file and the linked file. Publishing makes the host file predominant, while acquiring makes the linked file predominant. While there is no “correct” choice, making the file that contains the site data the primary file usually makes sense and is a common practice. In this case, this means we will want to acquire the coordinates from our site file. After we do so, Revit will save the Shared (Location) Coordinates to both files the next time we save the current model. In other words, on the next save of the current model, the host model, i.e., the 06 Commercial.rvt [06 Commercial Metric.rvt] project file, the “Location Position Changed” dialog will appear. In addition to saving the current model Revit also writes the Shared Coordinates back to the Site model. This happens any time a linked file in a host file with reconciled shared coordinates moves in any direction.

   - Click the “Acquire the shared coordinate system of...” radio button.
   - At the bottom of the dialog, click the Change button.

Revit projects can have one or more saved locations within them. This is useful when the same building model must be repeated on a site, such as a multi-building campus of condominium buildings. In our case, we have only one building model and could simply accept the default location name. However, it is good practice to get in the habit of renaming the default location so that later you can use this to verify that you have, in fact, reconciled the coordinates.
In the “Location Weather and Site” dialog, click the Rename button and change the name to **MRAC Commercial Site** (see Figure 6.41).

![Figure 6.41](image)

**FIGURE 6.41** Acquire the Shared Coordinates system and rename the default location

- Click OK two times.
- In the “Select Site” dialog, click the Reconcile button.

Take notice of the new location of the Survey Point icon. You may need to Zoom. When we acquired the coordinates of the site project, the Survey point moved to the origin of that file.

6. Save the project.

- In the “Location Position Changed” dialog, choose the Save option (see Figure 6.42).

![Figure 6.42](image)

**FIGURE 6.42** Save the shared location in the Commercial Site file

7. Select the Project Base Point (the round icon).
8. Deselect the Project Base Point and select the Survey Point (the triangular icon).

Notice that the Survey Point is still located at (0,0,0). However, this origin is now reading the origin within the site file which we acquired. Furthermore, the Project Base Point’s coordinates are now relative to this origin point. Note also the angles of both points (see Figure 6.43).
Next to each icon is a paper clip icon. The Project Base Point icon is not clipped and the Survey point is clipped. If you move the Survey Point while it is clipped, the entire linked file will move with it. You are not really moving the Survey Point but rather the location of the host project relative to the linked file. This would be very similar to the move, rotate and/or align steps performed in the “Link the Site Project” topic above. If you unclip the Survey Point and then move it, you will be changing the position of the Survey Point only. You would do this if there were a more meaningful benchmark rather than the linked file’s origin point. This might be a location designated by your Civil Engineer such as some known site feature.

Similar behaviors are exhibited by the Project Base Point. If its paper clip icon is clipped, moving it will relocate the entire project relative to the Survey Point and shared coordinate system. Moving an unclipped Base Point simply changes the reference point itself. You might wish to do this to make the Project Base Point reference a more meaningful point, such as the corner of the building. Feel free to experiment with moving these points both clipped and unclipped. However, be sure to save the project before experimenting. In most cases you can undo, but in cases where you cannot, you can close without saving and then reopen the saved file.

Be sure the Project Base Point is unclipped (shows a red line slash through the paper clip icon).

9. Zoom in as necessary and drag the Project Base Point to the intersection of Grids 1 and A and then clip it again (see the right side of Figure 6.43).

10. Save the project.

Rotate a View to True North

Floor plan views can be oriented either to “Project North” or to “True North.” Every plan view has this parameter. True North is the geographic direction of North given to us by the Civil Engineer or Land Surveyor. Project North is typically parallel to the predominant geometry in the building and is oriented for convenience when composing sheets. By default, floor plan views are oriented to Project North. Changing a view to display True North is easy once shared coordinates are set up.

Continue in the Site view. Make sure that no objects are selected and that the drop-down on the Properties palette reads: Floor Plan: Site.

- On the Properties palette, beneath Graphics, next to Orientation, choose True North and then click Apply.

The view will rotate to make True North point straight up. If you click either the Survey or Project Base Points, you will see the new orientation reflected in these icons as well.

11. On the Project Browser, open any other floor plan view.

Notice that the orientation in the other plans is still Project North.
Section II • Create the Building Model

Location Weather and Site

We touched briefly on project location in the previous sequence. Using the “Location Weather and Site” dialog, we can configure two important pieces of information for our projects: the actual geographical location in the World and the site-specific information relative to the project and its links. In the previous sequence, we renamed the default “Internal” Site for the linked topography file. Let’s take a look at this dialog again from the vantage point of our current project.

1. On the Manage tab, on the Project Location panel, click the Location button.

On the Location tab, you can input the address of the project in the “Project Address” field and press enter. Revit will use an Internet mapping service to set your project’s location. If you require more precision, you can drag the icon in the map or type in an exact longitude and latitude for your project location. This is important to get proper lighting and shadows. Refer to Chapter 17 for more information.

- Click on the Site tab (see Figure 6.42).

This is the dialog that we saw above. Notice that even though we renamed the Site while saving Shared Coordinates, it is still listed as Internal here. Remember, there are two files: the Site we renamed is in the Commercial Site.rvt file. We are currently in the 06 Commercial.rvt [06 Commercial Metric.rvt] project file. As noted above, it can be easier to verify the shared coordinates if you rename the Site to something other than Internal. Also notice the angle from Project North to True North corresponds to the rotation that we have between the two files.

- Click on the Rename button and change the name to MRAC Commercial Arch and then click OK twice (see Figure 6.44).

![Image of Location Weather and Site dialog]

**FIGURE 6.44** Filter the selection to just framing elements

Linking by Shared Coordinates

For each pair of files, you only need to establish the shared coordinates once. In other words, if the owner of the Commercial Site project wishes to link the architectural file, they can do so without repeating the steps in the “Saving Shared Coordinates” topic above. If you wish to try this, you must first close the Commercial project. You cannot have both a host file and a link file open at the same time in the same session of Revit.

First save the current project and then close it. Open the Commercial Site project. Open the 3D view or Site plan. On the Insert tab, choose the Link Revit button. Browse to the 06 Commercial.rvt [06 Commercial Metric.rvt] project file. Before clicking Open, choose Auto – By Shared Coordinates from Positioning. Click
Open to complete the linking. The Commercial project will appear in exactly the correct spot on the site. If you edit the properties of the linked file, you will see that the Shared Site was assigned to the location named “MRAC Commercial Arch”. There are other important features of Shared Coordinates that are worth your time and exploration. For example, the same linked file can be copied multiple times in a host project and assigned to different named locations. This is useful in a campus situation with multiple identical buildings on the same site. To do this, you reopen the Location Weather & Site dialog, click the Site tab, and Duplicate one of the named locations rather than rename it. Each named location can have its own saved coordinates.

If you opened the site project, save and close it now. Then reopen the commercial project before continuing.

Create and Link a Structural Project
Now that we have completed setup of our site model, we will next isolate the structural elements and create a separate linked file from them. This will leave only architectural elements (Walls, Doors, Windows, Column enclosures (Architectural Columns), Floors, and Roofs) in the 06 Commercial.rvt [06 Commercial Metric.rvt] project file. You may recall that in the previous chapter, we created Columns, Beams, Beam Systems, and Braces in our commercial project. These elements and the core Walls are the ones that we will separate out to their own structural model. However, some of these elements like the core Walls actually need to appear in both files. We’ll look at a special way to achieve that as well.

Convert a Group to a Link
The task of separating the structural elements into their own file can be accomplished in a few ways. We could create a separate file, and then select the required elements and copy and paste them from our project to the new one. We can also use the techniques already covered in this chapter and isolate the required objects using Groups. The process is as follows: select the desired objects, make a Group from them and then convert that Group to a Link. (We could also save the Group without converting it to a Link as well.) Once we have the Group saved as a separate file, we could open it directly, or import into another project. If you prefer to use copy and paste in the next sequence, feel free to do so. The steps that follow will highlight the approach using Groups to reinforce the skills we learned at the start of the chapter.

2. In the 06 Commercial.rvt file, on the QAT, click the Default 3D View icon. The view named (3D) will re-open.
3. Using a Window selection, select all elements on screen.
   • Click the Filter button, deselect everything except Model Groups (similar to Figure 5.36 in Chapter 5).
   • If there are Structural elements shown, choose those as well, but do not include Structural Columns.

   At this point, we can go directly to the Group step; however, it is often good practice to use the Temporary Hide/Isolate icon (on the View Control Bar) to isolate the selected elements first to be sure you have the desired selection.

4. On the View Control Bar, click the Temporary Hide/Isolate icon and choose Isolate Element from the pop-up.
   You should only have Beams, Braces, and Joists selected on screen.
   • On the ribbon, click the Create Group button.
   • In the “Create Model Group” dialog, type: Structure for the Name and then click OK (see Figure 6.45).
Section II • Create the Building Model

At this point we have two options: we can simply save the Group to a file (as seen in the “Saving a Group to a File” topic above) or we can convert it to a Link (using the procedure covered in the “Convert a Group to a Linked file” topic above). Let’s use the Link option.

5. With the Structure Group still selected, click the Link button on the Group panel of the ribbon.
   - In the dialog that appears, choose the “Replace with a new project file option”.
   - In the “Save Group” dialog, browse to the Chapter06 folder and then click Save.

Using this method, we have quickly and efficiently gathered all of the structural framing and moved it to a separate linked Revit file. If you were to unload the Link now, none of the Structure would remain in the 06 Commercial.rvt [06 Commercial Metric.rvt] project file. At this point we could open the new Structure.rvt file and continue the exercise in there. However, one limitation of either the Save to Group or convert to Link method is that the resulting file is not based on the default Revit template. This means the resulting file has no levels, few annotations, and only the bare minimum of views. As a result, it will prove better in practice to create a new file using your preferred template first, and then insert the newly created file into it as a Group. In this way, we can ensure that the Structural file (or any file created this way) benefits from the office standards embedded in a template project. The process would be very similar to the steps covered above in the “Binding Linked Files (to Groups)” topic.

Working with Copy/Monitor

To save a few steps, a file has already been created from the standard template and included with the other Chapter 6 files. We’ll open this file, make a few preparations and then insert our Group into it. The preparations that we need involve copying the Levels and Grids from our main commercial project over to the structural file. While it is possible to simply copy these items to the structural file using Groups or copy and paste, a better approach is the Copy/Monitor tool which is specifically designed for this purpose. The Copy/Monitor tool allows you to copy certain elements (Levels, Grids, Walls, Floors and Columns) from a linked file and keep them associated back to the originals. In this way, you can monitor changes as they occur and update the copies to match. This provides a very practical way for project teams to collaborate on shared elements even when they are not physically located in the same office.
7. On the QAT, click the Open icon.

The keyboard shortcut for Open is CTRL + O. Open is also located on the Application menu.

- In the “Open” dialog box, browse to the Chapter06 folder.

8. Double-click 06 Commercial-Structure.rvt if you wish to work in Imperial units. Double-click 06 Commercial-Structure Metric.rvt if you wish to work in Metric units.

The project will open with the South elevation view visible on screen. We had to close the commercial project above because Revit will not allow you have both projects (the host and the Link) open at the same time.

9. On the Project Browser, right-click the Revit Links node and choose New Link.

This is simply an alternative to the method covered above. If you prefer, you can continue to use the Link Revit button on the Insert tab instead.

- In the Import/Link RVT dialog, choose 06 Commercial.rvt [06 Commercial Metric.rvt].
- For Positioning, choose Auto – Origin to Origin and then click Open. In the “Nested Links Invisible” dialog that appears, click Close.

The warning simply informs us that the file has Links of its own that will not carry through to the current host. If we wanted them to, we could edit the Link type in the commercial project to be Attachment rather than Overlay. This is done in the Manage Links dialog. Overlaid reference files are direct links. Attachments can nest several levels deep.

10. On the Collaborate tab, click the Copy/Monitor button and then choose the Select Link option from the pop-up.

- Select the Commercial project onscreen. The Copy/Monitor tab will appear on the ribbon.

11. On the Copy/Monitor tab of the ribbon, click the Copy button.

- On the Options Bar, click the Multiple checkbox.
- Select Levels 1 through 4 and “Roof” in the linked file. (Use the CTRL key or a crossing selection).
- On the Options Bar, click the Finish button (see Figure 6.46).

FIGURE 6.46 Use Copy/Monitor to copy the Levels
Be sure to click the Finish button on the Options Bar, not the one on the ribbon. This finishes selection. The one on the ribbon finishes the command.

A small monitor icon will appear next to each monitored item. If a Level is changed in the main Commercial project, the structural engineer can re-enter the Copy/Monitor mode and use the Coordination tool on the Ribbon to synchronize the changes.

12. Return to the Copy/Monitor tab of the ribbon and then click the Finish button. This finishes the Copy/Monitor mode.

Create Structural Plans

13. On the View tab, click the Plan Views button.
   - From the pop-up that appears, choose Floor Plan.
   - In the dialog that appears, select all of the Levels and then click OK.

14. On the Project Browser, expand Floor Plans, select Level 1, hold down the Shift key and then select Roof.
    This will select all the plan views, not including the Site view.
    - Right-click the selected plans and choose Apply View Template.
    - Select Structural Framing Plan and then click OK.

Having assigned this view template we now see only structural components. This will make selecting the remaining items for copy/monitor much easier.

Copy/Monitor Grids, Walls and Columns

Now that we have copied the Levels and set up framing plans we are ready to copy and monitor the remaining structural items.

15. On the Project Browser, double-click to open the Level 2 plan view.
    If necessary, zoom to fit (type ZF).
    - Use the Copy/Monitor steps above (with the multiple option) to copy all of the Grids, all of the structural (steel) columns and the four core Walls.

   TIP
   Make a crossing window selection, click the Filter icon on the Options Bar, deselect Columns and Floors and then click OK.

   - Click the Finish button on the Options Bar.
   - On the Copy/Monitor tab of the ribbon click the Finish button.

Insert a Group

To complete our structural model, we’ll import the Group we created from the framing members.

16. On the Project Browser, double-click to open the South elevation view.
    - Use Temporary Hide/Isolate to hide the linked model.

17. On the Insert tab, click the Load as Group button.
    - In the "Load File as Group" dialog, browse to the Chapter06 folder.
    - Select the Structure.rvt file and then click Open. (If a message regarding duplicate Types appears, click OK.)

After a short pause, you will note that the Structure Group is now available on the Project Browser beneath the Model Groups branch.
18. On the Project Browser, beneath the Model Groups branch, right-click Structure and choose **Create Instance**.
   - To insert it in the correct location, simply type 0 (zero) and then press **ENTER**.
   - On the Edit Pasted panel of the ribbon, click the **Finish** button.

19. On the Project Browser, double-click to open the **Longitudinal** section view.
   - Select the Group instance on screen, and then on the ribbon, click the **Ungroup** button. We will leave the nested **Typical Framing** Groups alone. This way, we can still benefit from their being grouped should we need to edit the framing later.

20. Save and close the Structural model.

**Using Reload From to Swap a Link with another File**

Now that we have completed the setup of our structural model, we are ready to load it into our main Commercial project. Since we already have a link to the Structural Group created above, the process will involve simply swapping the file referenced by this Link. This is done in the Manage Links dialog.

21. Re-open the **06 Commercial.rvt** [**06 Commercial Metric.rvt**] file.
22. On the Insert tab, click the **Manage Links** button.
   - In the “Manage Links” dialog, be sure that the Revit tab is active.
   - Click on the **Structure** entry at the left.
   - Click the “Reload From” button at the bottom (see Figure 6.47).

![Figure 6.47](image)

**FIGURE 6.47** The Manage Links dialog—Reload a Link from an alternate file and/or location

23. Select **06 Commercial-Structure.rvt** [**06 Commercial Metric-Structure.rvt**] and then click **Open**.
   - Click OK to close the Manage Links dialog.

In this example, we used “Reload From” because we wanted to point the linked file to a different project file than the one originally used. In normal circumstances, you will want to use the Reload button that simply loads the latest saved changes from the same RVT file. If you no longer want the Linked file, you can use the Remove button.
**SUMMARY**

- Groups offer a powerful means to create and manage typical design conditions and keep all instances of them coordinated throughout the project.
- Any selection of objects can be grouped. Model element and Annotation elements however cannot occupy the same Group.
- When creating a Group from a selection of Model elements and attached Annotation elements (such as Tags) the Annotation becomes a separate Attached Detail Group.

If you try to open a project that is actively linked by the currently open project, Revit will display a warning indicating that the Linked file must first be unloaded before it can be opened. In other words, you cannot have both projects open at the same time in the same Revit session. This limitation does not prevent two different users from working simultaneously in each of the projects since each team member will be working on a different system. However, if both users are actively changing their respective models, you should save frequently and use the “Manage Links” dialog periodically to reload the linked project(s).

The best place to see the results of the work we have done here is in one of the section views. Open a section view and select the linked structural file. (Use the TAB key if necessary.) You will see it highlight on screen and be able to see clearly the elements that have been moved and copied to this linked file in comparison to those that remain in the host commercial project.

If you should ever wish to “turn off” a linked file, you can unload it. Do this with the Manage Links tool. When a linked RVT file is unloaded it will not be visible in any view. At a later point in time it can be reloaded and therefore visible. Unloading it also has the benefit of removing the data from the computer’s memory, which reduces the burden on the computer’s resources. If you wish to try it out, follow these steps:

24. On the ribbon, click the Manage tab.
   - On the Manage Projects panel click the Manage Links button.

   **TIP**

   The Manage Links button can also be found on the Insert tab.

   - Click the Revit tab, select the 06 Commercial-Structure [06 Commercial Metric-Structure] file, and then click the Unload button.

   **NOTE**

   Revit will warn you that this cannot be undone. While this is true, all it really means is that the undo command will not work with this action; you can always return to the Manage Links dialog and reload it.

   - When asked to confirm, click Yes and then click OK.

In the next chapter, we will continue to refine the Commercial project and its linked files. For now however, our work with Groups and Links in this chapter is complete.

25. Save and close all project files.
• Attached Detail Groups contain annotation that is linked to the model elements in the corresponding Model Group.
• The insertion point of a Group can be adjusted by dragging the control on screen. Subsequent instances of the Group will insert relative to this location.
• When you edit any instance of a Group, the changes are applied to all instances.
• Elements can be excluded from individual instances of Groups making a unique condition. Changes to the Groups still apply to the other elements in the Group.
• Groups can contain other Groups creating so-called “nested” Groups.
• Groups can be saved to files thereby becoming independent Revit projects.
• Groups can be converted to linked Revit projects.
• A separate Revit project can be linked to your current project. If the external project changes, the link will update to reflect the changes.
• Linked projects can be converted to Groups.
• You can link AutoCAD or Microstation files to Revit projects.
• Contour lines in linked DWG files can be used to create points in a Revit Toposurface element.
• Maintain proper positioning of linked projects using Shared Coordinates.
• Project Base Points and Survey Points give on-screen icons for easy understanding and manipulating of project coordinates.
• Use Copy/Monitor to copy certain kinds of elements from a linked file and keep the copies synchronized with the original linked file.
• You can swap instances of Groups and Links with other Groups or Links respectively.
CHAPTER 11
Detailing and Annotation

INTRODUCTION

In this chapter, we will explore the detailing process and tools available in Revit. As the design development phase gives way to construction documentation, details are created to clarify basic plan, section and elevation views of a project and assist in conveying overall design and construction intent. Before Revit, such details had been drafted independently of the overall drawings with perhaps some tracing to help minimize redundant effort. In Revit, much of the detailing can begin within a fully coordinated model view. You will then add detail information directly to this live Revit view.

The process is simple—first create a callout or section view of the model at a large scale and then add additional drafted components, text, dimensions and other embellishments necessary to craft the detail and convey design intent. In most cases, such embellishments are at minimum drawn relative to an underlying building model view and in many cases remain automatically constrained or linked to model geometry in the view. It is important to understand, however, that unlike the other Revit views, all drafting components appear only in the view to which they are added.

OBJECTIVES

In this chapter, we will create detail drawings using several techniques. Working first from the Revit model, we add additional information to create a wall-floor-foundation section detail. A variety of tools will be explored to assist in this process. We will also create a detail in our project using a detail originally created in AutoCAD. This process allows you to utilize detail libraries that you may already have directly within Revit. Our exploration will include coverage of Detail Lines, Detail Components, Repeating Details, Filled and Masking Regions, and various annotations. After completing this chapter you will know how to:

- Modify Crop Regions and add View Breaks
- Add and modify Detail Lines
- Add and modify Detail Components and Repeating Details
- Add and modify Text and Leaders
Section III • Construction Documents

- Add and modify Filled Regions, Masking Regions, and Break Lines
- Work with Drafting views
- Import legacy details into a Revit Architecture Drafting view

MODIFY WALL TYPES
To prepare us for the detailing tutorial that follows, we will modify the Wall Types currently in use in the residential project for the exterior walls. We will unlock the outer two components (called Layers) of the brick Wall and add a brick ledge to the foundation Wall. Doing so will allow us to create a brick shelf on the concrete Wall and extend the brick down to sit on it. These steps will make the model more accurately represent the construction, as well as making the detailing process a bit easier.

Install the Dataset Files and Open a Project
The lessons that follow require the dataset included on the Aubin Academy Master Series student companion. If you have already installed all of the files from this site, skip to step 3 to begin. If you need to install the files, start at step 1.

1. If you have not already done so, download the dataset files located on the CengageBrain website.
   Refer to “Accessing the Student Companion site from CengageBrain” in the Preface for information on installing the dataset files included in the Student Companion.
2. Launch Autodesk Revit Architecture from the icon on your desktop or from the Autodesk Revit Architecture 2012 group in All Programs on the Windows Start menu.
   You can click the Start button, and then begin typing Revit in the Search field. After a couple letters, Revit Architecture should appear near the top of the list. Click it to launch the program.
3. On the QAT, click the Open icon.

   The keyboard shortcut for Open is CTRL + O. Open is also located on the Application menu.
4. In the “Open” dialog box, browse to the location where you installed the MasterRAC 2012 folder, and then the Chapter11 folder.
5. Double-click 11 Residential.rvt if you wish to work in Imperial units. Double-click 11 Residential Metric.rvt if you wish to work in Metric units.
   You can also select it and then click the Open button.

Add a Brick Shelf
Let’s start with the foundation Wall. By modifying the Wall Type, we can create a brick shelf to receive the bricks from the exterior Wall above. This will be achieved by adding a Revea directly to the Wall Type.

5. On the Project Browser, double-click to open the Basement floor plan view.
There are four foundation Walls (in the new addition), three bounding the outside perimeter and another framing the right side of the passageway to the existing basement. We do not want to apply a brick shelf to the Wall in the passageway. Since we are going to edit the Wall type, the easiest way to prevent this is to create a new type for the Walls needing the brick shelf.
6. Using the CTRL key, select the three exterior foundation Walls (two vertical and one horizontal) (see Figure 11.1).

**FIGURE 11.1 Select the three exterior foundation Walls**

- On the Properties palette, click the Edit Type button. The “Type Properties” dialog will appear.
- Next to the Type list, click the Duplicate button.

A shortcut to this is to press ALT + D.

A new Name dialog will appear. By default “2” has been appended to the existing name.
- Change the name to: **MRAC - Foundation - 12" Concrete (w Brick Shelf) [MRAC - Foundation - 300mm Concrete (w Brick Shelf)]** and then click OK.
- At the bottom of the dialog, click the << Preview button.

A viewer window will appear to the left attached to the “Type Properties” dialog.
- From the “View” list (bottom left), choose **Section: Modify type attributes**.
- In the viewer, Zoom in to the top of the wall. (You can use the mouse wheel, right-click or the steering wheel icon in the lower-left corner.)
- On the right side of the dialog, at the top, click the Edit button next to Structure (see Figure 11.2).

This will open the “Edit Assembly” dialog and show the Wall Layers included in this Type. We can edit these Layers here as well as add other parameters such as Sweeps and Reveals (below we will use the same process to “unlock” some of the Wall Layers of another Type).
7. In the bottom right corner of the dialog, within the "Modify Vertical Structure" area, click the Reveals button.

**NOTE**
The "Reveals" and other buttons in the "Modify Vertical Structure" area will not be available if you have not enabled the Section Preview as noted in the previous steps.

A Reveal is a profile-based extrusion that cuts away from the mass of the Wall. Profile Families were discussed in a few locations in the previous chapter, including the “Build or load a Mullion Profile Family” topic. You can create and load Reveal Profile Families in the same manner as discussed in those topics. In this case, we will use a Profile that has been provided with the dataset files from the Aubin Academy Master Series: Revit Architecture 2012 student companion.

8. In the “Reveals” dialog, click the Add button to add a Reveal.

Item “1” will appear using the default profile. None of the Profile Families currently loaded in this project meet our needs for the brick shelf. Fortunately, we can load one from an external file directly from this dialog. One has been provided in the Chapter11 folder for this purpose.

- From the Reveals Dialog click the “Load Profile” button.
- Browse to the Chapter11 folder where you installed the datset files from the student companion.
- Select the file named: MRAC Brick Shelf Reveal.rfa [MRAC Brick Shelf Reveal-Metric.rfa] and then click the Open button.
This is a simple Reveal Family built using the Profile-Reveal.rft (Metric Profile-Reveal.rft) template. Feel free to open the file directly and study it or try your hand at building it yourself.

The Load Profile button is just a shortcut to loading the profile. You still need to assign it to the Reveal.

- Click in the Profile field and then click again on the down arrow to display the Profile list.
- Choose MRAC Brick Shelf Reveal: 12" d x 6” w [MRAC Brick Shelf Reveal-Metric : 300 d x 140 w].
- For the “From” setting, choose Top and then click the Apply button (see Figure 11.3).

In the “Edit Assembly” dialog in the background, you should see the Reveal Profile appear at the top left edge of the Wall in the viewer. Move the Reveals dialog out of the way if necessary.

- Click OK to return to the “Edit Assembly” dialog.
- Click OK two more times to return to the model view window.

9. On the Project Browser, double-click to open the Longitudinal section view.
- Zoom in on the left side to study the results (see Figure 11.4).
Unlock Wall Layers

Now that we have a brick shelf in the foundation Wall Type, we should put some brick there. To do this, let’s edit the brick Wall Type to unlock the outer material Layers (to allow their top and/or bottom offsets to move freely from the Wall’s top and base offsets) and then project them down to sit on the foundation brick shelf.

10. In the section view, select the Left exterior brick Wall.
   • On the Properties palette, click the Edit Type button.
     The Preview window should already be open. If it is not, open it again.
   • Click the Edit button next to Structure.

The preview window should be showing the section view. If it is not, choose Section: Modify type attributes from the “View” list. You can use standard navigation techniques such as the wheel of your mouse or the right-click menu to zoom and scroll the model in the viewer.

11. Right-click in the viewer window and choose Zoom In Region. Zoom in on the lower portion of the Wall.
   • In the “Modify Vertical Structure” area, click the Modify button (see Figure 11.5).

12. Click the bottom edge of the Brick Layer.
The edge will highlight light blue to indicate that it is selected. A small padlock icon will appear on the edge. We can use this padlock icon to unlock the bottom edge of the Layer, which will allow it to be moved independently from the Wall itself in the model.

- Click the padlock (to open it) and unlock the bottom edge of the Layer.
- Repeat the process to unlock the bottom edge of the Thermal/Air Layer (next to brick) (see Figure 11.6).

Upon returning to the model view window, you will note that the Wall now has two Shape Handles at the bottom edge (see Figure 11.7). If you don't see the shape handles, de-select the Wall, then select it again. You can use the second handle to modify the bottom edge of just the unlocked Layers. The other handle will continue to modify the Base Constraint of the entire Wall.

While the Shape Handle provides an easy way to edit the brick and air Layers, the Align tool provides a nice alternative too.

13. On the Modify | Walls tab, on the Modify panel, click the Align tool.
   - For the Reference line, click the bottom edge of the brick shelf on the foundation Wall (use the TAB key as necessary to make the proper selection).
   - For the Entity to Align, click the bottom edge of the brick Layer in the Wall above (see Figure 11.8).
Section III • Construction Documents

- Click the small padlock icon that appears to lock the constraint and keep these elements aligned.
- On the ribbon, click the Modify tool or press the ESC key twice.

So now the brick and concrete have the proper relationship, but there is a bold line between them. This is because there are still two separate Walls here. If you want the graphics to merge together showing a thin line between all internal layers, use the Join Geometry tool.

14. On the Modify tab, on the Edit Geometry panel, click the Join tool.
   - Select the Brick exterior Wall first and then the foundation Wall.
   - On the ribbon, click the Modify tool or press the ESC key twice (see Figure 11.9).

Be sure to click the Brick Wall first, and then join it to the Foundation Wall. Clicking in the opposite order will remove the customized bottom alignment.

You can repeat the procedure on the other two exterior Walls if you like. However, it is not necessary at this time.

- Save the project.
DETAILING IN REVIT ARCHITECTURE

Detailing in Revit Architecture is in many ways similar to detailing in traditional drafting. This is true regardless of whether you compare it to drafting created by hand on a drafting board or created in Computer Aided Design (CAD) software on a computer. The major difference is that in Revit Architecture you rarely start from scratch because you can base your detail on views that are automatically generated from your Revit model.

The typical Revit model includes enough data to generate a majority of the drawings that will be required in an architectural document set at an appropriate level of detail and accuracy. This is true for most plans, sections, and elevations. In the case of details, however, while it is theoretically possible to model all of the bricks, fasteners, joints, hooks, and other items that will actually occur in the building, the amount of effort (in man-hours) and the sheer size of the resultant model (in computer memory and hard drive requirements) would typically not yield a sufficient return on investment.

To keep the size of our models reasonable and to avoid spending additional and often unnecessary time modeling every bolt, screw, and piece of flashing, the strategy to detailing in Revit Architecture is instead a “hybrid” approach. In nearly all details you may create in Revit, you will be able to start the process with a cut (call-out) from the model. This live view of the model portrayed at the scale of the detail will give you a starting point upon which to add detail components and other view-specific two-dimensional elements and annotations. By separating a detail into both live model elements and view-specific embellishments, we achieve the best of both worlds: we have an underlay that remains live and changes automatically with the overall building model and we have all of the additional data required to convey design intent occurring only on the specific detail view, thus saving on overhead and unnecessary modeling effort.

It is this process that will be discussed in detail in the following tutorial. In this exercise we will discuss the available tools and techniques using the wall and floor intersection from our residential project that we edited above.

Adding a Callout View

Continue from the previous exercise in the Longitudinal section view. If you closed the project or this view, reopen them now. Details are typically presented at larger scales than the drawings from which they are referenced. The Callout tools in Revit Architecture will allow us to create a detailed view at a larger scale of any portion of the building model.

In the Longitudinal section view, be sure you can see the left exterior Wall from the first floor down to the footing. Zoom and Scroll as necessary.

1. On the View tab, on the Create panel, click the Callout tool.
   • From the Type Selector on the Properties palette, choose Section: Wall Section.
   • Click a point outside the exterior Wall on the left above the first floor and then drag a callout around the Wall to beneath the foundation (see Figure 11.10).
Revit Architecture will create a new branch on the Project Browser called Sections (Wall Section) and a new view called Callout of Longitudinal.

Like section and elevation markers, a callout marker will appear. When you deselect all elements, this callout will remain blue. As with the others, this indicates that you can double-click it to jump to the referenced view. You can also open the view from the Project Browser.

2. On the Project Browser, beneath Sections (Wall Section) right-click on Callout of Longitudinal and choose Rename.
   - Type: Typical Wall Section and then click OK.

3. Open up the callout view (you can double-click its name on Project Browser or its Callout symbol) (see Figure 11.11).
Chapter 11 • Detailing and Annotation

Notice that the boundaries of the crop region in the Typical Wall Section view match the extents of the callout boundary that we sketched in the Longitudinal section view. If this boundary is adjusted in either view, the boundaries in the other view automatically adjust. If you wish to see this, try tiling the Longitudinal section view and the Typical Wall Section view side by side and test it out. Remember to close hidden views or minimize other views first, so that when you tile, only the two sections will appear (see Figure 11.12).

![Figure 11.12 Drag the Control Handles in either view to edit the extent of the Crop Region](image)

4. When you are finished experimenting, return the shape of the crop region to match approximately as shown in Figure 11.11.
   - Maximize the Typical Wall Section view and zoom to a comfortable size.

Adjust Scale and Annotation Visibility

Annotation is separate from the model geometry shown in a view. While the level of detail and graphical display characteristics of the model may vary from view to view, the model will display in all views unless you specifically override the display settings to hide it. Annotation, on the other hand, is applied on top of the model and occurs only in the specific view in which it is created. Model and annotation elements also differ from one another with regard to scale. Annotation appears at a consistent height relative to its desired plot size, while the model geometry adjusts its size relative to the assigned scale. All of this behavior occurs automatically.

5. On the View Control Bar (bottom of the window) change the scale to \( \frac{\frac{1}{4}''}{1'} = 0'' [1:20] \) (see Figure 11.13).
6. Select the Site Level Line.
   - On the Modify | Levels tab, on the View panel, click the Hide in View icon and choose Hide Elements. (Or you can right-click and choose Hide in View > Elements from the menu that appears.)

   This operation does not have any effect on any other view. We have hidden this Level line in only the current view. The Site Level is not really relevant in the current Callout view, so by hiding the Level line, we eliminate potential clutter and confusion. In a similar fashion, we can adjust the location of the Level Heads and the length of the Level lines and again, the edits will be confined to only this view.

7. Click on any Level line.
   - Using the Control Handle at the end, adjust the end points so the Level text is completely outside the Crop Region (see Figure 11.14).
   - Click the Top of Footing Level line and then click the blue “squiggle” symbol near the Level Head.
   - Edit the blue grips to modify the Level line with an offset (see Figure 11.14).
Notice that all Level lines move together when you drag one.

8. Save the project.

**Detail Lines**

Now that we have cut our detail callout and configured the Level lines and scale to our liking, we are ready to begin adding embellishments. We can draw a variety of view-specific elements directly on top of the section view of our model. We will start with Detail Lines. These are simple drafted elements much like the sketch lines with which you are already familiar. When you add a Detail Line, it appears only in the view to which you add it. If you wish to draft a line that appears in multiple views, use a Model Line instead. We will use Detail Lines to sketch in some flashing at the bottom of the wall cavity.

9. On the Annotate tab, on the Detail panel, click the **Detail Line** tool.

Notice the choices on the Modify | Place Detail Lines tab that appears are very familiar and match those that we have seen in many sketch-based objects so far.

- From the Line Style list on the ribbon, choose **Wide Lines**.
- On the Options Bar, verify that there is a checkmark in the “Chain” checkbox.

10. Zoom into the bottom of the wall cavity (at the brick shelf).

11. Sketch the line segments shown in Figure 11.15.

![Figure 11.15](image)

**FIGURE 11.15** Sketch Detail Lines to represent the flashing in the wall cavity

To make it appear like flashing, it is best to avoid snapping these lines to the Wall. Unlike the sketch lines that we drew in previous chapters, these lines are complete “as is.” They do not describe the shape of a more complex element like a Floor or a Stair. These are simply drafted lines placed on top of a model view, much like drafting directly on top of a Mylar background in traditional hand drafting.
12. On the Project Browser, double-click to open the Longitudinal section view.
   - Zoom in to the same portion of the Wall and notice that this linework does not appear in this (or any other) view.

13. On the Project Browser, double-click to return to the Typical Wall Section view.

| TIP | You can hold down the CTRL key and then press TAB to cycle through the open views. |

All of the parts of the detail that we are going to create next could be created with Detail Lines following the same process. However, several other detailing tools are available to us. Let’s look at them now.

**Detail Components**

Detail Components are simply two-dimensional view-specific elements that (like Detail Lines) appear only within the view in which they are placed. They are more useful and more powerful than simple Detail Lines in that they are Families and can be parametric. Like other Families, a Detail Component Family can have many Types built into it. The parameters can be as simple as Length and/or Depth, or include dozens of parametric dimensions. For Example, a “Wide Flange” Family file included in the out-of-the-box Detail Component folder contains hundreds of Types representing all of the commonly-available steel shape sizes. Another example that is a bit more pertinent to the detail that we are creating here is dimension lumber. Rather than attempt to edit the Wall type and begin adding three-dimensional framing elements, which would add a level of complexity to the model that is typically only needed in details, we can add predefined detail components to our detail view to represent this information more efficiently only in the views that require it.

14. On the Annotate tab, on the Detail panel, click the **Component** drop-down button.
   - Choose **Detail Component** from the list.

Currently, there are no “Dimension Lumber” Families loaded in our project. Like other components in Revit, we can simply load them from the library.

   - On the Modify | Place Detail Component tab, click the **Load Family** button.
   - In the “Load Family” dialog, from default library folder (either the **Imperial Library** or the **Metric Library**), browse to:
     - Imperial: Detail Components\Div 06-Wood and Plastic\061100-Wood Framing.
     - Metric: Detail Components\Div 06-Wood and Plastic\06100-Rough Carpentry\06110-Wood Framing.

| NOTE | If you do not have access to either of these libraries, the Family files mentioned in this tutorial have also been provided in the Library folder with the dataset files installed from the student companion. |

   - Double-click the file named **Nominal Cut Lumber-Section.rfa** [**M_Nominal Cut Lumber-Section.rfa**].
     - The “Specify Types” dialog will appear.

Unlike other Families we have seen so far, this Family uses a “Type Catalog.” A Type Catalog is used when Families have dozens or even hundreds of types. It is an external text file saved in the same folder as the Family that lists the parameter values of all of the possible types. This method allows you to load only the selected types from this Family file into your project, and not the potentially hundreds of types associated with this Family file.
• From the matrix of types listed at the right, hold down the Ctrl key; click 2×6 [50×150mm] and then 2×10 [50×250mm] to highlight them.
• Click OK to load just these types into the project (see Figure 11.16).

FIGURE 11.16 Choose the Detail Component Family and specific types that you wish to load

15. From the Type Selector, choose Nominal Cut Lumber-Section: 2×6 [M_Nominal Cut Lumber-Section: 50×150mm].
   • Press the Spacebar three times.
   This will rotate it so the placement point is at the top left corner of the 2×6 [50×150mm].
16. Place two plates in the space between the floor joist and the foundation Wall (see Figure 11.17).

   Use the Move or Align tools to assist in accurate placement.

   TIP

FIGURE 11.17 Place a double top plate on the foundation Wall

17. Repeat the process (or copy) to add a sill plate above the joist at the first floor.
18. On the Annotate tab, choose the Detail Component tool from the Component dropdown button again.
ADJUSTING THE LINE WEIGHT OF DETAIL COMPONENTS

Perhaps you have noticed how heavy the outline is around this particular component. The line weight in this case is a result of the subcategory assigned to the outline geometry in the Detail Component Family. In this particular Family the subcomponent is “Heavy Lines,” which is set to a line weight of 5. If you wish to make this line weight less bold in your detail, you have three options: you can edit Object Styles in the current project and reduce the line weight assignment of the Heavy Lines subcomponent, use VG to edit the subcategory in this view only, or edit the Family and modify the outline to use a different subcomponent. Editing the Object Styles in the current project is quicker and easier, but not considered “best practice.” While the desired line weight will be achieved, the effect will apply to all Families that use the Heavy Lines subcategory and its name “Heavy Lines” will no longer be applicable.

The best practice approach is to edit the Family and reassign the outline to a lighter subcomponent. To do this, select one of the Nominal Cut Lumber-Section: 2 × 6 [M_Nominal Cut Lumber-Section: 503150] elements on screen. On the Modify Detail Items tab, click the Edit Family button (you can also right-click to find this command). This will open the Family in the Family Editor. (The Family Editor was covered in detail in the previous chapter). Select the outline. The outline element is a Masking Region, which is a polygon object with an outline and solid opaque fill. On the Modify Detail Items tab, click the Edit Boundary button to edit the sketch of the Masking Polygon. If you are working in Imperial units, you will need to create the Medium Lines subcategory. To do this, click the Manage tab and then click Object Styles. Click the New button in the lower-right corner to add a new subcategory. Name the new subcategory Medium Lines and set its line weight to 3. Click OK to finish. On the Modify Detail Items > Edit Boundary tab, chain select the entire outline (four lines) on screen and then choose Medium Lines from the Type Selector. On the ribbon, click Finish Region and then save the Family. Finally, click the Load into Project button on the ribbon. Overwrite the existing Family when prompted.

A modified version of the Family named MRAC Nominal Cut Lumber-Section.rfa [MRAC M_Nominal Cut Lumber-Section.rfa] has been provided in the Chapter11 folder. You can make the edits listed here or load the provided Family using the Load Family tool on the Insert tab.

• Change the Type to Nominal Cut Lumber-Section: 2 × 10 [M_Nominal Cut Lumber-Section: 50×250mm].
• Use the spacebar to rotate if necessary and place a rim joist as shown in Figure 11.18.

FIGURE 11.18 Place a rim joist using a 2 × 10 [50 × 250mm]
A frequent concern when creating these “hybrid” details is change management. What happens if, after placing Detail Components in several detail views, components in the model have to move, even if only slightly? To help alleviate the problem of having to revisit all of those details to make sure that all of the affected Detail Components get updated, you can lock the Detail Components to the model geometry that they are aligned with. After using the Align tool to position a component, click the lock symbol that appears. This will cause the Detail Component to move with the associated model component. Conversely, you cannot accidentally move a Detail Component once it has been locked to model geometry, so you don’t have to worry about accidentally modifying the model by inadvertently editing a Detail Component. Keep in mind that you can “over constrain” your models as well. Even though there is a potential benefit to locking the detail components to the underlying geometry, in some cases you may experience errors later in the design process when moving model components if such a move causing the locked relationship to become invalid. In such a case, the user performing the edit may not understand the error, nor know the impact of clicking the Remove Constraints button. As always in BIM, you must strike a balance between potential benefits of a practice with the potential disadvantages.

You use the same process to load and place any Detail Component. Revit ships with a very large collection of pre-made Detail Component Families. As we discussed in the previous chapter, set aside some time to get acquainted with what is provided. You can use the components in the library, modify them, or build your own. It is usually best to start with those provided before endeavoring to create your own. Let’s continue to add to our detail by repeating the load and add process to add an anchor bolt.

19. On the Annotate tab, on the Detail panel, click the **Component** drop-down button and choose the **Detail Component** tool from the list.
   - Click the **Load Family** button and browse to:
     - **Imperial**: `Detail Components\Div 05-Metals\050500-Common Work Results for Metals\050523-Metal Fastenings`
     - **Metric**: `Detail Components\Div 05-Metals\05090-Metal Fastenings`
   - Open the `Anchor Bolts Hook-Side.rfa` file.
   - From the Type Selector, choose the `1/2" [M16]` type.
   - Place the anchor at the midpoint of the lower plate.
   - On the ribbon, click the **Modify** tool or press the `ESC` key twice.

20. Select the bolt that you just placed.
   - On the Properties palette, change the “Length” parameter to `1'-9" [525]`.
   - Change the “Hook Length” to `3" [76]` and then click OK.
   - With the bolt still selected, on the Modify|Detail Items tab, click the **Mirror – Pick Axis** tool, clear the Copy checkbox, and mirror the bolt about its center.
   - On the Modify | Detail Items tab, click the **Align** tool; use the top of the plate as reference and align the bottom of the bolt to it (see Figure 11.19).

Fine-tune your placement as necessary to match the figure.
Repeating Detail Elements

Repeating Detail elements are Detail Components that automatically repeat about an invisible sketch line. This allows more rapid placement of Detail Components like studs, CMU, Brick, etc. In the detail that we are constructing, we can see the brick Layer of our Wall with the heavy cut line on the exterior and the diagonal fill pattern. This rendition is fine for general scales and overall plans and sections. However, at the scale of this construction detail, adding mortar joints will better delineate the brick veneer and suggest the individual bricks. While we could place one mortar joint and then array or copy it, a Repeating Detail Component is more expedient and the spacing can be edited later if necessary.

21. On the Insert tab, on the Load from Library panel, click the Load Family button.
   - Browse to the location where you installed the dataset files and open the Chapter11 folder.
   - Select the MRAC Mortar Joint with concave joint.rfa [MRAC Mortar Joint with concave joint-Metric.rfa] file and then click Open.

Now that we have loaded a mortar joint Family, we will create a new Repeating Detail Type using this Detail Component. If you wish, feel free to open this Family in the Family Editor and study its composition.

22. On the Annotate tab, on the Detail panel, click the Component drop-down button and choose the Repeating Detail Component tool from the list.
   Only one Type is available on the Type Selector—Repeating Detail: Brick. We are going to use this as the basis for a new Type.
   - On the Properties palette, click the Edit Type button.
   - In the “Type Properties” dialog, click the Duplicate button to create a new type.
   - Name the new Type MRAC Mortar and then click OK.
   - In the “Type Parameters” area, choose MRAC Mortar Joint with concave joint: Brick Joint from the “Detail” list.
   - Leave all of the other settings unchanged and then click OK to return to the view window.

23. Click at the bottom-left corner of the brick veneer and drag up past the top of the Crop Boundary and click again (see Figure 11.20).
FIGURE 11.20  Place a Repeating Detail for the Mortar Joints

- On the ribbon, click the Modify tool or press the ESC key twice.
- Save the project.

Filled Regions
Filled Regions are two-dimensional shapes comprised of boundary lines and fill patterns. You can draw them any shape you like and use them to create, hatch, or cover up parts of the detail or other drawing. We will use a Filled Region here to illustrate the filled trench on the exterior side of the foundation wall.

24. On the Annotate tab, on the Detail panel, click the top part of the Region tool.

The Modify | Create Filled Region Boundary tab will appear with familiar sketch tools.

- From the Line Style panel on the ribbon, choose Wide Lines.
- On the Draw panel, be sure that the Line icon is selected, and on the Options Bar that the “Chain” checkbox is selected.

25. Zoom into the bottom of the foundation Wall near the footing.
26. Sketch the shape shown in Figure 11.21. The exact dimensions are not critical.

FIGURE 11.21  Sketch a Filled Region boundary
27. On the Draw panel, change the shape to Circle.
   • Add a sketched circle with a 2’ [50] radius as shown in Figure 11.22.

![Figure 11.22](image)

**FIGURE 11.22** Sketch a circle in the Filled Region shape

28. On the Properties palette, click the Edit Type button.
   • From the Type list, choose **MRAC River Rock** and then click OK.
   • On the Mode panel, click the **Finish Edit Mode** button (see Figure 11.23).

![Figure 11.23](image)

**FIGURE 11.23** Change the Filled Region to River Rock and then Finish the Sketch

**NOTE**

If necessary, you can widen the crop region to allow more room to draw the Filled Region.

29. Repeat the same process for adding the finished grade with the **MRAC Earth Disturbed** Filled Region (see Figure 11.24).
Both of the Filled Region Types have been provided in the dataset for your use. They make use of custom Fill Patterns. You can edit and create Fill Patterns on the Manage tab on the Additional Settings drop-down. Simple fills can be created directly in the “Fill Patterns” dialog by designating the spacing of parallel lines. For more complex patterns, PAT files can be imported.

**Adding Break Lines**

Next let's drop in some Break Line components to hide part of the model. Break Lines have Instance parameters so we can individually adjust their size to fit the Detail.

30. On the Annotate tab, on the Detail panel, click the **Component** drop-down button and choose the **Detail Component** tool from the list.

   - Click the **Load Family** button and browse to:
     - Both Imperial and Metric: Detail Components\Div 01-General.
   - Open the **Break Line.rfa** file.
   - Place a Break Line at the top of the detail to cover the top edge.
   - Press the **SPACEBAR** three times, and then place another Break Line covering part of the floor joist to the right (see Figure 11.25).

Break line components contain invisible Masking Regions that mask (cover up) the model objects beneath them. The concept of a mask is common in graphic design software and can be helpful in creating details.

   - Use the Shape Handles to make adjustments as necessary.
Batt Insulation
Next we’ll place some batt insulation in the wall and floor.

31. On the Annotate tab, on the Detail panel, click the **Insulation** tool.
   - On the Options Bar, set the **Width** to 5" [130].
   - Click the first point at the bottom midpoint of the stud space, move up vertically and then pick the second point above the Crop Region (see Figure 11.26).

   ![Figure 11.26 Draw Insulation in the Stud cavity](image)

32. Press the **ESC** key one time (this deselects the previously drawn insulation, but remains in the command).
   - On the Options Bar, choose “to far side” from the drop-down list.
   - Click a point on the inside of the rim joist and drag to the right past the Crop Region (see Figure 11.27).

   ![Figure 11.27 Draw Insulation in the Floor cavity](image)
• On the ribbon, click the **Modify** tool or press the **ESC** key twice.

Notice that the insulation is not masked by the Breaklines. This is because there is an explicit display order for the view-specific Detail Components. The insulation is currently on top because it was added to the view after the break lines. We can shuffle the display order now.

33. Select the Break Line component on the right.
   • On the **Modify | Detail Items** tab, click the **Bring to Front** button (see Figure 11.28).

![FIGURE 11.28](image)  
**FIGURE 11.28** Use the Display Order icons to shuffle the order of Components in the view

• Repeat this process on the other Break Line elements.
• Use the **Send to Back** button on the Mortar Joints repeating detail item to bring it behind the flashing Detail Lines.

**Edit Cut Profile**

Sometimes you encounter a situation where the automatically created graphics do not suit your specific needs in a particular view. One such example is the keyway locking the foundation Wall to the Footing. It is possible to modify the model geometry to rectify this situation, but as an alternative, Revit Architecture provides us with the **Edit Cut Profile** tool. This tool gives us the ability to edit the path of the cut lines that Revit automatically generates. This type of edit is view-specific and two-dimensional. While it does not change the 3D shape of the model, it gives us a quick way to make the detail look the way we need without forcing us to model something that would have little or no benefit in other views. Since a key between the bottom of a foundation wall and the top of a footing would never be seen in any view other than a section or detail view, it would be difficult to justify the additional time or effort required to model it in 3D. Using the **Edit Cut Profile** tool we can make the section or detail appear as required more quickly and without the extra modeling overhead.

34. On the View tab, on the Graphics panel, click the **Cut Profile** tool.
   • On the Options Bar, select the “Boundary between Faces” option.

This option allows us to edit two boundaries—in this case the Footing’s boundary and the foundation Wall’s boundary—with one sketch. If we used the other option, Face, we would have to first edit the bottom face of the foundation and then go back, repeat the process and edit the top face of the footings.

• Select the boundary line between the foundation Wall and the footing (see Figure 11.29).
The Create Cut Profile Sketch tab appears.

35. From the Draw panel, using the **Line** shape, sketch the new path as indicated in Figure 11.30.

![Figure 11.30 Sketch the new shape using a Chain of Lines](image)

- On the Mode panel, click the **Finish Edit Mode** button.

In this case the fill pattern is the same on both sides of the Cut line, but if they were different you would notice that the fill pattern for the footing receded and the fill pattern for the foundation wall extended to fill in the key shape.

**View Breaks**

It is common that a detailed wall section will be too tall to fit on a Sheet. So it is typically broken into separate parts that crop away the repetitive areas. The crop boundary for any view includes “View Break” Controls and can be clipped to achieve this effect.

36. Select the Crop Boundary surrounding the section callout (it appears as a rectangle surrounding the drawing).
On each of the four edges of this Crop Region, a blue dot control handle appears at the midpoint and a “zig zag” break Control appears on either side of it. The “zig zag” controls allow us to truncate the view into smaller parts facilitating placement on a Sheet (see the left side of Figure 11.31).

![Diagram showing View Break Controls](image)

**FIGURE 11.31** View Break Controls allow you to crop out the middle portion of the section

- Click one of the View Break Controls on a vertical edge (there are four total; you can pick any one) of the Crop Boundary (see the right side of Figure 11.31).

The view splits into two separate Crop Regions with a large gap in the middle. A blue arrow Control Handle appears in the middle of each View Break region. We can use these to move the two portions closer together. Notice that along the vertical edges of each of the two new Crop Boundaries the same types of Control Handles appear. You can continue to break them into additional sub-views as necessary. But all breaks must be along the same direction as the first one—vertical in this case. In this example two is enough so we will not break it any further. However, we need to adjust the top View Break so we can see the entire Anchor bolt.

- Using the blue dot Control Handle at the bottom of the upper View Break, drag the edge down a bit to show all of the anchor bolt.

37. Click on the View Break Control arrow (in the middle) of the top View Break and drag it down so the Crop Region is a little above the upper crop boundary of the lower View Break (see Figure 11.32).
If you continue to drag so that you overlap the two View Breaks they will join back into one. This is how you “remove” the break.

Although the sub-views are truncated and closer together, distances are dimensionally correct. Look at the Level lines to the right of the views. The First Floor is at elevation zero (0) and the Top of Footing is at elevation -9'-1" [-2700]. Therefore, if we were to add a dimension from the top of the finished floor on the first floor to the top of the footing, it should read a distance of 9'-1" [2700]. Let’s try it out.

38. On the Annotate tab, on the Dimension panel, click the Aligned tool.

- Move the Dimension tool over the top edge of the Floor object at the First Floor.

Most likely the Level line will prehighlight. While we could dimension this point and still receive the correct value, we want to associate the dimension with the Floor element instead. We can use the TAB key here (like so many other places in Revit Architecture) to cycle to the element that we want.

- Press the TAB until the top edge of the Floor prehighlights and then click.

The selected edge will remain highlighted while you complete the dimension operation.

- Move down with the Dimension tool and over the top cut line of the Footing.

If the top cut line of the Footing does not automatically pre-highlight, use the TAB key again.

- With the top edge of the Footing pre-highlighted, click to select it.
- Move to the left Crop Region Boundary and click next to it (in the white space) to place the Dimension string (see Figure 11.33).
Notice that the Dimension displays the correct 9'-1" [2700] value from the top of the Footing to top edge of the finish Floor. As you can see, applying a View Break is a graphical convention only and has no impact on the dimensional accuracy of the model being displayed in each portion of the Crop Boundary.

- On the ribbon, click the Modify tool or press the ESC key twice.
- Add Break Line detail components on the foundation Wall at the break between the two halves of the detail.

39. Save the project.

ANNOTATION

Annotating a drawing with notes, dimensions, symbols, and tags is essential to communicating architectural design intent. Such annotations in Revit are view-specific elements. This means that these elements appear only in the view to which they are added. The exception to this is view indicators and Datum elements like section markers, elevation makers, Level Lines, Grids, and Callouts. These items are purpose-built to appear in all appropriate views and enhance the fully coordinated nature of a Revit project.

It is possible to create a view where annotation appears simultaneously in it and another "dependent" view. This feature is used to facilitate large drawings that require matchlines to fit on a standard sized sheet. If you would like to learn more, please look up Dependent Views in the online help.

Each view in Revit Architecture has a “View Scale” parameter and all annotations added to a particular view will scale and adjust accordingly. View indicators and Datum elements are included in this behavior. This means that no matter what the scale of the drawing, the annotation, view indicators and Datum symbols (level heads and grid bubbles) will be the correct size required for printed output. This behavior also applies to line weights and drafting patterns. Each graphical view you open will have its own scale. In addition, if the scale parameter of a view is changed, the text, line weights and
drafting patterns will automatically adjust. The relative thickness of a particular line, or line weight, is controlled in a matrix of common plot scales. If desired, you can edit this matrix with the *Line Weights* command from the *Additional Settings* drop-down button on the Manage tab. Drafting patterns will maintain their line spacing so the spacing always looks correct on printed output no matter what the scale is.

<table>
<thead>
<tr>
<th>NOTE</th>
<th>Model patterns do not change with the scale of the view; they are a fixed size relative to the model.</th>
</tr>
</thead>
</table>

*BIM Manager Note*  
Try using the out-of-the-box settings as-is for a while before making any changes. You will likely find the out-of-the-box settings for scale and line weight to be adequate for most situations. If you do make changes, save these modified settings in a modified version of the standard Revit template file and make it your office standard. This is much more efficient than repeating your desired edits with each new project. A common practice is to keep a record of changes made in the Project that should become standard settings. Periodically, you can use the *Transfer Project Standards* button on the Manage tab to migrate these settings into your Project Template.

### Create a Custom Text Type

A text element in Revit, like other elements, can have one or more Types. A text Type in this case is simply a grouping of parameters that control the look and formatting of the text. There are several parameters, many of which are similar to text in other computer software and are likely familiar to you.

Like other Families and Types, Text Types can be preconfigured and added to a Project Template. Additional Types can be added to the template or as a project progresses. The process for creating a new type is nearly identical to the one used for duplicating other element Types; you simply duplicate an existing one, rename it and modify its parameters. Let’s create a new text Type for our project. In this example, we will create a “general note” text Type that is 1/8" [3] high and uses a different font.

<table>
<thead>
<tr>
<th>NOTE</th>
<th>In Revit, the height is its final plotted height—you are not required to calculate text size relative to the model.</th>
</tr>
</thead>
</table>

40. On the Annotate tab, on the Text Panel, click the Text Types icon in the corner of the panel title bar (see the top half of Figure 11.34).
   - Next to the Type list, click the Duplicate button.

<table>
<thead>
<tr>
<th>TIP</th>
<th>A shortcut to this is to press <code>ALT + D</code>.</th>
</tr>
</thead>
</table>

     A new Name dialog will appear. By default “2” has been appended to the existing name.
     - Change the name to *MRAC Standard Notes* and then click OK.

You can use any font that is installed on your system. Since the choice of fonts can vary widely from one computer to the next, your system may not have the same fonts as those indicated here. Feel free to choose a different font if you prefer.

41. Beneath the “Text” grouping, from the “Text Font” list, choose the font of your choice.
   - In the “Text Size” field, type 1/8" [3] (see Figure 11.34).
This is the size the text will be when printed out. Beneath this, you can choose to make the text bold, italic, or underline if desired. The “Width Factor” setting is used to compress or stretch the text. This is a multiplier. When set to 1, the text draws in the way it was designed in the font. A value less than 1 will compress the text and a value greater than 1 will stretch it out.

In the “Graphics” area, you can change the color of the text as well as assign an arrowhead to be used when you create text with a leader line attached. Attaching a leader is done on the Options Bar. The “Leader Arrowhead” parameter is used to assign an arrowhead Type to the Text Type.

- From the “Leader Arrowhead” list, choose Heavy End 1/8’ [Heavy End 3mm].

Arrowheads are System Families. You can add additional Types using the Arrowheads command from the Additional Settings drop-down button on the Manage tab.

- Click OK to complete the new type.

**Placing Text**

42. On the Annotate tab, on the Text panel, click the Text tool.

- On the Properties palette, choose MRAC Standard Notes from the Type Selector.

To place text in a view, simply click a point on screen or drag a rectangle at the location where you want the text to appear. If you choose one of the leader options on the ribbon, the first (and possibly second) click will be to place the arrow and elbow of the leader, then you click to place the text. If you click a single point, the text will flow in one continuous line without wrapping. If you click and drag two points, it will wrap to the width between the points. Regardless of your choice, you can always edit the wrapping of a text element later using the control handles on the text element. Pressing the ENTER key within a text element will insert a “hard” Return. This will move the cursor to the next line regardless of the automatic wrapping. It is similar to using a word processor.

43. On the Format panel of the ribbon, choose the No Leader option and then on the left side of the detail, click and drag a text region near the top, close to the crop region edge.

- Type Standard Face Brick Veneer- see specification for color (see Figure 11.35).
Add a Text element and type in the desired note

- Click next to the note (in the white space) to finish typing.
- Click the Modify button on the ribbon or press ESC.

If a warning message appears and a text element disappears, you have created the text outside the annotation crop region (see Figure 11.36). The annotation crop appears as a dashed boundary outside of the view crop region and hides any annotation that falls outside its boundaries. Review the next topic for a more thorough explanation of the annotation crop region.

![Figure 11.35 Add a Text element and type in the desired note](image)

![Figure 11.36 Revit warns you when a newly created element is invisible](image)

**Annotation Crop Region**

In the exercises above, we made adjustments to the crop region of our detail callout views to fine-tune how much of the model’s geometry was included in the view. In addition to the crop region, we also have the annotation crop region. This region falls outside the normal crop region and affects only the annotation elements added to the view. When any portion of an annotation element intersects the annotation crop, the entire element disappears. While the annotation crop can be enabled in any plan, section, or elevation view, the most effective place to utilize it is in drawings that contain matchlines. In this way, if you have text or other annotation that occurs near the matchline, Revit can show a limited amount of the duplicate annotations on each matchline sheet. To see this feature in action, explore the dependent views feature in Revit. An example is shown in Figure 14.10 in Chapter 14. You can also look up dependent views and annotation crop regions in the online help.

In our current detail, we have no need to crop the annotation. Therefore we will simply turn off the feature in the current view.

- With nothing selected in the View window, on the Properties palette, beneath the “Extents” grouping, remove the checkmark from the Annotation Crop setting and then click OK (see Figure 11.37).
FIGURE 11.37 Turn off the Annotation Crop

If the notes you typed above were not showing, they should have now appeared.

Another effective way to deal with the annotation crop in a detail view, such as the one we have here, would be to simply enlarge the annotation crop region using the control handles.

Some blue control handles will appear attached to the text element while selected. You can use the one on the left to move the element (while leaving any arrow heads in place), the one on the right to rotate it, and the two small round ones on either side to resize and reshape the element and its word wrapping (see Figure 11.38).

44. Select the Text Note added above.
   - Use any of the control handles to fine-tune its placement.

FIGURE 11.38 Move, Rotate, or Resize a Text Element with its Control Handles

Including Leaders with Text

To place a leader and arrowhead with a note, you can choose the appropriate option on the ribbon.

45. On the Annotate tab, click the Text tool again.
   - On the Modify | Place Text tab, on the Format panel, click the One Segment button.
   - Click the Leader at Bottom Right button (if it is not already active).
   - In the view window, click near the middle of the double top plate on the foundation Wall.

This is the location of the arrowhead for the Leader.
   - Drag to the left and click beneath the first note (a temporary guideline will appear to assist you).
This is the end of the Leader. A text object will appear. (If you selected the “Two Segments” icon instead, you would place two segments of the Leader line before typing would begin.)

- Type the next note, **Double Top Plate – (2) 2x6** and then click next to the note (in the white space) to finish typing (see Figure 11.39).

- Using the Move handle, drag the text element to align it with the first one. A temporary guideline will appear to assist you.

When you drag a text element with a leader, be careful not to drag up or down as this will bend the leader line. This is because the leader’s arrowhead stays attached to the element to which it points. If you want to move the entire thing (text and leader together), use the Move command (on the Modify tab of the ribbon) or the arrow keys on the keyboard (to nudge). Make any fine-tuning adjustments that you wish to the position of either text element.

- Use the grip on the right side of the Text Box to shorten it until the Text wraps to make two lines.
- On the ribbon, click the **Modify** tool or press the **ESC** key twice.

The Leader should remain attached to the bottom line of Text. You can determine the Leader location for either the left or right side of the text on the Format panel of the ribbon. In the process of adjusting the Text box, the Leader may now have shifted so that it is no longer horizontal, so you may want to move the Text up or down until it returns to its original orientation as shown in Figure 11.39.

The first text element we created does not have a leader attached to it. You can add leaders to existing text anytime.

46. Select the first text element (the brick veneer note).

- On the Format panel, click the **Add Right Straight Leader** tool (see Figure 11.40).
A leader will appear attached to the text. You can then use the drag handles to modify its shape and adjust the location of the arrowhead.

- Make adjustments with the drag controls as necessary to move the arrowhead to point at the brick.

47. Using the **Text** tool with a leader option, add a note pointing to the batt insulation that reads: **Batt Insulation**.

- Adjust the position of the note and leader as required.

Sometimes you want to have the same note point to more than one location in the detail. You can add additional leaders to an existing text element. To do this, you simply select the text element and then click the appropriate icon on the Options Bar. To remove a leader you no longer need, click the “Remove Leader” button.

- With the Text selected, on the Modify Text Notes tab, on the Leader panel, click the **Add Right Straight Leader** button.
- Position the leader and its arrowheads as necessary to point at the insulation in the floor (see Figure 11.41).
Adding Keynotes

Adding text is not the only way to add notes to a detail (and other views). We can also use keynotes. Keynoting allows you to annotate your details using a pre-defined list of notes. The notes are organized in a keyed list, which is why they are referred to as keynotes. If your firm uses a keynoting system such as the AIA ConDoc system, keynotes provide a means to simplify the application of keyed notes and the compilation of all keys into a keynote legend for inclusion on titleblocks.

However, it is not required that you actually utilize the keys in order to use the keynote functionality. Even if you do not currently use a keynoting system, you may still find the keynoting tools useful. This is because rather than being required to type out each note you add to a project, with keynoting you choose the note from a pre-defined list of standard notes. Furthermore, you can even pre-assign keynotes directly to your materials, templates, and Family types in your office standard templates and library files.

Revit Architecture includes a sample keynote file organized in CSI format. You can use this list as is, edit it, or create your own. Creating or editing your own file is easy. The Keynote list is stored in a simple tab-delimited text file. If you wish to create your own file, look up the “Adding Additional Categories” topic in the online help for instructions and an example of the proper format. Of course using keynotes is optional, and to benefit fully from them, a certain amount of setup is required. You will have to decide if the benefits of doing so prove valuable enough to justify the initial configuration effort.

Before we begin adding keynotes to a project, you must choose a keynote file. You can use the same file for all projects in the office, or have different files for each project.

48. On the Annotate tab, click on the Tag panel titlebar.

The Tag panel expands to reveal more tools.

49. Click the Keynoting Settings button (see Figure 11.42).
Use the Browse button to load an existing file. Revit ships with files based on the CSI specification format. The RevitKeynotes_Imperial.txt files are based on the traditional 16 section CSI format. The RevitKeynotes_Metric.txt file is based on the newer CSI 2004 format and its 48 specification sections. These out-of-the-box keynote files are located in the C:\ProgramData\Autodesk\RAC 2012\Libraries\US Imperial folder for imperial and in the C:\ProgramData\Autodesk\RAC 2012\Libraries\US Metric folder for metric. You can use one of the provided files or create your own. Copies of these files are included with the dataset files from the student companion in the Chapter11 folder.

When assigning your chosen file to a project, the path to the file can be set to absolute, relative, or set by library location. An absolute path writes the complete path back to the drive letter. A relative path assumes that the keynote file is located in the same location as the project file and therefore only writes the path relative to the location in which the project is saved. Using the “At Library Locations” option writes the path relative to the locations defined on the “File Locations” tab of the Options dialog. The Options command is on the Application menu (big “R”).

Keynotes can be numbered using the keynote defined in the file or by sequential number relative to each Sheet in your document set. In other words, the “By keynote” method will use a fixed and predefined key. The “By sheet” method will compile the numbering uniquely for each Sheet of the set based on the notes actually used on that sheet.

Copies of the out-of-the-box keynote files have been included with the book dataset files installed from the student companion. For this reason, the “Relative” path type is configured for our project (as shown in the figure).

- Verify the settings, make any required changes, and then click OK.

50. On the Annotate tab, click the Keynote drop-down button and then choose the Element Keynote tool.

Move the cursor around on screen. Items that have a keynote assigned will appear as the mouse passes over them.
Move the mouse over the Anchor Bolt element on screen and then click it. Click a point for the leader and then a point to place the keynote tag. It requires two clicks. If you want a straight line leader, click twice along the same line. A Keynote symbol will appear with the key for the associated note displayed.

Most of the out-of-the-box detail components (like the anchor bolt and studs we used here) already have keynotes assigned from Autodesk. If you click an item that does not already have a keynote assigned (like the Walls and Floors) then the keynotes dialog will appear. At the top of the dialog whatever keynote file you assigned above will appear in the title bar. A list of major categories will appear. Each contains additional sub-categories and notes. You can choose any appropriate note from the list for the item you are noting.

The note will appear within the keynote tag with a leader pointing to the anchor bolt detail item. Continue to keynote other items if you wish. You will only be prompted to select a note the first time you keynote an item. After assigning the note the first time, Revit will simply display that note on each subsequent instance you keynote.

**Understanding Keynote Tags**

The default keynote tag has four Types. Three Types display the key and the fourth displays the text of the note. Using the text display option, you can use keynote tags to speed up data entry without being required to actually use “keyed” notes (see Figure 11.43).

51. Select one of the keynotes you have added.
   - From the Type Selector, choose **Keynote Number** or **Keynote Text**.

A couple variations are shown in the figure. If you prefer a variation not shown, you can edit the Keynote Tag Family.

---

**When you choose the Keynote Text option, you will notice that the text is center justified. To use right or left justified, edit the keynote Family, select the appropriate label element and change its properties to your preferred justification.**
Types of Keynotes—Keynotes have three modes: Element, Material, and User. The Element option reads the keynote assigned to the element in the model such as the keynote assigned to a Wall or Door, not the individual layers or sub-components of the Wall or Door. To keynote the layers of a Wall or components of a Door, you would use the Material keynote option. This will read the keynote assigned to the Material of the selected sub-component. When you wish to override the pre-defined keynote setting, choose the User option. This option will always display the “Keynotes” dialog and prompt you to choose a note. Since this option is an override, it will not update if you edit the type or Material of the selected element.

Keynotes offer some compelling features, but they are not as mature as other features in the software. For example, certain items cannot be keynoted, like Drafting Lines, Repeating Details, and Batt Insulation. Furthermore, keynotes have not been pre-assigned to all of the out-of-the-box content. They have been assigned to the out-of-the-box detail component Families as we have seen, but not to the out-of-the-box model Families or Materials. This means that to fully benefit from the power of keynotes, a good deal of effort will be required to go through the library and assign keynotes to both Families and Materials. While you might be tempted to abandon the keynote functionality altogether based on these limitations, remember that the alternative to keynotes is to manually type every note. Once set up, having keynotes assigned to elements will save a great deal of time in production and will help to standardize the verbiage and phrasing used on notes throughout the office. So they remain worthy of your consideration.

Keynote Legend—If you want to compile a list of all the keynotes used on a particular sheet or throughout the entire project, you can create a keynote legend. A Keynote Legend lists all the keys and their corresponding notes. This can be a real time saver versus manually compiling such a list. You create a keynote Legend from the View tab. On the Create panel, click the Legends drop-down button and choose Keynote Legend.

Finalizing the Detail

Our detail is nearly complete. With a few final edits, it will be ready to place on a sheet.

52. Using the process covered here, add additional notes or keynotes to the detail.
53. Using the Dimension tool, add dimensions to the footing and foundation Walls.

Remember to use your tab key as needed to select the required edges to dimension.

TIP

The Crop Regions around the detail are becoming a bit distracting. We can turn off their display.

54. On the View Control Bar (at the bottom of the view window) click the Hide Crop Region icon (see Figure 11.44).
Section III • Construction Documents

616

Hiding an Element in the View

On the left side of this detail we see a gray vertical line. This is the edge of the chimney beyond. In cases like this, where some piece of the model that we would rather not see displays, we can hide it in this view. We have two ways to approach this. Both are view-specific overrides leaving the chimney unchanged in all other views.

Method 1

55. Select the Fireplace element.

- On the ribbon, click the Hide in View drop-down and choose By Element (see the left side of Figure 11.45).

The fireplace will disappear. Should you need to make it reappear, click the small light bulb icon on the View Control Bar. This will make all invisible elements reappear tinted maroon. You can then select the chimney (or any maroon element) and choose the appropriate unhide command on the ribbon.
Method 2

56. Make sure you have no objects selected in the View Window.

- On the Properties palette, in the Extents grouping, for the "Far Clip Settings," change from Same as parent view to Independent.
  This makes the Far Clip Offset field editable.
- Change the Far Clip Offset to a small value like 1'-0" [300] and then click OK (see the right side of Figure 11.45).

This method will crop out everything in the view beyond 1'-0" [300] from the cut plane.

Detail the Remainder of the Wall

To detail the rest of the Wall section, you can follow the same procedures as outlined here. Start by returning to the Longitudinal section view and create a new callout of the top portion. Use the View Break controls to crop the detail and remove the repetitive portions. Add masking break line Detail Components to each of the breaks. Hide the Crop Region of the view when finished. Begin adding Detail Components on top of the section cut as we did above, add drafting lines and edit the linework as required. Complete the detail with dimensions, notes and/or keynotes. Focus on the Wall connection at the second floor and the overall studs, rafters, joists, and insulation. When you are finished, the detail should look something like Figure 11.46.

![Figure 11.46](image)

**FIGURE 11.46** Create additional Details using the same process

Most of the components that you will need are already loaded into this project; however, for items like the steel angle at the Window lintel, you can simply load them in from the appropriate library. At the roof eave, you will need to rely more on Filled Regions, Drafting Lines, and Edit Cut Profile. Let’s take a look.

57. From the View tab, click the Callout tool.

- On the Properties palette, choose Detail View: Detail from the Type Selector.
- Create a Callout bubble similar to the one shown in Figure 11.47.
58. In the Project Browser, expand the Detail Views branch.
   - Select **Detail 0** and right-click to rename it to: **Typical Eave Condition**.
   - With the **Typical Eave Condition** view still selected, on the Properties palette change the scale to **1 ½” = 1'-0”** and the Detail Level to **Fine**.
   - Double click on the **Typical Eave Condition View** to open it.

### Using Edit Cut Profile to Modify Wall Layers

As you have seen, you can use the technique of adding Filled Regions and Masking Regions to cover unwanted geometry and then sketching Detail Lines on top for almost any situation. There is nothing inherently wrong with the procedure, but if the underlying model should change, the Filled and Masking Regions may no longer cover the intended geometry leading to errors in coordination and intent. Another approach is to modify the underlying geometry as it is displayed in this view. To do this, we use the **Edit Cut Profile** tool as we did above for the footing.

Work in the **Typical Eave Condition** view.

59. Select the Roof Level Marker; on the ribbon, click the **Hide in View tool** and choose **Hide Category** from the pop-up.

60. On the View tab, on the Graphics panel, click the **Cut Profile** button.
   - Pass the cursor over the Wall and when the stud layer pre-highlights, click the mouse.

   The Create Cut Profile Sketch tab appears and shows some now familiar sketch tools. The existing boundary of the stud layer will show as an orange outline.

61. Using the Lines icon on the Draw panel, draw the cut profile (see Figure 11.48).

### FIGURE 11.47
Create a Callout View for the eave condition.

### FIGURE 11.48
Sketch the new edge of the Cut Boundary

A small arrow handle will appear on the sketch line. It should be pointing to the inside of the stud to indicate that you wish to keep everything below the sketch line. If it points outside the stud, click it to reverse it. Be sure that the line touches the edges of the stud component on both sides.
• On the Modify | Cut Profile panel, click the Finish Edit Mode button.

The result should look like the stud shown in Figure 11.49.

FIGURE 11.49 After the Cut Profile Edit, the shape of the Wall reflects the change

62. Use the Cut Profile tool again to edit the face of the Brick, Air Gap and Sheathing layers so that your detail looks like Figure 11.49.

The profile line for the Sheathing layer should be 5/8" [16] above the profile lines for the Air Gap and the Brick.

63. Use Detail Lines, Masking Regions, Detail Components and Repeating Details to add embellishment to the Detail (see Figure 11.50).

FIGURE 11.50 Finishing the Eave Detail.

64. Make any additional edits and then save the project.
Add a Detail Sheet

Once we have created one or more Detail views, we can add them to Sheets in the same fashion as other views. We explored this process back in Chapter 4. Let’s review the steps here to create a new Detail Sheet that contains our Typical Wall Section detail.

65. On the Project Browser, right-click the Sheets (all) branch and choose New Sheet.
   - In the “Select a Titleblock” dialog, choose MRAC D 22 × 34 Horizontal [MRAC A1 metric] and then click OK.

This will create “G101 - Unnamed.” This is because the last Sheet we created was Sheet G100.

   - In the Number field, type: A601.
   - In the Name field, type: Details and then click OK.

   You can also click directly on the (blue text) values in the titleblock and edit them directly on screen without right-clicking the sheet on Project Browser.

67. From the Project Browser, drag the Typical Wall Section detail view and drop it on the Sheet.
   - Click a point to place the detail. Move it around as desired to fine-tune placement.

68. On the Project Browser, double-click to open the Longitudinal section view (if you prefer, you can also open A301 – Sections Sheet instead).

Notice that the callout annotation has automatically filled in to indicate that the detail is number one on Sheet A601. This will also remain coordinated automatically (see Figure 11.51).

![FIGURE 11.51 Annotation will coordinate automatically after adding the detail view to a Sheet](image)

69. Repeat the process to add the other details done in this chapter to this Sheet.

If you want to align the views to one another on the sheet, it can be tricky sometimes to select and move the right thing. When you click the viewport, both the viewport and the title will highlight and move together. However, if you click just the title, you can move it independently. Revit will try to give you alignment guidelines as you drag items on screen.
In some cases, you will add details to the Sheet and then later wish to reorganize or renumber them. To do this, you edit the View Properties of the view in question. Edit the value of the “Detail Number” parameter in the “Instance Properties” dialog for the view. Be sure to type a number not yet in use—Revit will not allow you to duplicate an existing number. To swap the numbers of two details, first edit one to a unique value, edit the other to the value originally used by the first, and then edit the first to the number originally used by the second. If you make such a change, open the Longitudinal section view and note that the new numbers are reflected there as well. A change in one location is a change everywhere in Revit!

You can edit the view’s Properties directly from the Sheet if you wish. Expand the Sheet entry on the Project Browser to see a listing of all views already placed on a particular Sheet. Click the name listed and the properties for the View will be listed on the Properties palette. You can also double-click the view from there to open it.

**Create a Custom View Title**

Some firms like to see the sheet where a detail is referenced. You can customize the View Title Family to include this information automatically.

70. Expand the Families branch on the Project Browser.
   - Expand Annotation Symbols, right-click View Title, and choose Edit.

Annotation Families are much simpler than the component Families we worked with in the previous chapter. Here you can add linework, text, and labels. Labels report the values of parameters. In the case of View Title Families, we can report the name and number of the detail, the scale and the referring detail, and the sheet.

71. On the Home tab, on the Text panel, click the Label tool (see Figure 11.52).

![FIGURE 11.52 Add a Label to the View Title Family](image)

The line under the view title is actually part of the viewport object back in the project. Therefore, as you can see, there is no line here. You will have to approximate the correct location of the new label relative to the line. We’ll place it next to the scale Label in this case.
   - In the “Edit Label” dialog that appears, choose Referencing Detail and then click the Add Parameter(s) to Label icon in the middle of the dialog.
   - Select Referencing Sheet and add it to the label as well.
Section III • Construction Documents

- In the Prefix field for Referencing Sheet, type: / (a forward slash) and then click OK. This will make the Label display the Referencing Detail parameter, then a slash, then the Referencing Sheet like this: R/R101.

72. Edit the Element Properties of the new Label and change the Horizontal Align to Left.
- Use the control handles to reduce the width of the field and move it as necessary (see Figure 11.53).

![View Name](image1)

**FIGURE 11.53 Add Labels for the Referencing Detail and Sheet**

If you wish, add additional graphics, text, or labels.

73. From the Application menu, choose Save As > Family.
- Browse to the Chapter11 folder and save the Family as: MRAC View Title.rfa.
- On the ribbon, click Load into Project.

74. On the A601 – Details sheet, select all three viewports, on the Properties palette, click the Edit Type button.
- Click the Duplicate button.
- Name the new Type: MRAC Viewport with Referencing Title.
- Change the Title entry to MRAC View Title and then click OK (see Figure 11.54).

![Diagram](image2)

**FIGURE 11.54 Load the Custom View Title into the project and apply to the viewports**
75. Save the project.

Notice that the two wall details reference back to the A301 sheet, but the Typical Eave Condition references A601.

**DRAFTED DETAILS (NOT LINKED TO THE MODEL)**

In some cases, you will want to add a detail to a project that does not require a call-out underlay from the model. There might be several situations where this is appropriate. Examples include typical details that are generic in nature such as a typical head, jamb, or sill detail. Other examples might include a carpet transition, typical blocking condition, Wall type details or just a simple diagram of something related to the project but not specific to a particular area in the model. To create these kinds of details in Revit, we use a drafting view. A drafting view is like a simple blank sheet of paper. You can draw your detail on this blank page using any of the tools covered so far like detail components, filled regions, masking regions, drafting lines, and text. You can even add view references from other views if appropriate.

**Creating a Drafted Detail**

In this example, we will create a drafting view and a simple carpet transition detail. This can be created either with or without a view reference callout in our floor plans. You can create it as a typical, unreferenced detail by creating a new Drafting View on the View tab. If you want to reference the drafting view from a particular area of the plan, you can create a drafting view from the section and callout tools. To do this, you choose the “Reference other View” setting on the Options Bar before drawing the section or callout. For this example, we will create an unreferenced detail. In the next sequence, we will create a referenced one using the section.

1. On the View tab, on the Create panel, click the **Drafting View** tool.
   - In the dialog that appears, type **Floor Transition Detail** for the name.
   - Choose 3"=1'-0" [1:5] and then click OK (see Figure 11.55).

![New Drafting View dialog](image)

**FIGURE 11.55 Create a new Drafting View**

A new drafting view will be created and opened. When Revit opens the new drafting view the most obvious characteristic is that the view is empty, showing no model geometry. A drafting view is like a blank sheet of paper. There are no automatically generated graphics from the model.

2. On the Annotate tab, on the Detail panel, click the **Component** drop-down button and choose the **Detail Component** tool from the list.
   - Click the **Load Family** button and browse to:
     Imperial: Detail Components\Div 06-Wood and Plastic\061600-Sheathing.
Section III • Construction Documents

Metric: Detail Components\Div 06-Wood and Plastic\06100-Rough Carpentry\06160-Sheathing.

- Open the Plywood-Section.rfa [M_Plywood-Section.rfa] file.
- From the Type Selector, choose the ¾” [19mm] type.

If you have trouble finding this file, or if you did not install the default library files, all of the Families noted in this section are provided with the dataset files from the student companion. You will find them located in the same folder structure as noted here in the MRAC\Imperial Library [MRAC\Metric Library] folder. Feel free to load the required detail components from there instead.

- Following the prompts, create a horizontal length of plywood approximately 10” [250] long across the middle of the screen (see Figure 11.56).

![FIGURE 11.56 Draw the plywood subfloor](image)

- Zoom in on the component after you draw it.

3. Click the Load Family button again and browse to:
   Imperial: Detail Components\Div 09-Finishes\096000-Flooring\096400-Wood Flooring.
   Metric: Detail Components\Div 09-Finishes\096000-Flooring\09640-Wood Flooring.
   - Open the Wood Strip Flooring-Section.rfa [M_Wood Strip Flooring-Section.rfa] file.
   - From the Type Selector, choose the 1×3 [19 × 76mm] type.

4. Place the item on the top edge of the plywood.

- Repeat the process to load four more Families from:
  Imperial: Detail Components\Div 09-Finishes\096000-Flooring\096800-Carpeting.
  Metric: Detail Components\Div 09-Finishes\096000-Flooring\09680-Carpeting.
  Carpeting-Section.rfa [M_Carpeting-Section.rfa]
  Carpet Reducer at Flooring-Section.rfa [M_Carpet Reducer at Flooring-Section.rfa]
  Carpeting Tack Strip-Section.rfa [M_Carpeting Tack Strip-Section.rfa]
  Carpet Pad-Section.rfa [M_Carpet Pad-Section.rfa]

With the first three, simply place them on screen in approximate locations for now. The Carpet Pad-Section.rfa [M_Carpet Pad-Section.rfa] Family behaves like the Plywood-Section.rfa [M_Plywood-Section.rfa] Family above did. You must click two points to place it. You can click two points along the top edge of the plywood for this component.

5. Move and copy the carpet and wood flooring components on screen to match Figure 11.57.
6. Add a Break Line Detail Component to the end of the detail.
   • Edit the Element Properties of the Break Line and change the Dimensions parameters as follows:

<table>
<thead>
<tr>
<th>TABLE 11.1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jag Width</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Right</td>
</tr>
<tr>
<td>Left</td>
</tr>
<tr>
<td>Masking Depth</td>
</tr>
</tbody>
</table>

   Set the Jag Width and Jag Depth first and the Right and Left last. This will avoid Revit’s displaying error messages.
   • Copy the Break Line to the other side, and then press the SPACEBAR twice to flip it.

7. Add notes or keynotes to complete the detail (see Figure 11.58).
8. Add the detail to the A601 – Details sheet.

If you want this detail to be a typical detail, edit its View Properties and change the “Title on Sheet” parameter to “Typical Floor Transition Detail.” Otherwise, if you prefer to call it out from the plan, you can open the First Floor plan view, zoom in on an appropriate area and then click the Section tool. From the Type Selector, change the view type to Detail View: Detail. Before you draw the section, check the “Reference other View” box on the Options Bar and choose Drafting View: Floor Transition Detail from the list of views. Draw the section line. The callout will read detail 3 on sheet A601 (see Figure 11.59).

![FIGURE 11.59 You can optionally add a section callout that references the existing Drafting View](image)

9. Save the file.

**WORKING WITH LEGACY DETAILS**

Often details are reused from one project to the next. These “standard” details are typically kept in libraries for easy reuse and retrieval. In the days before computer design and drafting software, such a library would be a three-ringed binder from which photocopies were made. With computers, these standard details are stored digitally. If your firm has been using CAD software for a while, you likely already have such a digital library of standard details. You can use these legacy files directly in your Revit Architecture projects. You simply import the DWG or DGN files and place them on Sheets like other details.

**Create a Referenced Section View**

In this tutorial we will assume that the handrail of the existing Stair will be replaced with a new one. To show this, we will create a “Referenced Section View” to create a Section marker callout of a handrail detail within a stair section view. However, instead of creating the actual section view in Revit Architecture or drawing an unreferenced drafting view as we did above, the Referenced Section will link to a drafting view containing an AutoCAD file.

1. On the Project Browser, double-click to open the Section at Existing Stair section view.
• Zoom in on the area of the Stair between the First Floor Level and the Second Floor Level.

2. On the View tab, click the **Section** tool.
   - From the Type Selector, choose **Detail View: Detail**.
   - On the Options Bar, set the “Scale” to 6”=1'-0’ [1:2].
   - Place a checkmark in the “Reference other View” checkbox, and verify that the menu is set to **New Drafting View** (see Figure 11.60).

These settings instruct Revit to create a new Drafting view instead of the typical live section view of the model. The detail marker will point to this new drafting view.

• Drag the section line through the Railing as shown in Figure 11.60.

![Figure 11.60 Create a new Section View set to reference a New Drafting View](image)

Notice that a new Drafting view was created on Project Browser beneath **Drafting views**.

3. On the Project Browser, right-click the new Drafting view and choose **Rename**.
   - Name the view **New Railing Detail** and then click OK.

4. In the section view window, double-click on the detail head to open this Drafting view.

We again have a blank page upon which to work. Drafting an image that makes sense relative to the detail cut location is up to you. The only reference back to the model is the callout. We have already seen how we can draft something from scratch. Now let’s look at importing a legacy CAD file.

**Import a Detail Drawing**

5. On the Insert tab, on the Import panel, click the **Import CAD** button.
   - In the “Import CAD Formats” dialog, browse to the Chapter11 folder and choose **Typical Handrail Detail.dwg** [**Typical Handrail Detail-Metric.dwg**].
   - In the “Layer-Level Colors” area, choose **Black and white**.
   - In the “Positioning” area, choose the **Manual-Center** option (see Figure 11.61).
Import embeds the file into the Revit project and does not maintain a link to the file. If the file were changed outside of Revit, you need to re-import the modified file. If you wish to link to the file instead, use the Link CAD tool on the Link panel instead. Linking makes it possible to reload the file later via the “Manage Links” dialog if the original file changes.

6. Click Open to import the detail, and then click a point on screen to place the detail in the view.
   • Verify that the scale of the current view is 6"=1'-0" [1:2] as indicated above. If it is not, please change it.
   • Zoom to fit.

Notice that if you change the scale, it has an impact on how the line weights of the imported view display. If you wish to experiment with the way that the line weights import, click the small dialog launcher icon on the Import panel titlebar to open the “Import Line Weights” dialog. Revit uses the line weights built into the CAD file as is. If there are no line weights assigned to the CAD file’s layers, then it looks to the colors of the layers and assigns lineweights as listed in the “Import Line Weights” dialog for each color.

This is a typical detail and there is no need for any changes. If we needed to make edits, we could select the detail, and then on the ribbon, click the **Explode** button to convert it to individual Revit Detail Lines and Text so we could edit it. However, it is best to avoid this and make such edits in the original file using its native application instead of using Explode. Exploding an imported file can increase file size adversely and create inaccuracies in the file. Most CAD/BIM Managers would look unfavorably on exploded CAD files in live Revit projects, so please consider carefully before you proceed.
If you choose to explode imported CAD files, you will discover that many element types are added to your file beyond what you see on screen or what you would otherwise expect. For example, you will likely end up with many line styles, text styles, and other elements bearing names reminiscent of the original CAD file’s layers. In addition, regardless of whether you choose to explode the file, you will get Materials bearing names like Render Material 63-0-255 in your Material list. In general, these items will not cause you difficulty but they can increase the size of your files and cause confusion among team members. If you have decided to explode a CAD file, consider the following procedure. First, if you have access to the CAD program that created the file, open the file there first and clean up the geometry as much as possible. This includes deleting unneeded geometry and layers, purging the file, and resaving it. Next, import the CAD file into a new Revit project. Explode the CAD file in this temporary project and perform additional cleanup. This will include reassigning linework to appropriate Revit Line Styles, changing text to Revit text Types, etc. Please note that CAD dimensions and text leaders will not become Revit dimensions or leaders, so if you want actual leaders and dimensions, you will need to recreate these items. Once you have cleaned up the file to your satisfaction, you can select all of the elements and copy and paste them back to a drafting view in your original project. In general, importing CAD files into Revit should not become a long-term practice. CAD files in a Revit project can unnecessarily bloat the file and cause performance problems. Over time, you will find it beneficial to convert your standard CAD details to Revit format if you wish to continue using them in your Revit projects. For more information on this and other critical model management tips, you can download the Model Performance Technical Note at http://usa.autodesk.com/adsk/servlet/index?siteID=123112&id=8480751. While this document was written for Revit 2010 at the time of this writing, it is still relevant and the topics discussed in it apply to Revit 2012 as well.

7. On the Project Browser, double-click to open the A601 - Details Sheet view.
   - Drag the Drafting view and drop it on the Sheet (see Figure 11.62).

**FIGURE 11.62 Add the Detail view to the Details Sheet**

This will become detail 5 on the sheet. If you return to the Section at Existing Stair view, you will see that this number and sheet reference have appeared automatically in the callout.

8. Save the project.
Section III • Construction Documents

ADDITIONAL DETAILING TECHNIQUES

Except for Drafting views, all views in the Revit Architecture project are generated directly from the building model. While Revit does a very good job of interpreting this model geometry into abstracted two-dimensional representations such as plans and elevations, there are often items that we wish to manipulate in order to create the Architectural drawings we are accustomed to producing. We have already seen all of the techniques that are used to perform such edits. Until now we have used these techniques and tools only on detail views. However, you can add drafting embellishment on any Revit view including plans, sections, and elevations. All such edits, including those made with the Linework tool, Filled Regions, Masking Regions, Detail Components, Edit Cut Profile, and Drafting Lines can be done on any view. More importantly, such edits apply only to the view in which they are applied.

Embellishing Model Views

Let’s make a few enhancements to one of our elevation views.

9. On the Project Browser, double-click to open the East elevation view.

One common architectural drafting convention is to show the new foundation in an elevation as dashed below grade. We can achieve this using a combination of the Linework tool and adding Drafting Lines. Let’s start with the footing.

10. Select the Terrain element, and then on the View Control Bar, choose Hide Element from the Temporary Hide/Isolate menu (sun glasses icon).

A cyan colored boundary will appear around the viewport. New in 2012, a label reading “Temporary Hide/Isolate” will appear in the upper corner. Remember that this is the temporary hide/isolate command. The cyan boundary appears as long as some elements are temporarily hidden. Temporary hide/isolate does not affect printing and is reset when the model is closed.

11. Select each of the Level Heads that do not have associated views (the ones that are black), right-click and choose Hide in View > Elements. (You can also use the ribbon tool.)

This will hide levels for “Top of Footing” or “Bottom of Stair” etc. This is the permanent hide command. These elements will stay hidden even after closing and reopening the model. Permanently hidden elements also do not print. To reveal hidden elements and unhide them, click the light bulb icon on the View Control Bar. If you try this now, a maroon colored border will surround the screen and the label in the corner will change to reflect the new mode. The three hidden Level Heads will appear maroon in color as well, and the temporarily hidden terrain, which is still hidden, will appear cyan in color. Click the light bulb again to exit the mode.

12. On the Modify tab, on the View panel, click the Linework tool.

• Choose <Hidden> from the Line Style drop-down list.
• Click on each of the edges of the footings to change them to <Hidden> lines.
• Do not change any of the vertical foundation lines yet (see Figure 11.63).
You may need to pick more than once in the same general spot or a little to either side since there is more than one footing in the same spot in the elevation. If you are unhappy with the result, you can instead use the "Invisible lines" Type and then draw a continuous Drafting Line in on top. Be sure to lock the constraint padlock icon to keep the Drafting Line associated with the position of the footing.

13. On the View Control Bar, choose **Reset Temporary Hide/Isolate**. The terrain model will reappear. Notice that the footing still shows dashed through the terrain and is no longer hidden.

14. With the **Linework** tool still active, choose **<Hidden>** from the Type Selector again.
   - Click on one of the vertical lines of the foundation Walls.
     With it still highlighted, a drag handle will appear at either end.
   - Drag the top handle down to the point where it intersects the terrain (see Figure 11.64).

Later if you wish to change the linework to a different linetype or return it to its default setting, you can use the Linework tool again. To restore the default, use the **<By Category>** option from the Type Selector.
If you wish to modify the way that the terrain displays, you can use a Filled Region to trace over it. Draft additional linework as desired to complete the elevation. You can add notes, dimensions and tags as required. If the Linework tool is not working for a particular edge, you can try Masking Regions and Drafting Lines.

15. On the Annotate tab, on the Tag panel, click the Tag by Category tool.
   • On the Options Bar, clear the “Leader” checkbox.
   • Click on each of the Windows in the new addition. (Do not tag the Windows of the existing house.)

16. Add some text or keynotes to the patio on the right or to indicate materials of the elevation such as brick veneer and roof shingles (see Figure 11.65).

   **TIP**

   Try the Keynote > Material option to keynote the materials in the Wall instead of the entire Wall.

   ![Figure 11.65](image)

   **FIGURE 11.65** Add tags and notes to complete the elevation

17. Perform similar edits in other elevations if you wish.
18. Save the project.

**Controlling Display of Items Beyond**

To show depth in elevations, it is a common architectural convention to lighten the line weights of objects as they recede from view. Unfortunately, Revit does not offer an automated way to do this in elevations and sections. However, we can use the override graphics feature to manipulate the graphical display manually. Like all graphical overrides, edits you make are view-specific. So they will apply only to the view in which you make them. It may take you a little time and effort to fine-tune the elevations to display as desired, but you should be able to achieve acceptable results. We’ll do a quick example here to illustrate the concept and process.
19. On the Project Browser, double-click to open the North elevation view.

   • Feel free to repeat any of the previous edits (foundation display, notes, etc) on this elevation before you proceed.
   • On the right side, at the upper patio, select the gable Roof, its fascia boards and gutter, and the two upper Windows.
   • On the ribbon, on the View panel, click the **Override Graphics in View** button and choose **Override By Element from the pop-up**.
   • In the “View-Specific Element Graphics” dialog, expand the Projection Lines item and change the Weight to 1 and then click OK (see Figure 11.66).

![FIGURE 11.66 Override the graphics of selected elements in the view](image)

This change may be hard to see without zooming in. We also want to lighten the brick hatch on the Wall beyond at the patio in the same area.

20. Select the Wall beyond at the patio in the same area.

   • Choose **Override Graphics in View > Override By Element** again.
   • Check the Halftone checkbox and then click OK.

Notice that because of the way that the Wall joined, we are seeing the end of the perpendicular Wall on the right side. We can override this Wall the same way or we can edit the join of this Wall on the Second Floor to fix this.

21. On the Project Browser, double-click to open the Second Floor plan view.

   • On the Modify tab, click the **Wall Joins** tool.
   • Click on the intersection of Walls at the lower-left side of the patio.
   • On the Options Bar, click the Miter radio button and then click the **Modify** tool to accept the change (see Figure 11.67).
When you return to the North elevation, you will notice that selecting the Wall now gives better results.

22. Repeat any of these procedures on the remaining elevations and then save the project.

There is a feature called Silhouettes which will override the profile edges around your model in the current view. To access it, click the Visual Style pop-up on the View Control Bar (the tool that sets hidden line or shading) and choose **Graphic Display Options**. In the “Graphic Display Options” dialog, you can choose a Line Style for Silhouettes. However, this feature lacks the capacity to control which edges receive the effect. Revit will determine which edges are silhouette edges and which are not. Give it a try and see if the results are satisfactory. If not, you can use the Linework tool to override the outline of elements in elevation the same way we dashed the footings.

**Legend Views**

As our final exploration in this chapter, we will look at another type of drafting view: the Legend View. This kind of view, as its name implies, is used to create symbol legends in your project. When working in a legend view, you can add Legend Components. Legend Components are symbolic versions of all Families and Types in your project, and as such are only graphical representations, not actual model elements.

23. On the View tab, on the Create panel, click the **Legends** drop-down button and then choose the **Legend** tool.

   • In the “New Legend View” dialog, type Door Types for the name, choose 1/4"=1'-0" [1:50], and then click OK.

Like the other drafting views we have created, a blank page will appear. The unique feature of a legend view is the availability of the **Legend Component** tool on the Annotate tab. We can use this tool to place a symbolic representation of any Family in the project. In this case, we are building a Door Types Legend, so we want to add elevation views of each kind of door, but do not want to add actual Doors, which would throw off the count in the Door Schedule later. This is where the Legend Component comes into play.

24. On the Annotate tab, on the Detail panel, click the **Component** drop-down button and choose the **Legend Component** tool from the list.
Chapter 11 • Detailing and Annotation

• From the Family list on the Options Bar choose Doors: Single Flush: 36" × 80" [Doors: M_Single Flush: 0915 × 2032mm].
• From the View list on the Options Bar choose Elevation: Front.
• Click a point on screen to place the symbol.
• Repeat the process to place each of the following:
  Doors: Bifold-2 Panel: 36" × 80" [Doors: M_Bifold-2 Panel: 0915 × 2032mm]
  Doors: Bifold-4 Panel: 72" × 80" [Doors: M_Bifold-4 Panel: 1830 × 2032mm]
  Doors: Double-Glass 2: 68" × 80" [Doors: M_Double-Glass 2: 1730 × 2032mm]

Line them up next to one another. You cannot tag the symbols because they are not real doors, but you can add text and dimensions where appropriate.

25. Add labels, notes, and dimensions as appropriate (see Figure 11.68).

![FIGURE 11.68 Add notes and labels to complete the legend](image)

To edit the dimension values as shown in the figure, simply click on the dimension text and then edit the appropriate fields in the dialog that appears.

You can drag this legend view onto any sheet like the other views. Perhaps the most appropriate sheet for this legend would be the door schedule sheet. Since we have not created a door schedule yet, we will wait until the scheduling chapter for that task.

26. Save the project and close the file.
SUMMARY

Understanding the relationship between modeled elements and drafted elements is an important concept in Revit Architecture. Creating the basic model geometry can be accomplished in nearly any convenient view and as we have seen throughout this book and will remain coordinated as changes occur in all views. Drafting and annotation, on the other hand, occur in only the currently active view. This means that we can apply additional embellishments on top of an automatically generated model to explain and clarify design intent. We can modify the display of underlying model geometry using the Linework tool, element level graphic overrides, or view-specific display settings. Finally, we can create drafting views, which contain only drafting elements and no model geometry. Using a combination of these techniques, we can fine-tune any Revit view for inclusion in our complete set of architectural construction documents.

- Detailing occurs at many levels in Revit: as part of the model, as view-specific embellishment on top of the model, and as completely independent drafting views.
- You can use Wall Type edits such as unlocking layers, adding Sweeps, and adding Reveals to add details to the Walls that show throughout the model.
- Create callout views of any overall view to create the starting point for a construction detail.
- Add view-specific detail component (2D) Families, drafting lines, repeating details, filled and masking regions and batt insulation to embellish and add content to the underlying model callout view.
- Each view has its own scale and visibility settings.
- Detail Components and Detail Lines are view-specific embellishments that are used to convey design intent.
- Repeating Detail Components save time by adding an array of Detail Components at a predefined spacing.
- Use Masking Regions in any view to mask unwanted portions of the model.
- Use Filled Regions to apply patterns to areas and draw view-specific embellishments.
- Add Break Lines and adjust Crop Regions to isolate “typical” portions of detail views.
- Annotate the detail with dimensions, text notes and keynotes.
- Keynotes reference an external keynote file and help to maintain consistency in noting and reduce repetitive typing.
- Keynotes can display either the key or the note. You can add a keynote legend to list all notes used in the project or sheet by sheet.
- Use Cut Profile to modify the automatically created profile of building model elements within a particular view.
- Adding details to a sheet automatically numbers them and keeps the annotation coordinated.
- You can draw isolated two-dimensional details that do not link to the model. Use drafting views for this purpose.
- Import legacy CAD details and add them to drafting views to leverage existing detail libraries.
- Edit any section or elevation view using similar techniques to those used to create and modify details.
- Use the Override Graphics in View command to indicate elements that appear “beyond” in an elevation or section.
- A legend view is a special kind of drafting view that allows symbolic representations of any project Family to be added and annotated.
INDEX

A
Acoustical tile ceilings, 689–691
Add Edge tool, 774
Add Profile tool, 766, 775
Add Split Lines tool, 424
Adjust for Mullion Size setting, 457
Air gaps, 432, 434
Align tool, 34, 320, 585
ALT key, 81
Angle constraint, 463, 464
Angled Mullions, 474
Angular parameters, 793–797
Annotation
crop regions, 608–609
custom View Titles, 621–622
elements, 44, 47–48
families, 52, 511–512
keynotes, 612–615
leaders with text, 609–612
overview, 605–606
placing text, 607–608
text types, 606–607
visibility of, 589–591
Appearance option for printing, 715–717
Application menu, 73–76, 715
Arc options for walls, 115
Architects and BIM, 43
Architectural vs. Structural Columns, 251. See also
Columns
Area boundary line, 683–685
Area plans, working with, 683–686
Arraying
coat hooks (example), 560–561
grid lines, 242–246
Arrowheads, 607, 610
Artificial lighting, 824, 814–815
At Columns button, 254–255
Attached Detail Groups
adding to mirrored Groups, 296–297
adding to nested Groups, 303–305
creating for existing Model
Groups, 295–296
defined, 285
impact of Model Group changes on, 284, 288–289, 291, 296
tags and, 290, 295
Aubin, Paul F.’s web site, 817
AUGI, 471, 474
AutoCAD. See CAD; DWG files
Autodesk Buzzsaw, 718
Autodesk Design Review, 235, 721–722
Autodesk discussion groups, 474, 838
Autodesk Seek, 359, 491, 499, 719
Autodesk Users Group International
(AUGI), 474
Automatic ceiling, 690
Automatically Embed option, 456
Avatech Solutions, 640
Background for rendering, 817
Base Point, 318, 320, 585
Base ment
creating stair to, 325
new construction, 824–825
Basic walls, defined, 435, 486
Batch printing, 716
Batt insulation, 600–601
Bay windows, 785–786
Bays, sub-dividing Curtain Wall, 469–470
Beams, 269–270
<Beyond> line style, 276
Bi-directional coordination, 45
BIM
CAD vs., 40–44
extended design team and, 578
overview, 69, 38, 42
Binder bin example. See Parametric Families
Blends
defined, 504
solid, 523–526
swept, 504, 526–529
Blue color, 116, 187
Boundary and Riser mode, 336,
353–356
Boundary Line mode, 696
Braces, 270–271
Break Lines, 599–601
Brick shelves, 580–587
Browser Organization, 54–56,
229–231, 230
Building Information Modeling. See
BIM
Building Pads, 316–317
Bull nose risers, 355–356
Buzzsaw, 718–719
Callout views, 587–589
Camera views, 808–809
Canvas area, 88–89
Cartoon sets, 185, 233–234
Cased openings, 151–152
Categories
assigning Families to, 162–164
defined, 548–550
overriding by, 411
Ceilings
acoustical tile, 689–695
automatic, 690
completing RCP, 707
creating via Sketch, 695–697
displaying Doors in reflected, 704
drywall, 702–703
existing, edit an, 697–698
fixtures, 702–707
height offset, 690, 697
moving, rotating, and aligning grids, 695–696
section views of, 699–700
sketch, 695–696
switching to different grid size, 706
type properties, 691–693
type selector, 691
underpinned, 698–699
Central file, 732–734, 739–743, 751
Chain option for walls, 110, 113–115
Chain selection, 16, 99
Chimneys, 279, 390–393
Closed stringers, 349
Clouds in background, 817
Coat Hook Family example
arrays, 568–569
changing family category, 562–563
creating, 560–561
formula parameters, 564–566
loading, 570–571
nested families, 563–564
parametric array count, 569
using formula for array count,
569–570
visibility parameters, 567
Color Fill Legend, 65
Color Schemes, 678–683
Colors
in DWG and DGN files, 312
element/selection, 139–140
Columns
adding, 236–253
copying and pasting aligned,
258–259
editing, 255–258
using structural tools for, 251

841
Commercial project, creating, 185–186
Component Elements, 47
Component Families, 52–53, 485–489, 495
Components
basic procedure for creating, 111–110
cased opening, 151–153
detail, 584–635
legend, 634–635
overview, 40
plumbing fixtures, 149–162
Component Families, 52–53, 485–489, 495
Components
basic procedure for creating, 111–110
cased opening, 151–153
detail, 587–598
legend, 634–635
overview, 40
plumbing fixtures, 149–162

Computer-aided design. See CAD
Conceptual Massing environment. See also Divided Surface and Patterning tools
accessing, 756–758
creating forms, 759–760
eXtrusions, 762–764
lofts, 764–766, 771
overview, 761, 767
revolves, 760–761
sweeps, 767–770
swept blends, 770–771
editing forms
add Edge tool, 774
add Profile tool, 766
global and local controls, 773–774
overview, 747
X-Ray tool, 772
In-Place Mass example, 199–200
In-Place vs. Loadable Families, 756
intent stack, 761–762
interface, 758–759
loadable Family example
adding bay window, 785–786
creating new file and adding levels, 735–736
creating solid form, 735–736
loading into project, 734
sculpting top surface, 774
model-based vs. reference-based forms, 758–759, 776–780
overview, 756
Constraint system, 9
Constraints
applying, 145–146
blends and, 504
equality, 146–147
grid rotation and, 702
parameters vs., 541
Construction Documents, need for, 660
Construction phases. See Phases
Construction templates, 188
Contextual ribbon tabs, 76–77
Continuous Footings, 274–275
Contract Documents, relevance of, 578
Coordinates
project, 318
shared. See Shared Coordinates
toggling between global and local, 773–774
Coordinating Monitor tool, 728–729
Coordination review, 364–365
Copy/Monitor tool, 328, 422
Copying
columns, 258–259
grid lines, 249
walls, 121–122
Copy to Clipboard command, 298
Cut Geometry, 453
Cutable elements, 538
Cycle Section Head/Tail controls, 212
Datum Elements, 45–49, 605
Day lighting, 805, 821, 829, 835, 837
Default templates, 174–180
Delete command (for Groups), 308
Dependent views, 725–726
Desk Family example
adding keyboard shelf, 510–511
adding void form, 518
adjusting view windows, 522–523
creating, 511–517
creating pencil drawer, 529–530
creating reference plane, 521–522
creating solid blend, 523–526
creating solid extrusion, 519–520
creating solid revolve, 530–531
creating solid sweep, 532–534
editing extrusion, 505–506
loading, 534–535
mirroring leg, 526–529
using swept blend for fancier leg, 526–529
Detail Components, 592–598
Detail Elements, 49
Detail Groups. See Attached Detail Groups; Groups
Detail Lines, 50, 591–592, 618
Detail Sheets, 620–621
Detail views, 67–68
Detailing. See also Annotation
adding Break Lines, 599
adding callout view, 587–589
additional techniques, 630–635
creating working view, 437–439
curtain systems vs., 435–436, 458
drawing, 435–437, 450
editing, 439
effecting Mullion joins, 445–446
hosted, 449–453
mirroring, 453
overview, 434–435, 438, 485
properties, 455–457
using wall type for panel, 447–447
See also Conceptual Massing environment; Desk Family example; Families; Parametric Families
Custom parameters, 231–233
Custom stairs, 379–383
Custom view titles, 621–622
Cut Geometry, 453
Cutable elements, 538
Cycle Section Head/Tail controls, 212
Index

adjusting annotation visibility, 589–591
adjusting scale, 589–591
batt insulation, 600–601
controlling display of items beyond, 632–634
drafted details, 623–626
duplicating views with, 64
edit cut profile tool, 601–605, 617–618
embellishing model views, 630–632
filled regions, 597–599
finalizing, 615–617
legacy, 626–629
legend views, 634–635
overview, 579, 587
repeating detail elements, 596–597
view breaks, 602–605, 617

DGN files
import options, 312
importing details from, 626
linking vs. importing, 727
Digital cartoon sets, 186, 233–235
Digital plots, generating, 35
Dillon, Matt on BIM, 44, 839
Dimension parameters, 541–545
Dimension snaps, 103
Dimensioning and TAB key, 97–98
Dimensions. See also Temporary dimensions
adding, 34–35
overview, 47
permanent, for doors, 159–160
Display Detail Level, 255–256
Dissolve form, 776
Divided Surface and Patterning tools
applying custom Family Panel, 798–799
applying divided surface to form, 788
building complex roof surface, 788–789
creating pattern-based Curtain Panel Family, 793–796
overview, 788
stitching borders of, 799–801
using intersects for, 802
Door Families, 137–138, 444
Doors
adding, 10, 137–138, 220–221
cased openings, 151–152
changing, 136
curtain wall, 435–436
displaying in reflected ceilings, 704
elevator, excluding from Schedule, 660
equality constraints on, 146–147
families, 136–138
options for, 137–138
phase filters, changing, 136–137
placement with permanent dimensions, 145–147
placement with temporary dimensions, 141
renumbering, 639
in Schedule, 634–635, 637–686
size, adding new, 125
size, changing, 144, 148
swing parameter, 734–737
tags, 660–661
type, changing, 136
DPI setting, 816
drafted details, 623–626
Drafting Lines, 353, 630–632
Drafting Views, 233, 623, 626–627, 629–630, 634–635
Drag control, level, 189
Drag handles for section lines, 212
Draw Points tool, 424
Draw tools for walls, 113
Drivers, printer, 717–718
Driving Points, 789, 794
Drywall ceilings, 702, 711
duplicate command (for Groups), 310
DVD, replacing missing or damaged, xiii
dWg files
import options, 313–314
importing details from, 626
linking vs. importing, 727
outputting to, 713
whirlpool tub example, 571–573
E
Edges, adding, 774
Edit Assembly dialog, 406
Edit Boundary tool, 697
Edit command (for Groups), 299
Edit Cut Profile tool, 601–602, 618–619
Editing forms in conceptual design environment, 771
Edit profile, 775
Elbows
for grid lines, 239, 249
for levels, 186, 209
Element keynote option, 615
Elements. See also Families; specific types and elements
annotation, 49
borrowing, 735, 745
cutable, 538
datum, 48
editing from Schedule, 642–645
generic, 50–51
hiding, 91, 616–617
hosted. See Doors
isolating, 91
model, 47–48
overriding by, 411
revealing hidden, 91
selecting. See Selection methods
types overview, 45
view, 48–49
in Worksets, 735, 746–747
Elevation Base, 188
Elevation cropping, adjusting, 207–208
Elevation sheets, 222–224
Elevation tags
adjusting, 203–205
creating custom, 511–516
imperial vs. metric, 177–178
loading custom, 205–206
NCS, 513–516
Elevation views
adding elbows, 209
adjusting elevation cropping, 207–208
adjusting elevation tags, 203–205
adjusting level heads, 208–209
editing level heights, 209–210
loading custom elevation tags, 205–206, 511–516
overview, 203
Elevations
interior, 709–710
showing depth in, 632–634
Elevators
adding, 383–384
excluding door from Schedule, 659
Equality constraints on doors, 146–147
Existing ceiling, edit an, 697–698
Existing conditions layout, creating, 117–132
Existing conditions view, 344–345
Existing roof plan view, 388
Exporting, 74, 719–721
Exposure adjustment, 818
Extend tool. See Trim/Extend tool
Exterior Glazing type, 455
Extrusions
creating in Conceptual Massing environment, 762–764
creating roofs by, 21–24, 418–422
creating solid, 519–520
creating solid forms by, 166–167
creating void forms by, 167–169
defined, 504
delaying, 505–506
reveals, 582–583
Families. See also Elements; Types; specific Families
accessing in projects, 492–497
advanced parameters. See Coat Hook Family example annotation, 54, 512–513
category assignment, 162–164
component, 51–54, 486–487, 495
conceptual Mass. See Conceptual Massing environment creating from CAD, 571–575
curtain panel, 555–560
custom, 152–153, 571–575. See also Desk Family example
detail components, 592–597
door, 141
duplicating, 503–504
In-Place. See In-Place Families libraries accessing, 497–500
overview, 487–492
loading, 152–153, 509–510, 534–535, 570
from manufacturer’s content, 571–575
model element, 52–53
nested, 563–564
overview and types of, 51–52, 485–487
parametric. See Parametric Families profile, 528, 533, 558–560
saving, 508–509
strategies for, 492
system, 54–55, 113, 486–487, 495
tag, 678–680
titleblock, 217, 221, 224–227, 229
types
adding Parametric Family, 545–547
editing and creating, 500–503
view title, 621–622
Family Edit mode, 384
Family Worksets, 731
Fascia boards, 408–410
Files. See also Paths, file; specific types
central, 734–735, 740–741, 747–748
default paths for, 101
export options, 74
filename extensions, 74
journal, 101
linked. See Linked files
local, 741–744
location settings, 101–102
printing to, 35
recent, 72–73, 491
saving Groups to, 306–307
Filled Regions, 597–599
Filtering
schedule items, 650
selection, 97
Fireplaces, in-place creation
adding reference planes, 164–166
creating solid form, 166–167
creating void form, 167–169
joining with wall, 169–170
selecting category, 162–164
First floor, New Construction, 825–828
Flip Section control, 212
Floor plan sheets, 217–222
Floor plan views, applying view template to, 192–193
Floors
adding, 19–21, 413–414
adjusting position and joins of, 415–417
copying to levels, 265–266
creating Floor Type, 414–415
creating from walls, 264–265
editing, 370–371
landings, 25, 371–374
overview, 387
Footers in Schedules, 648–650
Footings, 274–279
Forms. See under Conceptual Massing environment; Solid forms; Void forms
Formula parameters, 564–566
Foundation, 274–279
Framing, structural, 268–273
Functions, 405–407, 431, 456
Furniture. See also Desk Family example; Schedules
excluding from Group, 293–294
plan view, 663–664
Gaps in Segments control, 212
General overview. See Quick Start tutorial
General tab, 100–101
Generic elements, 50–51
Glazing, 798
Global and local controls, 772–773
Global vs. project settings, 99–100
grids, 274–279
Groups
adding missing elements to, 300–303
adding rooms within, 310–311
arrayed grids and, 244–246
attached detail. See Attached Detail Groups
binding linked files to, 309
commands on right-click menu, 298–299
converting to linked file, 307–309, 326–328
creating, 271–273, 281–285
duplicating and editing, 289–291
duplicating on Project Browser, 298–300
editing, 273, 287–289
excluding members of, 291–295
importing, 330
instances
creating, 285–286
duplicating, 291–295
nesting, 303–306
overview, 281
saving to file, 306–307
Guide Grids, adding, 249–251
Gutters, adding, 410–412
Hardware, adding to Family, 547–548
Headers in Schedules, 648–653
Height, wall, 113, 199
Height Offset from level, 690, 691
Hidden Line Views option for printing, 714
Hide/Show Bubble, 189, 239
Hide unreferenced view tags option, 715
Hiding elements, 91
Highlight Boundaries option for Rooms, 668
Highlights, 820
Horizontal Mullions, 463–465
Host Elements, 47–48, 486
Host Families, 50–51
Host Sweeps
applying to roof edges, 408–410
for Stacked Walls, 482–483
I
IFC (Industry Foundation Class)
files, 727
Ignorable Warning messages, 274–275, 292, 381, 391–392
Index

Image files, 813, 819
Image settings for rendering, 820
Imperial templates, 175, 177–178
Imperial units, 69–70, 118, 178
Import units option, 313
In-Place Families
  conceptual massing, 756, 757
defined, 162, 487
  fireplace example. See under Fireplaces, in-place creation
In-Place Masses, 199–203
Industry Foundation Class (IFC) files, 727
Instance parameters in Schedule, 643
Instance properties, 86–87
Install dataset files and open project, 760
Insulation, batt, 600–601
Intent Stack, 761–762
Interference check, 728–730
Interior elevations, 707–711
Invisible lines, 553
Isolated Foundation, 274
Isolating elements, 91
Isometric views, 12, 808

J
Join Condition, default, 456
Joining floor/roof with walls, 264–265
Journal File Cleanup settings, 101

K
Keyboard shelves, adding, 510–511
Keyboard shortcuts, 80–81
Keynotes, 612–615

L
Label Contours tool, 830
Labels
  adding more than one parameter to, 226
  for Tag Families, 679
  for view titles, 621–622
Landings, 25, 371–374
Layers
  importing CAD, 313
  roof, 405–407
  wall, 431
Layout settings, 4
Leaders
  option for Room Tags, 667–672
  options for Doors, 138
  with text, 609–611
Legacy details, working with, 626–629
Legend Components/Views, 634–635
Legends
  color scheme, 682
  keynote, 615
Length and Alignment constraint, 189, 239
Level Heads, adjusting, 208–209
Levels
  adding and modifying, 186–189
  adding in Conceptual Massing environment, 780–781
  constraining walls to, 196–198
  controls, 188–189
  copying floor slabs to, 265–266
  copying landings to, 359
  editing, 15–17
  height adjustment, 209–210
  height offset from level and, 690
  overview, 48, 173, 186
  renaming, 191–195
  views and, 187–188, 190, 192–193
Libraries
  family
    accessing, 497–500
  overview, 487–492
  seek, 383–384, 492, 499–500, 719
Light fixtures, 702–704, 816
Lighting, 812, 814–818
Lines
  adjusting weight in Detail Components, 594
  <Beyond> style, 276
  break, 599–600
detail, 50, 591–592, 618
  invisible, 553
  model, 50, 353, 591
  section, 211–212
Linework tool, 630–632
Linked files
  binding to Groups, 309
  CAD, 313–315
  converting Groups to, 307–309, 327–328
  copying/monitoring elements from, 328–329
  linking by Shared Coordinates, 326
  overview, 307, 311
  placing on dedicated Workset, 750
  positioning, 320–321
  revit, 318–319
  swapping with another file, 331–332
  workers vs., 311
Local files, 741–744
Location line for walls, 113
Location line for walls, 113
Location line for walls, 113
Location line for walls, 113
Location line for walls, 113
Location line for walls, 113
Location line for walls, 113
Make Element Editable command, 298
Mark, 641
Masonry shell
  adding windows to, 453
  creating wall type, 430
  editing wall type structure, 431–434
Masses. See also Conceptual Massing environment
  adding in-place, 199–203
  editing, 459–463, 466–467
Match command, 298, 496–497
Matchlines, 722–723
Material keynote option, 615
Material Takeoffs, 676–678
Materials
  applying to Toposurfaces, 828–830
  editing landing, 375–376
  rendering and, 807, 810–811
  for Roof Layer, 406
Mental Ray ProMaterials library, 812–813
Mental Ray rendering engine, 804, 806, 812
Merge Surface tool, 830
Metric templates, 175, 177–178
Metric units, 69–70
Microstation files. See DGN files
Midtones, 818
Mirrored Groups, adding Detail Groups to, 296–297
Model-based forms, 758–759, 776–780
Model Element Families, 52–53
Model Elements, 47–48
Model Groups. See Groups
Model In-Place. See In-Place Families
Model Lines, 50, 353, 591
Model Text, 50
Modeling vs. CAD, 40–44
Models
  considerations for rendering, 806–808
  3D vs., 160
  editing, 654–656
  editing elements from Schedule, 642–645
  editing Schedule parameters from, 656–657
  spinning, 12, 17, 154, 228
  viewing in 3D, 153–156
  views and, 49–51
Modify Sub-Elements tool, 424
Modify tool
  creating selection boxes with, 96–97
  as default tool, 7
Mullions
  adjusting position of, 466–469
  angled, 474
  assigning, 444–447
  corner, 464, 472–474
Index

Mullions (continued)
curtain wall properties related to, 456–457
deleting extra, 468
editing horizontal, 463–464
editing joints, 445–446
editing vertical, 465–466
profile families, 558–560
type properties, 463–465
Multi-segment sweeps/swept-blends, 770

N
Name for Print Setup settings, 715
National CAD Standard (NCS), 640, 719
Natural lighting, 805, 812–814, 816–817
Navigation Bar, 57, 95
Navigation in views, 57–60, 94–95
NCS (National CAD Standard), 640, 720
Nested Families, 563–564
Nested Groups, 303–306
New Features Workshop screen, 72

O
Object snaps, 103–104
Object Styles dialog, 412
Offset, Mullion, 463
Offset option for Rooms, 667
Offsetting walls, 113, 120–121, 127–128
On Grids button, 254–255
Online resources, 838–840
Open stringers, 349
Openings, 9, 18–19. See also Doors; Windows
Options Bar. See also specific elements overview, 72, 88
right-clicking on, 92
Options dialog box, 100–102
Orbit control, 155
Orientation option for printing, 714
Output Settings for rendering, 815–816
Outputs
application menu, 712–713
exporting to CAD, 719–721
exporting to DWF file, 721–722
options for, 37
preparation, 31–33
printing, 713–718
publishing, 718–719, 722–724
Overhangs, 23–34, 420
Overrides. See Visibility/Graphics over rides
Overview. See Quick Start tutorial

P
Pads, Building, 316–317
Paint tool, 809–810
Panel Types, swapping, 442–444
Panelized wall systems. See Curtain Systems; Curtain Walls
Panels, ribbon, 76–77
Panning, 59–60, 94–95
Paper option for printing, 714
Paper Placement option for printing, 714
Parameter dialog box, 569
Parameters
adding more than one to Label, 226
advanced, for Families. See Coat Hook Family example
angular, 833–837
creating custom, 231–233
custom, 231–233
dimension, 541–545
door swing, 835–837
formula, 564–566
in Schedule, 643–644, 656
shaded, 679
visibility, 567
wall, 122–123
Parametric Families
adding Family Types, 545–547
creating custom, 231–233
creating new Types from, 502–503
duplicating groups on, 298–300
dissolve forms, 776
driver configuration, 717
to file, 35, 716
duplicate, 717–718
setup dialog, 713–715
troubleshooting, 718
Printing views. See Sheet views
Profile parameter, Mullion, 474
Profiles, adding, 775
Project Base Point, 318, 321–324
Project Browser
accessing Families from, 492–497
browser organization, 54–56, 229–231, 233
creating new Types from, 502–503
duplicating groups on, 298–300
overview, 44–45, 72, 81–86
right-click items in, 92
Project Coordinates, synchronizing, 323
Project Elevation Base, 188
Project information, editing, 229
Project North, defined, 325
Project Standards Worksets, 731
Project Vasari, 760–776
add edge, 774
capturing, 774
delete profile, 775
dissolve forms, 776
eidt profile, 775
editing forms in conceptual design environment, 771
extrusions, creating, 762–764
global and local controls, 772–773
install dataset files and open project, 760
intent stack, 761–762
loft form, creating, 764–766
revolve form, creating, 766–767
sweep form, creating, 767–770
swept blend form, creating, 770–771
using X-ray, 771–772
Projects. See also Files; Project Browser; Sample project exploration; Templates
bi-directional coordination within, 45
commercial project creation, 185–186
creating from Construction template, 181–183
creating with default template, 176–181
creating without template, 184
residential project creation, 117–120
saving as template, 74, 235
ProMaterials library, 809, 811
Properties, instance vs. type, 86–87
Properties Tool, 16, 86–88
Property Line tool, 830

Q
Quality setting for rendering, 815
Queries, 674–678
Quick Access Toolbar (QAT) adding tools to, 76
overview, 74
right-clicking on, 91–92
Quick Start tutorial adding doors and windows, 9–11
adding fl oor, 19–20
adding roof, 21–24
adding stair, 24–27
creating schedule, 28–30
creating walls, 7–9
determining in any views, 15–19
getting started, 4–5
output options, 35
preparing output, 31–34
solar studies, 35–38
underlay creation, 5–7
working in other views, 12–15

R
Radius option for walls, 113
Rafter mode, 404–405
Railings
adding to entry stairs, 381–382
adding to patio, 382–383
adding outside, 377
adjusting sketch of, 357–358
editing, 375–377
modifying, 339–340
overview, 334
type selection during stair addition, 337, 370
types, 349–350
Ramps, adding, 377–379
Raster processing, 714, 718
RCP. See Ceilings
Recent files screen, 72–73, 512
Reception desk, 516–518
Rectangle option, adding walls with, 116–117
Reference-based forms, 759–760, 776–780
Reference Lines, 833–835
Reference Planes
adding to in-place Family, 164–166
for custom Families, 519, 521–523, 539–541
overview, 49, 345, 346
for positioning stairs, 345–346
Reference tracking, 40
Referenced Section Views, 626–627
Refl ected ceilings. See Ceilings
Reproduce command (for Groups), 299
Reload From button, 331–332
Reload Latest tool, 747
Rename command, 33
Rename command (for Groups), 298
Rendering
dialog and settings, 815–818
3D views and cameras, 808–809
generating, 835
lighting, 804–806, 812–820
materials, 809–812
model preparation, 806–808
overview, 804
post-rendering exposure adjustment, 818
saving, 819
walkthroughs, 820
workflow, 804–806
Repeating Detail elements, 596–597
Reports, 682–683
Representation, 41
Reset Shape tool, 424
Residential project, creating, 117–120
Resources, online, 838–840
Restrooms, 161–162, 832
Revealing hidden elements, 91
Revels, 582–583
Revision tracking, 724
Revit Architecture. See Quick Start
tutorial; User interface; specific concepts and elements
Revit Structure, 251
Revolves, 504, 530–531, 766–767
Rewind function, 60, 95
Rhomboid pattern, 792, 794
Ribbon. See also Tools
overview, 6–7, 71, 75
panels, 76–77
right-clicking on, 91
viewing states, 77–78
Right-clicking, 91–93
Riser and Boundary mode, 353–356
Risers, 25, 355–356
Riverbed Technology, 732
Roof plan views
creating in Existing phase, 388
editing view range, 422–423
modifying, 401–402
Roofs
adding
existing, 389–391
new, 398–399
simple, 197–198
in tutorial, 21–24
adding gutters to, 410–412
adding Layers to, 405–407
adding skylights to, 412
adjusting chimney, 391–393
applying Host Sweep to edges, 408–410
attaching walls to, 393–394
commercial vs. residential, 387
complex type, 405
in Conceptual Massing environment. See Divided Surface and Patterning tools
creating by extrusion, 21–24, 418–421
detail structure of, 405–407
joining, 399–400
options for, 402–405
overview, 388
sub-elements, 422–428
Room Bounding, 695, 700
Rooms
adding fl inish information, 673
adding within groups, 309–310
door numbers and, 639
editing names of, 671
exporting reports, 682–683
overview and options for, 667–668
renumbering, 640, 661, 669–671
reporting in Furniture Schedule, 674–676
Tags, 667–671, 678–679
viewing Schedule of, 672–673
working with Area Plans, 682–683
Rotate tool, 318
Run sketch creation mode, 336, 368

S
Sample project exploration detail views, 67–68
generating acquainted with, 57–60
generating started, 56–57
tool tips, 60–62
views, editing in any, 67
views and detailing, 62–66
Saturation, 818
Save Group command, 299
Scale, 33, 65, 228, 589–591, 605
Schedule Keys, 640, 656–660
Schedule views
adding, 213–214, 640–642
duplicating, 647–648
Index

Schedule views (continued)
importing from other Projects, 214–215
interaction with plan view, 29
overview, 213

Schedules
adding to sheet, 651–653
copying and pasting, 183
creating, 28–31
editing model elements from, 642–645
editing parameters from model, 656
excluding elevator doors from, 385
exporting to file, 682
filtering items in, 650
footers, 648–650
formatting and appearance, 650–651
grand totals, 648–650
grouping items in, 646–647
headers, 648–650
highlighting items in Model, 639
material takeoffs, 676–678
overview, 637
reporting Room in Furniture, 674–676
sorting items in, 645–646
splitting long, 653–654
viewing existing, 638–640
viewing Room, 672–673

Scope Boxes, 723
Second floor
editing wall layout, 394–398
new construction, 826–828

Section boxes, 808
Section lines, 211–212
Section sheets, 222–224
Section views
of ceilings, 699–700
creating, 13–15, 211–212
overview, 211

Seek Web Library, 383–384, 491, 499–500, 719
Segment Drag Handle controls, 212
Select All Instances command, 257, 298
Selection boxes, 96
Selection methods
in conceptual modeling
environment, 200
crossing, 115–116
overview, 95–97
Selection sets, 95–97
Settings, 99–107
Shadows, 814, 820
Shafts, 266–268, 372–374
Shape Editing tools, 423–428
Shape Handles, 585
Shared Coordinates
defined, 322
establishing, 318
linking by, 326
saving, 319, 322–325
Shared Elevation Base, 188
Shared Levels and Grids Workset, 731–732
Shared Parameter File, 679
Sheet Prefix Browser Organization, 230
Sheet views
cover sheets, 227–228
elevation sheets, 222–224
floor plan sheets, 217–222
overview, 57, 216–217
from placeholders, 221
section sheets, 222–224
Sheets
adding, 31–33
adding Schedules to, 651–653
adding plan views to, 221–222
cover, 227–228
detail, 620–621
elevation, 222–224
on Project Browser, 85–86
renaming, 33, 217–219
renumbering, 33, 217–219
section, 222–224
views from placeholder, 221
Shelves, brick, 580–586
SHIFT key, 96
Sinks, adding, 161
Site Plan views, applying view template to, 193
Sites, creating simple, 193–195
Sketch-based objects, defined, 334
Sketch ceiling, 690
Sketch mode, 19, 337
Skylights, 412
Slope
roof, 199, 387, 390–391, 399, 423–428
stair/railing, 26–27
Slope Arrow mode, 696
Snaps, 103–104
Solar studies, 35–38
Solid blends, 523–526
Solid extrusions, 519–520
Solid forms
creating, 166–167, 781–782, 784–785
defined, 504–505, 518–519
Solid revolves, 530–531
Solid sweeps, 532–534
Spacing settings, 457
Specialty Equipment template, 537–538
Spline Through Points tool, 789
Split button tools, 19, 78–79
Split Face tool, 810
Split Surface tool, 828–829
Splitting
stringers, 26
walls, 131–132
Stacked Walls, 435, 477–483
Stairs. See also Railings
adding, 25–28, 335–339, 367–370
adding railings to entry, 381–382
adjusting Toposurface for, 340–341
adjusting wall profile for, 361–362
to basement, 350–352
bull nose riser, adding to, 355–356
copying and demolishing, 342–344
custom shaped, 379–381
editing sketch of, 352–355
multi-story, 370–371
overview, 334–335
straight interior, 345–347
types, 347–350
viewing in 3D, 356–358
Status Bar, 88
Steelhead accelerators, 732
Steering Wheel, 12, 58–59, 62, 155
Storefront type, 455–456
Stringers, 26, 349–350
Structural framing, 268–273
Structural plans, creating, 330
Structural vs. Architectural Columns, 251. See also Columns
Structural walls, 260–264
Sub-element editing tools, 422–428
Subcategories, creating, 548–550
Sun path, 814
Survey Point, 321–322, 324
Sweeps
in conceptual massing
environment, 767–770
defined, 504
host, 408–410, 482–483
solid, 532–534
wall, 481–482
Swept blends, 526–529, 770–771
Swing parameter, 835–837
Symbolic Lines, 550–552
Synchronizing with Central file, 739–740, 746–747
System Families, 54–56, 113, 486–487, 495

T
TAB key, 97–99
Tag All Not Tagged tool, 661
Tags
adding to other views, 674
door, 660–661
elevation, 177–178, 203–205, 511–516
families, 679
groups and, 286–287, 289
loading, 511–516, 661–662

loading custom elevation, 205–206

NCS elevation, 513–516

options for doors, 138

overview, 660

room, 667–674, 678–679

Teams, tools for. See Work sharing

Templates
collection, 181–183
creating own, 113, 184–185
creating projects without, 184
default, 101, 176–181
definition, 517

emperial, 175

metric, 175

overview, 173, 174–176

sharing, 74, 235

view, 192–193

views and, 49, 217

Temporary dimensions

doors, 10–11, 141

enabling for multiple selections, 210

for levels, 17, 189–190

setting defaults for, 103, 124

sketching and, 125–126

for walls, 8

for windows, 18

Text

leaders with, 609–611

overview, 50

placing, 607–608

types, 606–607

Thickness

mullion, 463–464

roof layer, 407

3D Models

BIM vs., 41, 44

considerations for rendering, 806–808

3D views
camera, 808–809

default, 748

defining in rendering workflow, 804–806

of models, 12–13, 153–156

plumbing fixtures and, 160

of sun path and shadows, 36–37

of stairs, 356–358

in workset enabled projects, 748

TIF files, 819

Tiling views, 14–15, 88, 517–518

Tilted walls, 42

Titleblocks, 217, 221, 224–227, 229

titles on sheet parameter, 224

Toilets, 161, 832

Tools, 8, 78–79. See also specific tools

Toolips, 60–62, 79–81, 89, 738

Toposurfaces

adjusting, 340–341

creating, 194–195

graded region tool, 342

from imported data, 312, 315–316

splitting and applying materials to, 828–830

tools for, 830

Total sun area, 37

Transfer Project Standards command, 113, 176

Transparent background, 701

Transparent feature, 573–574

Transverse section view, 255–256

Trim/Extend tool

for floors, 20–21

for void forms, 167–169

for walls, 127, 128–129, 261–262

Troubleshooting printing, 718

True North, rotating views to, 325

Truss mode, 404–405

2D drafting items, 807

2D DWF, publishing, 234

2D/3D Extents toggle, 189, 209, 239

Type Catalogs, 592

Type Mark, 641

Type parameters in Schedule, 643–644

Type properties, 86–87

Type properties command, 299

Type Selector dropdown for Room

Tags, 667

Types. See also Families
definition, 51, 87, 486

editing and creating, 500–503

match properties, 496–497

selector, 86–88

Unconnected height for walls, 113

Underlays, creating, 5–6

Underpinned ceilings, 698–699

Unit conventions, 69–70

Upper Limit option for Rooms, 667

User Defned Worksets, 731–732, 735–736

User interface.

See also Options Bar;

Project Browser; Quick

Access Toolbar (QAT); Ribbon; Selection methods

application menu, 73–74, 712–713

conceptual massing environment, 759

navigating in views, 57–60, 94–95

overview, 69–71

recent files, 72–73

right-clicking, 91–92

settings, 99–104

status bar, 89

TAB key, 97–99

tools, 8, 79

type selector and properties palette, 86–88

unit conventions, 69–70

view control Bar, 90–91

User keynote option, 615

Username setting, 101

V

Variable option for Roof Layers, 406

Vector processing, 714, 718

Vertical mullions, 465–466

View Breaks, 722–723

View cube, 62

Viewport boundary, 32

Viewports, 61, 66

Views. See also Phases

adjusting level of detail display for, 255–256

callout, 587–589

camera, 810–811

3D. See 3D Views
dedicated rendering, 809

dependent, 722–723

detail, 67–68
detailing and, 62–66
drafting, 233, 623–626, 634–635
duplicating, 64
detailing in any, 15–19, 66, 156–159
elevation. See Elevation views

embellishing, 630–632

enlarged, 377

furniture plan, 664–666

hiding elements in, 616–617

isometric, 12, 808

legend, 634–635

levels and, 187–188, 190, 192–193

models and, 49–50

navigating in, 57–60, 94–95

not on sheets, 63, 86, 230

opening, 229

overview, 45, 49–50, 173

on Project Browser, 63–64, 84–85

referenced section, 626–627

reflected ceiling plan. See Ceilings

roof plan. See Roof plan views

rotating to True North, 325

in sample project, 62–66

scale, 33, 65, 228, 589–591, 605

schedule. See Schedule views

section. See Section views

sheet. See Sheet views

switching between, 216
Index

Views. See also Phases (continued)
templates and, 49, 216
tiling, 14–15, 88, 517–518
visibility settings. See Visibility/
Graphics over rides
walkthrough, 820
working, 64, 438–439
working in other, 12–15
work set enabled project, 748
Visibility/Graphics over rides
cut line weight for host sweeps, 411
depths in elevations, 632–634
doors in RCP, 704
furniture, 66, 664–666
linked files, 422
in rendering views, 807
work sets, 738–739
Visibility parameters, 567
Visibility settings for Family
elements, 553–554, 572–573
Void forms
creating, 164–167, 506–507, 760
defined, 506–507, 518–519
Volume calculations, for energy
analysis, 667

W
Walkthroughs, 820
Wall Foundation, 274
Wall Layers
joining, 581
unlocking, 581–582
using Edit Cut Profile for, 601–619
Wall Sweeps, 481–482
Walls
adding using lines, 109–113
adding using pick lines mode,
127–128
adding using rectangle, 7, 113–114
adjusting profile for stairs, 361–362
attaching to roof, 393–394
basic options, 110–111
brick shelves, 580–586
constraining to levels, 196–197
copying, 121–122
creating and editing Type. See Masonry shell
creating floors from, 264–266
curtain. See Curtain Systems;
Curtain Walls
detailing, See Detailing
extending single element, 128–127
height, 110, 199
location adjustment, 122–124
masonry. See Masonry shell
moving, 130–131
offsetting, 121
options for, 118
parameters, changing, 122–123
phasing and, 132–136
residential project creation,
117–118
second floor, 394–400
sketching, 125–126, 131–132
splitting, 128–130
stacked, 435, 477–483
structural, 259–262
tilted, 42
trimming, 169
trimming/extending single
element, 169–170
types of, 431
WAN (Wide Area Network). See
Wide Area Network (WAN)
Warning messages, Ignorable, 274,
292, 391, 479–480
Web sites of resources, 838–840
Whirlpool tub example, 571–573
White Point setting, 818
Wide Area Network (WAN), 732,
740–741, 750, 818
Width on side 1 and 2 parameters,
464–465
Windows
adding, 10–12, 149
adding to masonry walls, 429–430
bay, adding, 785–788
cased openings, 151–153
custom Families, 152–153
modifying, 17–18
Windows (interface), closing unused,
209, 222
Windows selection method, 115
Wiring for ceilings, 706–707
Witness lines, moving, 117–120, 241
Work Plane
defined, 21, 418
dissociating, 531
setting perpendicular to the path,
767
using surfaces as, 524
Working views, 64, 500–501
Working with Area Plans, 683–686
Work sets
adding new elements, 746
borrowing elements, 735,
745–748
central file, 732–734, 739–740,
742–743
closing, 743
creating additional, 735–749
default 3D views, 748
disposable and open, 734
designing elements in, 658
enabling, 732–733, 772
linked files vs., 307
local files, 740
moving items to, 737
overview, 726, 728,
730–733
reload latest tool, 747
rendering performance and,
806–808
tips for, 749–750
tooltips, 738
visibility, 736, 738–739
Work sharing. See also Linked files;
Work sets
linking and importing, 727
overview, 298, 311, 726
Work surface Height Reference
Plane, 531
Wraps, 406, 434

X
X-ray tool, 771–772

Z
Zoom option for printing, 714
Zooming tools, 32, 58–60,
94–95